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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for technical or editorial errors or 
omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. 
Government under vendor's standard commercial license.

Copyright Notices

© Copyright 2008 Hewlett-Packard Development Company, L.P.

Trademark Notices

Windows® and Windows Server™ 2003 are U.S. registered trademarks of Microsoft® Corp.

UNIX® is a registered trademark of The Open Group.

Java™ and all Java based trademarks and logos are trademarks or registered trademarks of

Sun Microsystems, Inc. in the U.S. and other countries.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
3



Support

You can visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
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1 Getting Started
This chapter describes three of the HP OpenView Performance Insight (OVPI) 
client applications (Report Builder, Report Viewer, and the Web Access 
Server), the prerequisites you must meet to use them, and how to start them. 

Overview

To help you with the report preparation process, OVPI supplies client 
applications. The client applications provide the interface for designing, 
displaying, scheduling, generating, and printing management reports; and 
distributing reports using the Web Access Server. You can install a client 
application on any networked system. 

The client applications discussed in this guide are as follows:

• Report Builder. Report Builder lets you build customized reports based on 
data from the OVPI database, modify existing reports, and deploy reports 
to the Web Access Server.

• Report Viewer. Lets you view, modify, and print the reports you purchased 
with OVPI or the custom reports you create with Report Builder.

• Web Access Server. Lets you deploy, view, schedule, and generate reports 
using a Web browser. 

It also lets you perform administrative tasks for the OVPI client 
applications and services. Refer to the HP OpenView Performance Insight 
Administration Guide for details.

For information about the Management Console client application, refer to 
the HP OpenView Performance Insight Administration Guide.
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Report Types

The client applications use the following files:

• Report Definition 

A report definition file (.rep file extension) contains multiple tables, 
graphs, graphics, and text and retrieves its data from the database. 

• Dataset 

A dataset file (.srep file extension) is similar to a report, except when you 
view a dataset report, its data is retrieved from the report, not the 
database. A dataset report is a snapshot of the data taken at the time the 
report is generated. This is performed by a batch generation process, 
which is typically set up by the Administrator. Like a report definition file, 
you can change many of the display attributes of a dataset report. 

Prerequisites

Before you can use Report Builder, Report Viewer, or the Web Access Server, 
ensure that you have met the following prerequisites:

• OVPI is installed. For more information about installing OVPI, refer to 
the HP OpenView Performance Insight Installation and Upgrade Guide for 
Oracle Databases and HP OpenView Performance Insight Installation and 
Upgrade Guide for Sybase Databases.

• You have a user account. For more information about user accounts, see 
your Administrator or refer to the HP OpenView Performance Insight 
Administration Guide.

• You have one of the following Web browsers installed on the system where 
you will use the Web Access Server application or view the online help for 
Report Viewer or Report Builder: 

— Microsoft Internet Explorer 5.5 or later 

— Netscape Navigator 6.0 or later

— Mozilla Firefox 5.0
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• The Web Access Server service (OVPI HTTP Server) is running. For more 
information about how to check if the Web Access Server is running, refer 
to the HP OpenView Performance Insight Administration Guide.

• To view and generate reports properly, make sure that your display is set 
to one of the following: 8, 16, 24, or 32 bits.

• Before you attempt to build reports, which is an advanced feature of OVPI, 
consult your HP representative for guidance.

Starting the Client Applications

You can use the client applications on either a Windows or a UNIX operating 
system. For a list of supported operating systems, refer to the HP OpenView 
Performance Insight Installation and Upgrade Guide for Oracle Databases 
and HP OpenView Performance Insight Installation and Upgrade Guide for 
Sybase Databases.

Starting Report Builder or Report Viewer

 UNIX System

To start Report Builder or Report Viewer on a UNIX system:

1 Open a new shell window on the system where the application is installed.

2 Navigate to the following directory:

installation_directory/bin 

In this instance, installation_directory is the directory into which you 
installed OVPI.

3 Type either of the following commands, and then press ENTER:

— ./builder 

— ./viewer 
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Windows System

To start Report Builder and Report Viewer on a Windows system, do one of the 
following:

• From the Windows desktop, click the Start button, point to Programs, 
point to HP OpenView, point to Performance Insight, and then click 
Builder or Viewer.

• From a Windows Command Prompt window, type one of the following 
commands at the MS-DOS command prompt, and then press ENTER:

— builder 

— viewer 

• From Windows Explorer:

a Navigate to the following directory:

installation_directory\bin 

In this instance, installation_directory is the directory into which you 
installed OVPI.

b Double-click one of the following:

— builder.exe 

— viewer.exe 

Logging On

To log on to Report Builder or Report Viewer:

1 Start the application you want to use. For more information about how to 
start either application, see Starting the Client Applications on page 17. 

The builder and viewer commands support a set of command-line options. 
For more information about these command-line options, refer to the HP 
OpenView Performance Insight Reference Guide.
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2 Perform the action you want. (For example, on the File menu, click Open. 
In the Open dialog box, choose the report you want to open, and click 
Open.) 

The Login dialog box opens.

3 Enter your username, your password, and select the system on which you 
want to use the application.

For more information about your user account or about creating user 
accounts, see your Administrator or refer to the HP OpenView 
Performance Insight Administration Guide.

4 Click Login. 

Displaying the Web Access Server

To display the Web Access Server:

1 Enter the address of Web Access Server in your Web browser. For more 
information about this address, see your Administrator or refer to the HP 
OpenView Performance Insight Administration Guide.

If you are using Report Builder and open a dataset report (.srep), 
you do not have to log on to the application. In any other instance, 
the Login dialog box opens.
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The Log on page appears.

2 Click Log on.

The Connect to dialog box opens.

3 Type your username and password. 

For more information about your user account or about creating user 
accounts, see your Administrator or refer to the HP OpenView 
Performance Insight Administration Guide.
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4 Select Save this password in your password list if you want your password to 
automatically appear in the Password box each time you log on.

5 Click OK.

The Web Access Server appears as shown in Figure 52 on page 282. For 
more information about the Web Access Server, see Chapter 11, Using the 
Web Access Server. 

Using the Client Applications

For more information about how to use the client applications, see the 
following chapters: 

• Chapter 2, Using Report Builder—Describes the Report Builder user 
interface. 

• Chapter 3, Creating Reports—Describes how to create and modify report 
elements, set report building preferences, change Report Builder options, 
and save, print, open, and close reports.

• Chapter 4, Modifying Reports—Describes how to change element 
properties, modify graphs and tables, and create reports with deferred 
selections.

• Chapter 5, Linking Report Elements—Describes how to link one element 
to another in a report.

• Modifying Data Selection—Describes how to determine the way a report’s 
elements select data from the database and how to use OVPI’s advanced 
data selection tools. 

• Scheduling and Generating Reports—Describes how to schedule and 
generate reports using the Web Access Server and the Schedule and 
Generate Tools.

• Deploying Reports—Describes how to deploy and undeploy reports using 
the Deployment Wizard and the Deployment Tool.

If the account that you are logged on to the Web Access Server with remains 
inactive for more than 30 minutes, the Enter Network Password dialog box 
opens, requiring that you enter your password to gain access to the 
application.
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• Chapter 9, Creating Forms—Describes how to create forms, which let you 
change the data contained in a single database table.

• Chapter 10, Using Report Viewer and Chapter 11, Using the Web Access 
Server—Describe how to view reports using Report Viewer and the Web 
Access Server, respectively. These are the reports you purchased with 
OVPI or the custom reports you creating using Report Builder.

• Appendix A, Element Properties—Describes the properties for each table 
and graph element that you can viewing when using Report Builder.
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2 Using Report Builder
Report Builder lets you build, customize, and open existing reports. You can 
use Report Builder to:

• Build historical performance reports that contain multiple graphs, tables, 
graphics, text, and company logos; drill-down navigation between related 
graphs and tables for detailed knowledge of network and device problems.

• Customize the reports you create and any of the reports currently 
available from HP, which support many of today’s major technologies.

• Open multiple reports of different types (that is, dataset and report files).

• View existing reports.

• Create forms, which are a special kind of report. A form is a user interface 
that lets you change the data contained in a single database table. 
 23



The following figure shows a sample report and its elements.

Figure 1 Sample Report

You must start Report Builder on the system where it is installed. For 
information about starting Report Builder, see Starting the Client 
Applications on page 17.

After you start Report Builder, the Report window appears in the Report 
Builder window. Figure 2 on page 25 shows the Report window.
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Report Builder Interface

Figure 2 shows the Report Builder window after you choose New from the File 
menu and log on to Report Builder.

Figure 2 Report Builder Window

Report Builder has an MDI (Multiple Document Interface) desktop. Using the 
MDI desktop, Report Builder lets you open, modify, and preview multiple 
reports of differing formats (report and dataset files). The MDI desktop uses 
dockable and document windows.

Report Builder Windows

Report Builder uses the following types of windows:

• A dockable window floats on top of the other windows or it snaps to a side 
of the application window. 
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The Components, Browser, and Log Viewer windows are dockable 
windows. For more information, see Docking Windows on page 27 and 
Undocking Windows on page 28.

• A document window appears when you open an existing report or create a 
new one. 

The Report window is a document window. For more information, see 
Modifying Undocked and Document Windows on page 28.

The following figure shows the Browser window when it is undocked. 

Figure 3 Browser Window
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The following figure shows the Browser, Components, and Log Viewer 
windows when they are docked. (The Browser and Components windows are 
arranged in a tabbed-page format when more than one is docked on the same 
edge of the Report Builder window.)

Figure 4 Docked window

Docking Windows

To dock a window:

1 Click the title bar of the window you want to move with the left mouse 
button. 
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2 Drag the window to any edge (left, top, right, or bottom) of the application 
window. 

The window snaps to the edge. For the top or bottom edge, the window 
snaps horizontally. For left or right edge, the window snaps vertically.

Undocking Windows

To undock a docked window:

• Press the SHIFT key and click the pointer on the window’s title bar.

Modifying Undocked and Document Windows

You can minimize, maximize, close, and move undocked and document 
windows like any other window for your operating system. 

To move a document window:

• Click the title bar of the window you want to move and drag it to the 
location you want.

You can minimize, maximize, restore, close, and resize undocked and 
document windows just like you do when you are running Windows. Click the 
Minimize, Maximize, Restore, or Close buttons in the upper right-hand of the 
window. To resize, place the pointer over any edge of the window and drag.

Title Bar

The title bar is the horizontal bar at the top of the Report Builder window. It 
displays information about the current window. Figure 2 on page 25 shows the 
title bar.
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Menu Bar

Report Builder has the following menus: File, Edit, View, Insert, Window, and 
Help.

Report Builder also lets you use your keyboard to perform some of its 
operations. To the right of each menu or submenu option is a notation showing 
the option’s shortcut key. The shortcut key is the key sequence that produces 
the same result as selecting the menu option from the menu.

File Menu

Table 1 Report Builder File Menu Options

Menu Option 
and Shortcut 
Key Description

New Lets you create a new report or form. 

Open (CTRL+O) Displays the Open dialog box, which lets you open an 
existing report. 

Browse Displays the Browser window, which lets you open 
reports that have been deployed to the system and 
users folders on the Web Access Server. For more 
information about deploying reports, see Chapter 8, 
Deploying Reports.

Close Closes the active Report window.

Close All Closes all of the open Report windows.

Save
(CTRL+S)

Saves the report with the current file name to the current 
directory location. When you save a report for the first 
time, the Save dialog box will open. 

Save As Opens the Save dialog box, which lets you save your 
report to any of the available formats. 
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Save All Saves all of the opened reports with their current file 
names to the current directory location.

Deploy Opens the Deployment Wizard, which lets you deploy 
reports to the users or system folders on the Web 
Access Server. For more information about deploying 
reports, see Chapter 8, Deploying Reports.

Print
(CTRL+P)

Opens the Print dialog box, which lets you print a report 
and specifying several different printing options. 

Disconnect from 
server

Disconnects you from the server. A confirmation dialog 
box opens to confirm that you want to disconnect from 
the server.

Exit Exits Report Builder.

Table 1 Report Builder File Menu Options (cont’d)

Menu Option 
and Shortcut 
Key Description

On UNIX systems, the Open, Save As, Print, and Page Setup dialog boxes 
appear differently than those for Windows systems. Refer to your operating 
system-specific documentation for information about how to use these dialog 
boxes.
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Edit Menu

.

Table 2 Report Builder Edit Menu Options

Menu Option 
and Shortcut 
Key Description

Undo
(CTRL+Z)

Lets you reverse the effect of the previous operation, if 
it is possible to do so. For example, you can undo an 
operation that modifies a report; but if you change a 
preference, you cannot undo it.

Redo
(CTRL+Y)

Lets you perform the last operation you did before 
choosing Undo. For example, if you delete a circle and 
then restore it using Undo, when you choose Redo, 
Report Builder deletes the circle again.

Cut
(CTRL+X)

Removes the selected object from the report and places 
it on the clipboard.

Copy
(CTRL+C)

Copies the selected object and places it on the clipboard.

Paste
(CTRL+V)

Pastes the object that you previously cut or copied.

Delete
(DELETE key)

Deletes the selected object or objects but does not place 
the object or objects on the clipboard.

Select All
(CTRL+A)

Selects all the objects in the active report window.

Align Top Aligns the top edges of all the selected objects.

Align Left Aligns the left edges of all the selected objects.

Align Right Aligns the right edges of all the selected objects.

Align Bottom Aligns the bottom edges of all the selected objects.
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Align Vertical Aligns the centers of the selected objects vertically in 
the center of the Report window.

Align Horizontal Aligns the centers of the selected objects horizontally in 
the center of the Report window.

Refresh
(CTRL+F5)

Refreshes the selected element or elements in the 
current Report window.

Refresh All
(F5)

Refreshes all the elements in the current Report 
window.

Preferences
(ALT+ENTER)

Displays the Preferences dialog box, which lets you set 
your report creation preferences. For more information, 
see Creating Reports on page 47.

Options
(ALT+O)

Displays the Options dialog box, which lets you change 
Report Builder options. For more information, see 
Specifying Options on page 120.

Parameter Values
(ALT+P)

If the current report has parameters defined, this 
option displays the Modify Parameter Values dialog box, 
which lets you change any of the parameters in a report. 
For more information, see Modifying Parameter Values 
on page 207.

Table 2 Report Builder Edit Menu Options (cont’d)

Menu Option 
and Shortcut 
Key Description
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View Menu

Insert Menu

Table 3 Report Builder View Menu Options

Menu Option Description

Components Displays the Components window if it is not already 
displayed.

Log File Displays the Log Viewer window, which displays the 
contents of Report Builder’s log file (builder.log). The log 
file messages are categorized by type (all, info, warning, 
error, and debug).

Log Output Displays the Output Viewer window, which displays the log 
file messages as they are written to the builder.log file.

Grid Displays a grid in the Report window, which you can use to 
size and position elements.

Links Displays the links for the selected source object.

Toolbars Lets you show or hide the active toolbars.

Status Bar Lets you show or hide the status bar.

Table 4 Report Builder Insert Menu Options

Menu 
Option Description

Graph Lets you add a graph to a report.

Table Lets you add a table to a report.

Combo Box Lets you add a combination box to a report.

Input Field Lets you add an input field to a form.
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ized 
Window Menu

The Window menu lets you control Report Builder windows. Table 5 lists the 
options on the Window menu.

Input Combo 
Box

Lets you add an input combination box to a form.

Tabbed Area Lets you add a tabbed area to a report.

Image Lets you add an image to a report.

Line Lets you add a line to a report.

Label Lets you add a label (text) to a report.

Circle Lets you add a circle to a report.

Rectangle Lets you add a rectangle to a report.

Link Lets you link two or more elements (graph, table, and tabbed 
page) in a report. For more information about how to link 
elements in a report, see Linking Elements on page 171.

Table 4 Report Builder Insert Menu Options (cont’d)

Menu 
Option Description

Ensure that all the windows that you want to tile are open. You cannot tile minim
windows.
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Help Menu

Table 5 Report Builder Window Menu Options

Menu Option Description

Tile Arranges the open Report windows so that they 
fill the entire Report Builder window without 
overlapping.

Tile Vertically Arranges all of the open Report windows 
side-by-side, so that they fill the entire window 
without overlapping.

Tile Horizontally Arranges the open Report windows top to bottom 
so that they fill the entire window without 
overlapping.

Cascade Arranges all of the open Report windows in an 
overlapping fashion so that each title bar is 
visible.

Open Windows 
List

Lists, in the order in which you opened them, all 
the Report windows opened during the current 
session. A bullet appears next to the report that 
you are currently viewing.

Table 6 Report Builder Help Menu Options

Menu Option Description

Help Topics Displays a list of topics available within the Help 
system.

About Report 
Builder 

Displays version and copyright information for 
Report Builder.
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Toolbars

Report Builder has a General toolbar and a Report Builder toolbar. They 
contain buttons for the most frequently used tasks.

General Toolbar
The following figure shows the General toolbar. By default, it always appears 
in the toolbar area of the Report Builder window.

Report Builder Toolbar
The Report Builder toolbar appears below the General toolbar when the 
Report window is the active window. The following figure shows the Report 
Builder toolbar.

1 2 3 4 5 6 7 8 9 10 11 12 13 14

1. New
2. Browse
3. Open
4. Save
5. Save All
6. Print

7. Delete
8. Cut
9. Paste
10. Copy
11. Tile Horizontally
12. Tile Vertically

13. Tile
14. Cascade

1. Line
2. Circle
3. Image
4. Label
5. Rectangle
6. Combo Box
7. Graph

8. Table
9. Tabbed Area
10. Input Combo Box
11. Input Field
12. Link Elements
13. Align Left
14. Align Right

15. Align Top
16. Align Bottom
17. Align Vertical
18. Align Horizontal
19. Refresh
20. Refresh All

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
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Components Window

The Components window displays a report’s elements and the elements’ 
properties. The following figure shows the Components window.

The Components window comprises the following panes:

• Components tree – Displays the hierarchical contents of the report that 
is currently displayed in the Report window. A report’s content is 
organized into levels. You can expand and collapse these levels. When you 
select items in the level, the Properties list displays the properties of that 
level. For more information about the hierarchical contents of a report, see 
Report Levels on page 38.

Components window 

Properties list

Components tree
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• Properties list – Lists the properties and values for the selected level or 
item in the Components tree. You can select most properties in the list and 
modify them. For more information about modifying properties, see 
Changing Element Properties on page 133.

Report Levels

Within a report, there are three hierarchies of information: Parameters, 
Elements, and Links. For example, each time you create an element in a 
report, Report Builder adds an element item to the Elements level of the 
report. The following figure shows the levels and the items that can appear in 
the Elements level of a report.

You can expand the hierarchical levels of a report just as you do when you 
view the contents of a Windows system using Windows Explorer. You can 
expand the Elements level of a report to see the additional levels and items it 
contains, or collapse those levels. 

If you click on a level or an item and it has properties, they will appear in the 
Properties list.

To change level and item properties, you can do one of the following depending 
on the level or item that is selected:

• Change the properties displayed in the Properties list.

• Right-click a level or an item to select options from a shortcut menu.

For more information about modifying properties, see Chapter 3, Creating 
Reports.
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Elements

The Elements level contains a report’s elements, the elements’ properties, and 
their data queries. An element is a graphic object (for example, a line or an 
image, a label, a table, a graph, or a tabbed page). 

The following figure shows how the Table level appears.

The following figure shows how the contents of the Graph level appear.
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Table 7 Graph and Table Levels’ Contents

Level Element Contains...

Data Both The folder for data queries (Query). The 
Query folder contains the following 
folders: Selected Statistics, Statistics, 
Sort Order (for selected statistics), 
Group By, Constraint List (which 
contains Time Period, the time period for 
data selection), and Nodes (the nodes for 
data selection).

Title Area Both Title properties 

Legend Area Graph Legend properties

Properties Graph Properties for the following: X-axis and 
the y-axis, region, chart, and legend

Row Properties Table Row properties

Column Properties Table Column properties
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The following figure shows how the contents of a Tabbed Area level appear. 

Tabbed areas contain the levels listed in Table 7 for tables and graphs; 
however, those levels are contained beneath the tab they appear on.

Parameters

A parameter specifies a name for a value. This name can be used in 
constraints, where the current value will be automatically substituted. For 
more information about creating parameters, see Creating Parameters on 
page 200.
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The following figure shows how the contents of the Parameters level may 
appear when parameters are defined in a report.

Links

One element can link to another element in a report. You can link tables, 
graphs, and tabbed pages. For more information about linking elements, see 
Linking Elements on page 171.

The following figure shows how the contents of the Links level may appear 
when a report contains links.
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Report Window

The Report window appears in the Report Builder window after you open a 
new or existing report. Figure 2 on page 25 shows the Report window.

When the Report window is active, you can create a new report in it or modify 
the report it displays. When you close the Report window, you close the report 
file. 

The current list of open reports appears in the Window menu in the order in 
which you opened them; a bullet appears next to the active Report window as 
shown in the following figure.

Logging Windows

Report Builder can display two different types of logging windows, the Log 
Viewer and the Output Viewer windows.
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Log Viewer Window

The following figure shows the Log Viewer window. It displays the contents of 
Report Builder’s log file (builder.log). The log file messages are categorized 
by type (all, info, warning, error, and debug). (This is a dockable window.) 

To display the Log Viewer window, choose Log File from the View menu. 

To clear the messages in the window, right-click the Log Viewer window and 
choose Clear from the shortcut menu. 
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Output Viewer Window

The following figure shows the Output Viewer window. It displays the log file 
messages as they are written to the builder.log file. (This is a dockable 
window.) 

To display the Output Viewer window, choose Log Output from the View menu. 

Status Bar

The status bar, which is located at the bottom of the Report Builder window, 
displays the status information for the current operation. The following figure 
shows the status bar.

The status bar has the following components:

1. Status text 2. Progress bar 3. Current pointer 
location

1 2 3
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• Status text. Displays messages about the current operation. 

For example, when a report is loaded, the following message appears in 
the status text area:

Ready 

• Progress bar. Displays a completion percentage for operations that may 
take some time. 

• Current pointer location. The coordinates display the current location of 
the mouse pointer in relation to the upper left-hand corner of the Report 
window. This is useful when you are drawing an element in the Report 
window.
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3 Creating Reports
Using HP OpenView Performance Insight’s (OVPI) Report Builder, you can 
create new reports or modify existing reports. This chapter describes how to 
do the following:

• Create, select, resize, move, cut and paste, and delete report elements.

• Set the preferences (defaults) that Report Builder will use when you 
create a report.

• Change Report Builder’s options.

• Save, print, open, and close reports.

• Export reports, tables, graphs, and graph overlay data.

Creating a Report

To create a report: 

1 Do one of the following:

• To create a new report, do one of the following:

— Choose New from the File menu, and then choose Report from the 
shortcut menu. 

— Click  on the general toolbar, choose Report from the Create 
New dialog box, and then click OK.

• To modify a report on your system, follow the procedure in Opening 
Reports on Your System on page 50, and then proceed with step 2.

• To modify a report on the Web Access Server, choose Browse from the 
File menu. 
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The Login dialog box opens. 

2 Enter your username and your password, and click Login.

• If you are creating a new report, the Components and Report windows 
appear. By default, Report Builder creates a blank report with the 
following filename: Untitled-1.rep. The Report Builder toolbar 
displays.

• If you are modifying a report on the Web Access Server, go to step 2 in 
Opening Reports on the Web Access Server on page 51, and then 
proceed with step 3 in this procedure.

3 Reposition the windows as needed (see Figure 2 on page 25).

4 Use the Report Builder toolbar, the Insert menu, or the shortcut menus 
available in the Components tree to create your report. 

5 After you create elements, you can do any of the following:

• Link the report’s tables, graphs, and tabbed areas (see Linking 
Elements on page 171).

You only have to log on the first time you open or browse for an 
existing report.

To See

Display a grid in the Report 
window.

Displaying the Grid on page 53

Create elements (images, labels, 
graphic objects, tables, graph, and 
tabbed areas).

Adding Elements on page 53

Select elements. Selecting Elements on page 107

Position and transfer elements 
(move, microposition, resize, copy, 
cut, and paste).

Positioning and Transferring 
Elements on page 109

Delete elements. Deleting Elements on page 111

Align elements. Aligning Elements on page 112

Refresh the Report window. Refreshing Elements on page 113

Change the Report Builder 
options.

Specifying Options on page 120
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• Modify your report by doing the following:

— Modify graphs (see Modifying Graphs on page 136).

— Modify tables (see Modifying Tables on page 158).

— Create a deferred selection (see Creating Reports with Deferred 
Selections on page 162).

— Modify how graph and table elements will select data from the 
database (see Modifying Data Selection on page 183).

— Specify more advanced ways (constraints and parameters) to 
define data selection (see Creating Constraints on page 195 and 
Creating Parameters on page 200).

6 After you create your report, do any of the following:

To See

Save the report. Saving Reports on page 127

Print the report. Printing Reports on page 129

Close the report. Closing Reports on page 130

Generate and schedule the report. Scheduling and Generating 
Reports on page 217

Deploy the report to the Web Access 
Server in order to view it using the Web 
Access Server.

Deploying Reports on page 237

View the report using Report Viewer or 
the Web Access Server.

Viewing Reports on page 272 
Viewing Deployed Items on 
page 291
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Opening Reports

You can open the following types of reports:

• Report Definition (.rep) — A type of report that retrieves data from the 
database each time you run the report.

• Dataset (.srep) — A type of report that contains a snapshot of data taken 
from a database. For example, you can save a.rep file as a.srep file and 
use it as a demo report.

You can open a report by using any one of the following methods:

• Open dialog box – Lets you open reports that are located on your system. 
See Opening Reports on Your System on page 50.

• Browser window – Lets you open reports that have been deployed to the 
Web Access Server. See Opening Reports on the Web Access Server on 
page 51.

• builder command – Lets you open reports on your system or those that 
have been deployed to the Web Access Server. For more information about 
the builder command, refer to the HP OpenView Performance Insight 
Reference Guide.

• Drag-and-drop – Lets you drag a report from your file management 
application (for example, Windows Explorer) and drop it into the Report 
Builder window. See Opening Reports Using Drag-and-Drop on page 52. 

Opening Reports on Your System

To open a report on your system:

1 Do one of the following:

• On the General toolbar, click .

• From the File menu, click Open. 

When using Report Builder only, you can open dataset reports (.srep) 
without logging on to the application.
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The Open dialog box opens. 

2 Navigate to the folder that contains the report you want to open. 

3 To open the report, do one of the following:

• Double-click the report.

• Select the report, and then click Open. 

Opening Reports on the Web Access Server

To view a report on the Web Access Server, the report must be deployed there 
first. You can deploy reports to the Web Access Server using any of the 
following applications: 

• Deployment Wizard (see Using the Deployment Wizard on page 238)

• Web Access Server (see Deploying and Undeploying Reports on page 284)

To open a report located on the Web Access Server:

1 Do one of the following:

• On the General toolbar, click .

• From the File menu, click Browse. 
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The Browser window opens.

Reports are deployed to the following folders:

• System – All users can view the reports deployed in this folder; 
however, only the Administrator can deploy reports here.

• Users – This folder contains user-specific folders, which contain 
deployed reports. There is one folder for each user in the Users folder. 
Only the user who owns the folder and the Administrator can view the 
reports deployed in this folder. 

2 Expand the folder that contains the report you want to open. A list of 
reports in the folder appears.

3 Double-click the report you want to open. 

Opening Reports Using Drag-and-Drop

You can drag a report from your file management application (for example, 
Windows Explorer) and drop it into the Report Builder window.

To open a report using the drag-and-drop method:

1 Using your file management application, find the report that you want to 
open.

2 Ensure that Report Builder is running.

3 Drag the report to the Report Builder window. 

If you have not logged on to the application yet, log on using the Login 
dialog box which will open.

The report is displayed.
52 Chapter 3



Displaying the Grid

You can display a grid to help you size and position elements in the Report 
window. When the grid is displayed, elements that you create or move will 
snap to the grid. 

To display the grid, choose Grid from the View menu. 

Adding Elements

You can add elements to a report using the Report Builder toolbar, the Insert 
menu, and the shortcut menu, which is available when you right-click the 
Elements level in the Components tree.

You can add the following kinds of elements: 

• Images – See Adding Images on page 54.

• Labels – See Adding Labels on page 56.

• Graphic objects (circles, rectangles, and lines) – See Adding Graphic 
Objects on page 58.

• Tables – See Adding Tables and Graphs on page 62.

• Graphs – See Adding Tables and Graphs on page 62.

• Combo Box – See Adding a Combination Box (Combo Box) on page 59.

• Tabbed areas – See Creating Tabbed Areas on page 91.

After you add an element to a report, the element will appear in the Report 
window, and an element item will appear in the Components tree of your 
report. For example, after you add an image, the text “Image” appears in the 
Components tree. You can change an element’s name (see Changing Element 
Names on page 113).
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Adding Images

You can add an image (for example, a company logo) to your report. The 
following file formats are supported: 

• .gif 

• .jpg 

• .png 

Adding an Image

To add an image:

1 Do one of the following:

• On the Report Builder toolbar, click .

• From the Insert menu, click Image. 

• Right-click the report’s Elements level, and choose Insert Image from 
the shortcut menu.

The pointer changes to a crosshair.

2 Do one of the following:

• To create an element of a default size (20 x 20 pixels), click the 
crosshair pointer in the Report window. 

• To create an element of an exact size, position the crosshair pointer in 
the Report window where you want the upper-left corner of the 
element, and then drag the pointer until you reach the desired size.
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The Open dialog box opens.

3 Navigate to the folder that contains the file you want to include.

4 Do one of the following:

• Select the file, and click Open.

• Double-click the file.

The image appears in the Report window, and an “Image” item appears in 
the Components tree. You can change an element’s name (see Changing 
Element Names on page 113).

Editing an Image

To edit an image:

1 Select the image in the Report window or in the Components tree.

The Properties list displays the image’s properties and the current values 
for those properties. 

An image’s properties are Name, Description, Width, Height, X, Y, 
Foreground, and File Name. For a description of each of these, see 
Appendix A, Element Properties. 

2 Click the Value box next to any property to change its value. 

For example, to change the image: 

a Click the Value box next to File Name. The Open dialog box opens.
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b Locate a new image.

c Do one of the following:

— Select the file, and click Open.

— Double-click the file.

The new image appears in the Report window.

3 To update the value, click in another Value box or move the pointer over 
the image.

Adding Labels

To add a label:

1 Do one of the following:

• On the Report Builder toolbar, click .

• From the Insert menu, click Label. 

• Right-click the report’s Elements level, and choose Insert Label from 
the shortcut menu.

2 Do one of the following:

• To create an element of a default size (100 x 40 pixels, 100 being the 
width and 40 being height), click the crosshair pointer in the Report 
window. 

• To create an element of an exact size, position the pointer (a crosshair) 
in the Report window where you want the upper-left corner of the 
element, and then drag the pointer until you reach the desired size.

A red box appears. By default, the text, “Label”, appears in the box.

3 Click the pointer in the box. An insertion point appears.

4 Enter the text you want.

The label appears in the Report window, and a “Label” item appears in the 
Elements level of the report. You can change an element’s name (see 
Changing Element Names on page 113).

For more information about how to align labels, see Aligning Elements on 
page 112.
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Modifying a Label

You can do the following to modify a label:

• Edit label text.

You can edit label text using the Report window or the report’s Properties 
list. 

• Change text attributes (font, size, bold, italics).

Editing Label Text

You can edit label text by using the Report window or the Properties list. You 
can also use the following key sequences to edit label text: CTRL+C (copy), 
CTRL+X (cut), and CTRL+V (paste).

To edit label text using the Report window:

1 Click the label to select it. An insertion point appears.

2 Edit the text.

To edit label text using the Properties list:

1 Click the label in the Report window. The label element is selected in the 
components tree.

2 In the Properties list, click the Value box next to Text. The Label Text 
dialog box opens.

3 Edit the text.

4 Click OK.

Changing Text Attributes

To change text attributes:

1 Select the label in the Report window or in the Components tree.

The Properties list displays the label’s properties and the current values 
for those properties. 
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An image’s text attribute properties are Font Name, Font Size, Bold, and 
Italic. For a description of each of these, see Appendix A, Element 
Properties. 

2 In the Properties list, click the Value box next to the property you want to 
change, and select or type another value.

3 To apply the change, do one of the following:

• Place the pointer over the label in the Report window.

• Click in any other Value box in the Properties list.

• Text box only: Press ENTER after you type the value.

Copying, Cutting, Pasting, and Deleting a Label

To copy, cut, paste, or delete a label:

1 Click the label in the Report window to select it.

2 Do the following:

• To copy a label, choose Copy from the Edit menu or press CTRL+C.

• To paste a label, choose Paste from the Edit menu or press CTRL+V. 
(The label is pasted on top of the label that you copied.)

• To cut a label, choose Cut from the Edit menu or press CTRL+X. 

• To delete a label, do one of the following:

— Press the DELETE key.

— Choose Delete from the Edit menu.

— Right-click the label, and choose Delete Label from the shortcut 
menu.

Adding Graphic Objects

To add a line, circle, or rectangle:

1 Do one of the following:
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• On the Report Builder toolbar, click the button for the object you want 
to add. 

• From the Insert menu, click the object you want to add.

• Right-click the report’s Elements level, and choose the object you want 
to add from the shortcut menu.

2 Do one of the following:

• To create an element of a default size, click the crosshair pointer in the 
Report window. Note that the default size for a rectangle or a circle the 
default size is 20 x 20 pixels, while for a line it is 0 pixels.

• To create an element of an exact size, position the pointer (a crosshair) 
in the Report window where you want the upper-left corner of the 
element, and drag the pointer until you reach the desired size.

The object appears in the Report window, and a “Line”, “Circle”, or 
“Rectangle” item will appear in the Elements level of the report, 
depending on the type of object you added. To change the name of the 
element, see Changing Element Names on page 113.

Adding a Combination Box (Combo Box)

You can add a combination box (also known as combo box) to a report. You 
might use the combination box to update a value in a table or a graph. 

For example, suppose you want to create a report that filters an entire 
interface set by several common criteria and then displays this information in 
a table. First, you would need to set up several combination boxes for the 
criteria selection, and then you would need to link those boxes to the table 
that will display the information. When the report is complete, the table 
would show only the interfaces that met the selection criteria.

Graphic Object Toolbar Button

Line

Circle

Rectangle
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One such combination box that might be created in this scenario ia a box that 
lets you choose an interface based on customer assignment. The procedure in 
this section shows how such a combination box might be created.

To add a combination box to a report:

1 Do one of the following:

• On the Report Builder toolbar, click .

• From the Insert menu, click Combo Box.

• Right-click the form’s Elements level, and choose Combo Box from the 
shortcut menu.

2 Do one of the following:

• To create an element of a default size (100 x 40 pixels), click the 
crosshair pointer in the Report window. 

• To create an element of an exact size, position the crosshair pointer in 
the Report window where you want the upper-left corner of the 
element, and then drag the pointer until you reach the desired size.

The Combo Box wizard opens.

3 Enter a name for the combo box (for example, Customer Selection) and 
then click Next. (A name and a description is optional.)

4 To select a database table that the combination box will display:

a Expand a data source folder (for example, Generic)

b Select a data table (for example, KV_CUSTOMER).

c Click Next.

5 Select the statistics you want to use to populate your combo box.

a To select a statistic, do one of the following: 

— Double-click a statistic in the Choose from box.

— Select a statistic in the Choose from box, and click .

b To remove a statistic from the Select Statistics dialog box, do one of 
the following:

— Double-click a statistic in the Selected statistics box.
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— Select a statistic in the Selected statistics box, and click .

c Click Next. 

For example, for customer selection, you might choose cust_name, Key ID, 
and cust_id.

6 In the Display Statistic list, click the statistic that you want to assign to 
the combination box and then click Next.

For example, select cust_name to assign the customer’s name to the box.

7 Do the following: 

a Review the summary of the information that the combination box will 
contain. 

b If necessary, click Back to return to make a change. After you make 
any changes, click Next until you return to the summary.

c Click Finish.

A combination box is created in the Report window. The combination box for 
customer selection mentioned in the example scenario may look similar to the 
following after it is created:

You would need to link any combination boxes to the table that will display 
the information. 

When Customer Unassigned is selected, the associated table shows all rows 
for which the cust_id statistic is not defined. When a specific customer is 
selected, the associated table shows only the rows that pertain to the selected 
customer.

After you create a combination box, you can use the Components tree to 
change its properties. Specifically, you can add a label “Select Customer” to 
the top of a combination box, which will appear as the first option in a 
combination box. This option will choose data from the destination element 
without applying any constraints. 
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To locate these properties, select the Combination box in the Components tree. 
In the properties list, you will see Enable No Constraints Option, No 
Constraints Label, and Default to No Constraints. For more information about 
each of these properties, see Appendix A, Element Properties.

Adding Tables and Graphs

The Table and Graph wizards let you add tables and graphs elements to 
reports. The wizards prompt you to specify some or all of the following 
information depending on the type of element you are creating and the 
method you are going to use to create that element:

• Name and Description

Lets you enter a name for the element and a description. These become 
the element’s Name and Description properties in the report’s Properties 
list.

• Select a Data Source 

Lets you select a database table from which to obtain data for the element. 
Report Builder interrogates the database and displays a list of the 
different reporting groups found. 

A group is a related set of database tables, typically organized by 
technology (such as RMON or Frame Relay) or by vendor (such as Empire 
or Cisco). Under each group, there are folders organized by technology 
that contain tables or a list of database tables. The tables are listed by 
their SQL names and include raw, rate, and summary tables.

• Choose the Time Column’s Name

Lets you choose the time column’s name if you have selected a table from 
the Property Tables or Generic categories, which collect their data based 
on time.

• Select Statistics

Lets you select the statistics the element will display. A statistic is usually 
an expression or an SQL table column name. This includes SQL aggregate 
functions like min., max, and avg.

• Set Time Period

Lets you select the time period for which the element will select data.

• Add Titles
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Lets you specify the title of the element.

• Nodes, interfaces or both

Lets you select the nodes, interfaces or both from which the element will 
retrieve data if you have selected a table from the Managed category. 

• Graph only: Select Graph Attributes

Lets you select whether the graph’s data should be graphed by time or by 
node if you selected a table from the Managed category.

• Graph only: Select Graph Style

Lets you select one of the following graph styles: Area, Stacking Area, Bar, 
Stacking Bar, Pie, Plot, Scatter Plot.

• GOS Graph only: Y-axis labels

Lets you select the GOS labels and values that will appear on the y-axis of 
the GOS graph.

• GOS Graph only: Statistic weights and GOS values

Lets you select the values needed to perform the weighted average of each 
statistic.

Adding a Graph

Task 1: Select the graph option.

Do one of the following:

• On the Report Builder toolbar, click .

• From the Insert menu, click Graph.

• Right-click the report’s Elements level, and choose Insert Graph from the 
shortcut menu.

You can defer node and interface selection until you view the report. 

You can defer a report only if you are selecting Time Period, or Node and 
Interface, or both.

For more information about how to defer node and interface selection, see 
Creating Reports with Deferred Selections on page 162.
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Task 2: Specify the size of the graph in the report.

Do one of the following:

• To create an element of a default size (200 x 200 pixels), click the pointer 
in the Report window. 

• To create an element of an exact size, position the pointer (a crosshair) in 
the Report window where you want the upper-left corner of the element, 
and then drag the pointer until you reach the desired size.

Figure 5 Element Name and Description Window

Task 3: If needed, specify a name for the table and a description of it.

1 In the Name box, enter a name for the element. (This becomes the 
element’s Name property in the report’s Properties list.)

2 In the Description box, enter a description of the element. (This becomes 
the element’s Description property in the report’s Properties list.)

3 Click Next.

Supplying this information is optional. To enter a name and description, go to 
Task 3; otherwise, click Next and go to Step 4.
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Task 4: Choose a graph style.

Figure 6 Select Graph Style Window

1 Choose a graph style.

2 Click Next.
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Task 5: Select a data source for the graph.

Figure 7 Select a Data Source Window 

1 Expand the data source folders and select the data table that you want 
from one of the following folders:

• Managed Category. This folder contains all the different data 
collections that are configured within OVPI. All tables found within 
this folder are registered data tables that are managed by report 
packs. Selecting a table from this folder will give you access to the 
time-series data associated with the specific property table of the 
management category. An implicit data join will be made between the 
data table and property table pair.

You will be allowed to build a query against a data table and its 
property table. The set of available statistics is all of the columns in 
the data table and all of the columns in the property table.

If Archive tables have been added, the data sources list will include 
Archive tables under the DeviceResource folder. For each category, 
tables are listed in active and archive subfolders.
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• Generic. This folder contains all the data collections found in the 
database. Thus, if you want to graph data from generic or non-OVPI 
tables, these tables would appear in this folder and not in the 
Managed Category folder. 

2 To create a Grade of Service (GOS) graph, select the Create as a GOS 
graph box. 

Grade of service is used for system health reporting and Service Level 
Agreements (SLAs). See Creating Grade of Service Graphs on page 78 for 
more information.

3 Click Next. 

Task 6: Select how the data should be graphed.

Figure 8 Select Graph Attributes Window

1 Do one of the following:

Occasionally, there is no data available for a graph. This can happen when 
polling cycles are missed or network errors occur. You can decide how to graph 
missing data by setting the Hole properties after you create the graph. For 
more information, see Displaying Missing Graph Data on page 156.
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• Click Time to graph the data by time. 

• Click Node to graph the data by node. 

2 Click Next. 

3 Do one of the following depending on the type of data source you have 
selected for the graph:

• Managed Category.

• Generic. Do one of the following depending on the way in which you 
choose to graph the data:

— Time. Go to Task 7.

— Node.

Task 7: Select the name of the time column. 

Figure 9 Enter the Column’s Name Window

1 Select the name of the time column from the Time Column Name list.

2 Click Next.
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Task 8: Select the node columns. 

Figure 10 Select Node Columns Window

1 To select a node column, do one of the following: 

• Double-click a node column in the Choose from box.

• Select a node column in the Choose from box, and click .

2 To remove a node column from the Node Columns box, do one of the 
following:

• Double-click a node column in the Node Columns box.

• Select a node column in the Node Columns box, and click .

3 Click Next. 
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Task 9: Select the statistics that the graph will display.

Figure 11 Select Statistics Window

To select and remove statistics:

1 To select a statistic, do one of the following: 

• Double-click a statistic in the Choose from box.

• Select a statistic in the Choose from box, and click .

2 To remove a statistic from the Select Statistics dialog box, do one of the 
following:

• Double-click a statistic in the Selected statistics box.

• Select a statistic in the Selected statistics box, and click .

3 Click Next. 

If you selected a table from the managed category, the Select 
Nodes/Interfaces window opens, go to Step 10 on page 71; otherwise, go to 
Step 13 on page 74.
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Figure 12 Select Nodes/Interfaces Window

Task 10: Select the nodes and interfaces from which the graph will display data. 

Do one of the following:

• Click Next to select data from all nodes and interfaces (Use All 
Nodes/Interfaces), which is the default.

• Click Use Selected Nodes/Interfaces to select specific nodes and interfaces. 

To select specific nodes and interfaces, do the following:

a Expand a node’s folder to display its interfaces. 

b To select a node or an interface, do one of the following: 

— Double-click a node or an interface in the Choose from box.

— Select a node or an interface in the Choose from box, and 

click . 

c To remove a node or an interface, do one of the following:

If you select a node, all of its interfaces are automatically selected.
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— Double-click a node or an interface in the Selected 
Nodes/Interfaces box.

— Select a node or an interface in the Selected Nodes/Interfaces box, 

and click .

d When you have selected the nodes and interfaces that you want, click 
Next. 

Depending on which wizard window opens next, do the following:

• Create y-axis Labels window. (See Figure 15 on page 80.) This window 
opens if you selected the Grade of Service option in step 1 on page 65. To 
complete your GOS graph, see Creating a GOS Graph on page 80.

• Set Time Period window. (See Figure 15 on page 80.) This window opens if 
you did not select the Grade of Service option in Step 1 on page 65. Proceed 
with Task 11.

Task 11: Set a time period for the graph.

Figure 10 shows the Set Time Period window. 
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• Select Use Relative Time. Go to Task 12.

• Select Use Absolute Time. Go to Task 13.

Task 12: Set a relative time period.

1 In the Start box, do one of the following:

• To select a current time period, click the This time period button. Click 
the time period arrow and select an option. For example, if the time 
period is This Week, the report displays data for the current week.

• To select a previous time period, click the Previous n time period button. 
Enter a number in the box, and then click the time period arrow, and 
select an option. For example, if the time period is Last 1 Week(s), the 
report displays data for the last full week (Sunday to Sunday) prior to 
the current date.

2 In the Duration box, do one the following:

• Click Default to use the default duration period.

• Click For n time period to set the duration. Enter a number in the box, 
and then click the time period arrow, and select an option.

• Click Until Now to display data for selected time period up until the 
current time. For example, if it is Thursday, and you select a time 
period of 1week, the report will display data for the prior week 
(Sunday to Sunday) through Thursday.

3 Click Next.

4 Go to Step 14 on page 76.
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Task 13: Set an absolute time.

The initial start and end times in the Set Time Period window (absolute time) 
represent the range of available data in the database. 

1 Click the Browse button next to the Start Time box or the End Time box. A 
window similar to this one opens: 
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2 Click the down arrow to display a calendar, similar to the one below: 

3 Click the Month and Year arrows to select the month and year you want.

4 Click the Hour, Minutes, Seconds, and Time of Day arrows to select the 
time.

5 Click a date in the calendar. 

After you click a date, the calendar window closes, and the selected date 
and time display in the Start Time (or End Time) window. You can click 
the down arrow to reopen the calendar if you want to make changes.

6 Click OK when you finish setting the date and time.

7 Click Next. 
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Task 14: Specify one or more titles for the graph.

Figure 13 Add Titles Window

1 Select a Titlen check box.

2 Enter a title in the text area. A title can have up to three lines.

3 Click Next.
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Task 15: Close the graph wizard.

Figure 14 Summary Window

Click Finish.

The graph appears in the Report window, and a graph item appears in the 
Elements level of your report.

Selecting Colors for Multi-Node Graphs

The Report Builder allows you to control the colors of statistics rendered in 
multi-node graphs using a color map file.

color.prp File

The color.prp file is located in the $OVPI_HOME/data directory. This file 
contains, by default, a list of 20 colors in RGB (#FFEEDD) format. The OVPI 
administrator can change this list by adding or removing color entries.

Multi-node graphs initially use the color.prp file to assign colors to the 
statistics rendered in the graph. For example, the first four colors in the 
color.prp file could be red, green, blue, and orange, and the first four 
statistics rendered in the graph will display using these colors. Once the 
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report is saved, the colors are saved within the report file on a per element 
basis. Therefore, each graph will have its unique color settings. Once saved, 
the report uses the saved colors rather than the values set in the color.prp file.

Using the color.prp File

The Report Builder contains the Color Map property for a multi-node graph 
displayed under the Elements level of the components tree. Right-click the 
Color Map property. This opens the Color Map dialog box. The dialog box 
initially contains the 20 colors from the color.prp file. To change a color, 
right-click the color and select a new color from the resulting color palette. Use 
the buttons in the Color Map dialog box to change the order of the color list, or 
to add and delete colors from the list.

The Color Map property also contains a Size property, an editable parameter 
that lets you set the number of colors in the color map. The default is 20, based 
on the number of color entries in the color.prp file. If you increase the value of 
the size property beyond the number of available colors in the color.prp file, a 
random color will be used for each new color entry.

Creating Grade of Service Graphs

When you create a graph, you have the option of making the graph a Grade of 
Service (GOS) graph. GOS is used for system health reporting and Service 
Level Agreements (SLAs). GOS converts sets of individual historical 
performance statistics into a graph using a weighted stacked-bar format. 

You can select any set of metrics and assign a grading scale to each based on 
the relative importance of that metric. A grading scale (for example, excellent, 
good, fair, and poor) allows you to concentrate troubleshooting efforts 
immediately on areas where performance is substandard.

Grade of Service reports alleviate data overload that can result from massive 
amounts of network data available from countless devices and sources. 
Critical parameters for a given device are rolled up into an overall indicator 
that reflects that device’s performance level.

Adding more colors to the color.prp file could affect the loading performance of 
reports. Once a report is saved, these colors are added to the report file. 
Having a large number of colors may slow the rendering process because 
these colors are replicated for each graph element in the report.
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Grade of Service Example

Suppose you want to compute the GOS for a particular LAN segment. You 
determine that the significant parameters contributing to your LAN GOS are 
Utilization, Collisions, Errors, and Overhead. Table 8 lists the relative 
contributions of those parameters.

You decide to include the following categories of service in your GOS graph: 
Excellent, Good, Fair, and Poor.

In this case, a score of 1 for an individual parameter or for weighted, combined 
parameters will fall in the excellent range. Similarly, a score of 2 will be good, 
a score of 3 will be fair, and a score of 4 will be considered poor performance. 
You must also determine what ranges of scores for individual parameters 
constitute Excellent, Good, Fair, or Poor service. Table 9 lists the ranges of 
scores for your parameters.

If, at a given time, you receive a Utilization value of 6% (Good=2), Collisions of 
4% (Excellent=1), Errors of 3% (Good=2), and Overhead of 13% (Fair=3); your 
GOS for that time period is calculated as follows:

In this case, the GOS is between 1 and 2; so this score falls in the Good range.

Table 8 Example — Parameter Contributions to GOS

Parameter Weighting

Utilization 40%

Collisions 25%

Errors 25%

Overhead 10%

Table 9 Example — Score Ranges for Service Level Categorization

Excellent Good Fair Poor

< 5% 6–15% 16–30% > 30%

< 5% 6–10% 11–15% > 15%

< 1% 2–5% 6–10% > 10%

< 5% 6–10% 11–15% > 15%
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Creating a GOS Graph

To create a GOS graph, Complete tasks 1–8 in the procedure described in 
Adding Tables and Graphs on page 62. Figure 15 shows the Create Y-axis 
Labels window, which opens after you selected the Grade of Service option in 
Step 5 on page 66. 

Figure 15 Create Y-axis Labels Window

Task 1: Create the GOS labels and values that you want to appear on the y-axis of the graph.

You can have as many labels as you like. Each label has a value associated 
with it. The values shown by default in the Create Y-axis Labels window 
represent the result of the weighted average computation described in 
Creating Grade of Service Graphs on page 78.

1 In the Create Y-axis Labels dialog box, do the following:

a To edit a label, click the Axis Label or Value boxes, and enter a new 
axis label or value.

0.40 2×( ) 0.25 1×( ) 0.25 2×( ) 0.10 3×( )+ + +

0.80 0.25 0.50 0.30 1.85=+ + +
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b To add a label to the list, click . 

c To delete a label from the list, select the label, and click .

d To rearrange the order of the labels in the list, select a label from the 
list, and then do one of the following:

– Click  to move a label up in the list.

– Click  to move a label down in the list.

2 When you are finished, click Next.

Task 2: Select the values needed to calculate the weighted average of each statistic.

Figure 16 Statistic Weights and GOS Values Window
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In the example described in Grade of Service Example on page 79, the 
parameters In Utilization and Out Utilization each contribute 50% to the GOS 
weighting. Both statistics have the same valuations (0% - 10% is Excellent, 
11% - 15% is Good, 16% - 35% is Poor, and 36% and greater is Critical).

1 To modify the values, click the cell you want to change.

2 Type a new value.

You can use the TAB key to advance to the next box. 

3 Click Next.

4 To complete the graph, go to Task 11 on page 72. 

You can change the y-axis labels and weighted values after you create the 
graph. To change these values, see Changing GOS Y-Axis Labels on page 155 
and Changing GOS Weighted Values on page 156, respectively.

Adding a Table

Task 1: Select the table option.

Do one of the following:

• On the Report Builder toolbar, click .

• From the Insert menu, click Table.

• Right-click the report’s Elements level, and choose Insert Table from the 
shortcut menu.

Task 2: Specify the size of the table in the report.

Do one of the following:

• To create an element of a default size (200 x 200 pixels), click the pointer 
in the Report window. 

• To create an element of an exact size, position the pointer (a crosshair) in 
the Report window where you want the upper-left corner of the element, 
and then drag the pointer until you reach the desired size.

Before you click Next in the Statistic Weights and GOS Values 
dialog box, ensure that you verify that the sum of all the weights is 
100, and that each statistic’s weighted value increases.
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Task 3: If needed, specify a name and description for the table. 

The Element Name and Description window opens (Figure 5 on page 64). 

1 In the Name box, enter a name for the element. (This becomes the 
element’s Name property in the report’s Properties list.)

2 In the Description box, enter a description of the element. (This becomes 
the element’s Description property in the report’s Properties list.)

3 Click Next.

Task 4: Select a data source for the table.

Figure 17 Select a Data Source Window

Supplying this information is optional. To enter a name and 
description, go to Task 3; otherwise, click Next and go to Step 10 on 
page 89 of this procedure.
Creating Reports 83



1 Expand the tree until you find the data table you want. 

The following folders are available:

• Managed Categories. This folder contains all the different data 
collections that are configured within OVPI. All tables found within 
this folder are registered data tables that are managed by report 
packs. Selecting a table from this folder will give you access to the 
time-series data associated with the specific property table of the 
management category. An implicit data join will be made between the 
data table and property table pair.

• Property Tables. This folder contains property tables. These are not 
data holding tables. These tables list all the objects managed by OVPI. 
A single query will be made to the selected table with no joins.

• Generic. This folder contains a list of all database tables that can be 
accessed by the OVPI clients. These tables can be anything from the 
actual tables required to manage OVPI itself, to the actual data and 
property tables. This is for advanced users. A single query will be 
made to the selected table with no joins.

• Custom Query. Lets you type an SQL SELECT statement, which will 
select data from a table in the database that you are currently 
connected to. 

2 Select the data table, then click Next. 

Depending on the type of table you selected, one of the following happens:

• If you selected a table from the property or generic categories, the 
Determine if the Table is Time-Based window opens. Go to Task 5.

• If you selected Custom Query, the Enter the Generic SQL Statement 
window opens. Go to Table 7 on page 87.

• If you selected a table from the managed category, the Select Statistics 
window (Figure 11 on page 70) opens. Go to Table 8 on page 87.
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Task 5: Specify if the data table is based on time.

Figure 18 Determine if the Table is Time-Based Window

1 Specify if the table you selected from the Select a Data Source window is 
time-based by clicking Yes or No.

2 Click Next.

Do one of the following:

• If you clicked Yes, the Enter Time Column’s Name window opens. Go to 
Step 6 on page 86.

• If you clicked No, go to Step 8 on page 87.
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Task 6: Select the name of the time column. 

Figure 19 Enter the Column’s Name Window

1 Click the Time Column Name arrow, and select the name of the time 
column from the list.

2 Click Next, and go to Step 8 on page 87.
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Task 7: Type your generic SQL statement.

Figure 20 Enter the Generic SQL Statement Window

1 In the text area, type an SQL statement that will define the data for the 
table.

2 Click Next. 

The Add Titles window (Figure 13 on page 76) opens. Go to Step 11 on 
page 89.

Task 8: Select the statistics that the table will display.

The Select Statistics window opens (Figure 11 on page 70).

1 To select a statistic, do one of the following: 

• Double-click a statistic in the Choose from box.

• Select a statistic in the Choose from box, and click .

2 To remove a statistic from the Select Statistics window, do one of the 
following:
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• Double-click a statistic in the Selected statistics box.

• Select a statistic in the Selected statistics box, and click .

3 Click Next. 

Depending on the category of table you selected, the following will occur.

• If you selected a table from the managed category, the Select 
Nodes/Interfaces window opens (Figure 12 on page 71). Go to Task 9.

• If you selected a table from the property or generic categories that was 
time-based, the Set Time Period window opens.

• If you selected a table from the property or generic categories that was 
not time-based, the Add Titles window opens (Figure 13 on page 76).

Task 9: Select nodes and interfaces.

To select nodes and interfaces, do one of the following:

• Click Next to select data from all nodes and interfaces (Use All 
Nodes/Interfaces), which is the default.

• Click Use Selected Nodes/Interfaces to select specific nodes and interfaces. 

To select specific nodes and interfaces, do the following:

a Expand a node’s folder to display its interfaces. 

b To select a node or an interface, do one of the following: 

— Double-click a node or an interface in the Choose from box.

— Select a node or an interface in the Choose from box, and click 

. 

c To remove a node or an interface, do one of the following:

— Double-click a node or an interface in the Selected 
Nodes/Interfaces box.

— Select a node or an interface in the Selected Nodes/Interfaces box, 
and click .

If you select a node, all of its interfaces are automatically selected.
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d When you have selected the nodes and interfaces that you want, click 
Next. 

Task 10: Set a relative or absolute time period for data selection.

The Set Time Period window opens. 

To select a relative time period: 

1 Click Use Relative Time.

2 To select a current time period, click the time period arrow and select a 
This time period option (This Hour, This Week, This Month, or This Year). For 
example, if the time period is This Week, the report displays data for the 
current week.

3 To select a previous time period, click the Last arrow, select an option, and 
then enter a number in the Last box. For example, if the time period is 
Last 1 Week(s), the report displays data for the last full week (Sunday to 
Sunday) prior to the current date.

4 Select the Until Now check box to display data for selected time period up 
until the current time. For example, if it is Thursday, and you select a time 
period of 1week, the report will display data for the prior week (Sunday to 
Sunday) through Thursday.

5 Click Next.

To select an absolute time period:

1 Click Use Absolute Time. See the instructions in Table 13 on page 74.

2 Click Next.

Task 11: Specify one or more titles for the graph.

The Add Titles window opens (Figure 13 on page 76).

1 Select a Titlen box.

2 Enter a title. A title can have up to three lines.

3 Click Next. 
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The Summary window opens. 

Task 12: Close the table wizard.

Click Finish.

The table appears in the Report window, and a table item appears in the 
Elements level of your report. You can change an element’s name (see 
Changing Element Names on page 113).
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Creating Tabbed Areas

A tabbed area allows multiple elements (tables and graphs) to appear in the 
same area of the report. Each element has its own tab. You can view the 
element by selecting its tab. Figure 21 shows how a tabbed area appears in a 
report.

Figure 21 Report Builder—Tabbed Area

Creating a Tabbed Area

To create a tabbed area in a report:

1 Do one of the following:

• On the Report Builder toolbar, click .

• From the Insert menu, click Tabbed Area.

• Right-click the report’s Elements level, and choose Insert Tab from the 
shortcut menu.

2 Do one of the following:

• To create an element of a default size (200 x 200 pixels), click the 
pointer in the Report window. 

• To create an element of an exact size, position the pointer (a crosshair) 
in the Report window where you want the upper-left corner of the 
element, and then drag the pointer until you reach the desired size.
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A tabbed area appears in the Report window, and a Tab item appears in the 
Elements level of the report. You can change an element’s name (see 
Changing Element Names on page 113).

Deleting a Tabbed Area

To delete a tabbed area, do one of the following:

• Right-click the Tab item in the Components tree, and choose Delete Tab 
Area from the shortcut menu.

• Right-click the tabbed area in the Report window, and choose Delete 
Tabbed Area from the shortcut menu.

Adding Tabs to a Tabbed Area

To add a tab to a tabbed area:

1 To add a table or graph tab to a tabbed area, do one of the following:

• Right-click the Tab item in the Components tree, and choose Insert 
Graph in Tab or Insert Table in Tab from the shortcut menu.

• Right-click the tabbed area in the Report window, and choose Add 
Graph Tab or Add Table Tab from the shortcut menu. 

If you want to add a tab to a tabbed area that already contains tabs, 
right-click a tab’s label to display the appropriate shortcut menu. If 
you do not click a tab’s label, the graph or table shortcut menu is 
displayed.
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The Enter a Label for the Tab window opens.

2 In the Tab Label box, type the a label for the tab, and click Next.

3 Do one of the following:

• To create a graph, go to  Task 3 and complete the procedure.

• To create a table, go to Task 3 and complete the procedure. 

Modifying Tabs

You can cut, copy, paste, and delete a tab. 

To copy, cut, paste, or delete a tab:

1 Right-click the name of the tab in the tabbed area in the Report window. A 
shortcut menu opens.
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2 Choose any of the following options from the shortcut menu:

• Copy Selected Tab. Lets you copy a tab. 

• Paste to Tabs. Lets you paste a tab. 

• Cut Selected Tab. Lets you cut a tab. 

• Delete Selected Tab. Lets you delete a tab. 

• Delete Tabbed Area. Lets you delete the tabbed area. 

Setting Tab Order

To change the order in which tabs are arranged in a tabbed area:

1 Right-click the Tab item in the Components tree, and select Set Tab Order 
from the shortcut menu.

The Set the Tab Order dialog box opens.

2 Select a tab from the Tabs list.

3 Do one of the following:

• Click  to move the tab toward the front the list.

• Click  to move the tab toward the end of the list.
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Adding a CrossTab

A CrossTab presents summarized user-defined data in a grid format. You can 
create CrossTabs in a report using the Report Builder toolbar. A simple 
example is shown below:

A CrossTab has rows, columns, and summary fields. In the example above, 
“Apples” is a row, and “Bill” is a column. Summary fields are at the 
intersection of rows and columns. Each value represents a summary, such as 
the sum, the maximum, the average, the count and so on, of the records that 
meet the row and column criteria. In the example above, the intersection of 
"Bill" and "Apples" is 1. This is the number of apples that Bill ate.

At the end of each row is a total for that row. In the example, the total 
represents all of the fruit types eaten by Bill, Fred, and Joe. In this case, seven 
apples were eaten. At the bottom of each column is a total for the column. In 
this example, this represents all of the fruit that each person ate. In this case, 
Bill ate six pieces of fruit. Finally, at the intersection of the Total column and 
the Total row is the grand total. In this case, this represents the total number 
of fruits eaten by all of the people, which is 17. Although this example is 
simple, CrossTabs can be a powerful way to present and summarize 
information. If you add multiple row and column fields to group on, CrossTabs 
can become quite complex.

Creating a CrossTab

Task 1: Select the CrossTab option.

Do one of the following:

• On the Report Builder toolbar, click .

• From the Insert menu, click CrossTab.

Bill Fred Joe TOTAL

Apples 1 2 4 7

Bananas 3 2 0 5

Oranges 2 2 1 5

TOTAL 6 6 5 17
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Task 2: Specify the size of the CrossTab in the report.

Do one of the following:

• To create an element of a default size (200 x 200 pixels), click the 
pointer in the Report window.

• To create an element of an exact size, position the pointer (a crosshair) 
in the Report window where you want the upper-left corner of the 
element, and then drag the pointer until you reach the desired size.

Figure 22 Element Name and Description Window

Task 3: If needed, specify a name for the table and a description of it.

1 In the Name box, enter a name for the element. (This becomes the 
element’s Name property in the report’s Properties list.) 

2 In the Description box, enter a description of the element. (This becomes 
the element’s Description property in the report’s Properties list.) 

Supplying this information is optional. To enter a name and description, go to 
Task 3; otherwise, click Next and go to Task 4.
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3 Click Next.

Task 4: Select a data source for the CrossTab.

Figure 23 Select a Data Source Window

1 Expand the data source folders and select one of the following options that 
best suits your requirements:

• Managed Category. This option lets you choose from all of the different 
data collections that are configured within OVPI. All tables found 
within this folder are registered data tables that are managed by 
report packs. Selecting a table from this folder will give you access to 
the time-series data associated with the specific property table of the 
management category. An implicit data join will be made between the 
data table and property table pair.

You will be allowed to build a query against a data table and its 
property table. The set of available statistics is all of the columns in 
the data table and all of the columns in the property table.
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• Property Tables. This option lets you choose from property tables. 
These are not data holding tables. These tables list all the objects 
managed by OVPI. A single query will be made to the selected table 
with no joins.

• Generic. This option lets you choose from a list of all database tables 
that can be accessed by the OVPI clients. These tables can be anything 
from the actual tables required to manage OVPI itself, to the actual 
data and property tables. This is for advanced users. A single query 
will be made to the selected table with no joins.

2 Click Next.

Depending on the type of table you selected, one of the following will 
happen:

• If you selected the Generic option, the Determine if the Table is 
Time-Based window opens. Go to step 3.

• If you selected the Custom Query option, the Enter the Generic SQL 
Statement window opens. Go to step 4.

• If you selected the Managed Category or Property Tables options, the 
Select the Rows for your CrossTab window opens. Go to step 5.

3 Do the following:

a Specify if the table you selected from the Select a Data Source window 
is time-based by clicking Yes or No.

b Do one of the following:

— If you selected No, click Next.

— If you selected Yes, the Enter the Time Column's Name window 
opens. Select the name of the time column from the list, and click 
Next. Go to step 5.

4 In the text area, type an SQL statement that will define the data for the 
table, and then click Next. Go to Task 9.

5 Select the statistics that will represent the rows in your CrossTab.
Do the following:

a To select a statistic, do one of the following:

— Double-click a statistic in the Choose from box.

— Select a statistic in the Choose from box, and click .
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b To remove a statistic from the Selected statistics box, do one of the 
following:

— Double-click the statistic in the Selected statistics box.

— Select a statistic in the Selected statistics box, and click .

c Click Next.

Task 5: Select the statistics that will represent the columns in your CrossTab.

1 To select a statistic, do one of the following:

• Double-click a statistic in the Choose from box.

• Select a statistic in the Choose from box, and click .

2 To remove a statistic from the Selected statistics box, do one of the 
following:

• Double-click the statistic in the Selected statistics box, 

• Select a statistic in the Selected statistics box, and click .

3 Click Next.

Task 6: Select the aggregations

To select the aggregations for your CrossTab, do the following:

1 Click Add. The Add Aggregation Field dialog box opens.

2 Do the following:

a In the Field list, click a field.

b In the Aggregation list, click an aggregation.

c In the Display Name box, type the display name you want for the     
aggregation.

d Click OK.

You can also do either of the following:

• To remove an aggregation, select the aggregation, and click Delete.

• To edit an aggregation, select the aggregation, and click Modify.

3 Click Next.
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Task 7: Select nodes and interfaces

To select all nodes and interfaces:

• Use All Nodes/Interfaces is selected by default.

• Click Next.

To select specific nodes and interfaces:

1 Click Use Selected Nodes/Interfaces to select specific nodes and interfaces.

2 Expand a node’s folder to display its interfaces.

• To select a node or an interface, do one of the following:

— Double-click a node or an interface in the Choose from box.

— Select a node or an interface in the Choose from box, and click 

 .

• To remove a node or an interface, do one of the following:

— Double-click a node or an interface in the Selected Nodes/
Interfaces box.

— Select a node or an interface in the Selected Nodes/Interfaces box, 

and click .

3 Click Next.

If you select a node, all of its interfaces are automatically selected.
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Task 8: Select a time period

Figure 24 Set Time Period Window

To select a time period do one of the following:

• Click Use Relative Time.

a In the Start box, do one of the following:

— To select a current time period, click the This time period button. 
Click the time period arrow and select an option. For example, if 
the time period is This Week, the report displays data for the 
current week.

— To select a previous time period, click the Previous n time period 
button. Enter a number in the box, and then click the time period 
arrow, and select an option. For example, if the time period is Last 
1 Week(s), the report displays data for the last full week (Sunday 
to Sunday) prior to the current date.

b In the Duration box, do one the following:

— Click Default to use the default duration period.
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— Click For n time period to set the duration. Enter a number in the 
box, and then click the time period arrow, and select an option.

— Click Until Now to display data for selected time period up until the 
current time. For example, if it is Thursday, and you select a time 
period of 1week, the report will display data for the prior week 
(Sunday to Sunday) through Thursday.

c To select a current time period, click the time period arrow and select 
a This time period option (This Hour, This Week, This Month, or This 
Year. For example, if the time period is This Week, the report displays 
data for the current week.

d Click Next.

• Click Use Absolute Time.

a Click  next to the Start Time box or the End Time box. A window 
opens.

b Click the down arrow to display a calendar.

c Click the Month and Year arrows to select the month and year you      
want.

d Click the Hour, Minutes, Seconds, and Time of Day arrows to select      
the time.

e Click a date in the calendar. After you click a date, the calendar 
window closes, and the selected date and time display in the Start 
Time (or End Time) window. You can click the down arrow to reopen 
the calendar if you want to make changes.

f Click OK when you finish setting the date and time.

g Click Next.

Task 9: Add Titles

The Add Titles window opens.

1 Do the following:

a Select a Title check box. Enter a title in the text area. A title can have 
up to three lines.

b Click Next.

The Summary window opens.
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2 Click Finish.

The CrossTab appears in the Report window, and the CrossTab element and 
its attributes appear in the components tree as follows:

MyCrossTab

• Rows -- The list of rows that you selected

• Columns -- The list of columns that you selected

• Aggregations -- The list of columns that will be aggregated in the 
CrossTab Data

• Title Area

As with other elements, each of the CrossTabs attributes has additional 
properties that you can change. When you click on an attribute, its properties 
display in the properties list portion of Report Builder's components window. 
Additionally, if you right-click on the Rows, Columns, or Aggregation attribute 
in the components tree, you can select an option (Change Rows, Change 
Columns, or Change Aggregations) from a menu to change the rows, columns, or 
aggregations.

Following is an example of a CrossTab. In this example, row 1 is 
dsi_target_name, row 2 is dsi_table_key, column1 is ta_period, and the 
aggregation is the sum of TOTIfInOctets.
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Applying Rules to a CrossTab

You can apply a rule to any of the following fields in a CrossTab: the 
aggregation summarization (highlighted in yellow in the CrossTab example 
above) the column grand total (gray in the above example), the row grand 
total (green in the above example), and the grand total (red in the above 
example).

To apply a rule:

1 Start the Rule wizard by doing either of the following:

• In the report’s Components tree, expand Elements, Element Name 
(the name of your CrossTab element), and Data. Right-click Rules, and 
then click Add Rule on the menu.

• Right-click in a field in the CrossTab, and then click Add Rule on the 
menu. The Rule Name and Description Window opens.

2 Do either of the following:

• Type a name and a description for the rule, and click Next. Specifying 
a name and description is optional.

• Click Next.

The Apply Rule to the Selected Field window opens.

3 Select the fields in the CrossTab to which you want to apply the rule.

a Do either of the following:

— Select a field in the Choose from box, and click the right arrow 
button.

— Double-click a field in the Choose From box.

b Click Next.

If you need to remove a selected field, do either of the following:

— Select a field in the Apply to box, and click the left arrow button.

— Double-click a field in the Apply to box.

The Add Rule Clauses window opens.

4 Add rule clauses.

a Click the New button. A clause row is added.
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b Click the Operator box, select an operator, and then press the TAB 
key.

c Type a value in the Value box, and then press the TAB key.

d Type a label for the clause in the Clause Label box, and then press the 
TAB key.

e Select one of the following options from the Set box to indicate what 
will occur when a rule is satisfied:

— Background. Displays a color behind the field’s data. When a rule 
is satisfied, the field can be highlighted with red.

— Image. Displays an image instead of the field’s data. When a rule 
is satisfied, an image of a check mark can display.

— Text. Displays user-specified text instead of the field's data. When 
a rule is satisfied, the text “Full” can display.

f Click the To box and do one of the following depending on the option 
you selected in the Set box:

— Background. Select a color from the Select a Color dialog box.

— Image. Locate an image using the Open dialog box.

— Text. Type the text you want to display in the To box.

g Repeat steps a through f to add additional clauses.

h To delete a clause from the list, select the clause, and click Delete.

i To rearrange the order in which the clauses will be evaluated, select 
the clause, and do one of the following:

— Click the up arrow to move the clause up in the list.

— Click the down arrow to move the clause down in the list.

j Click Next.

The Summary window opens.

5 Review the rule summary, and click Finish to create the rule.

Even though Statistic appears as an option, you cannot use this 
option for a CrossTab.

Even though Statistic appears as an option, you cannot use this 
option for a CrossTab.
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See Chapter 6 for information about creating rules.

Drilling Down in a CrossTab

Drilling down in a CrossTab is different from drilling down in a table. You can 
only use columns that are in the RowFields list as drilldown source columns. 
This is because the CrossTab does not have a one-to-one mapping from the 
computed fields to the rows of the underlying data table. When the CrossTab 
is viewed using the Web Access Server, drilldown icons will appear in the 
same way as those do for tables.

Creating Report Links to CrossTabs

As with drilldowns, report links will work differently for CrossTabs than for 
tables. You can only use columns that are in the RowFields and the 
ColumnFields lists as link output statistics. Links originating from other 
report elements may not use data from fields in the CrossTab element like 
tables and graphs can. 

Creating Report Links

Reports can contain links to other reports, applications, and Uniform 
Resource Locators (URL). A report link takes specific information from an 
element (graph, table, image, or label) in a report (the source report), and uses 
the information as the input to a report parameter (in the case of a report to 
report link) or to an argument (in the case of a report to application or URL 
link). 

When you trigger the link in the source report, the destination of the link 
(report, application, or URL) is displayed with the specified information from 
the source report.

If a report you are viewing with Report Builder contains a link, the cursor will 
change from an arrow to a hand when it is placed over the link. Additionally, 
depending on the type of element used for the link, the following occurs: 

Report links are created in reports using the Management Console’s Catalog 
Manager application. To use Catalog Manager, you must have an account 
with Administrator privileges. Refer to the HP OpenView Performance Insight 
Administration Guide for more information about using Catalog Manager to 
create links.
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• Elements that are the destination of a report link are surrounded by a 
blue border. 

• Text in a label or in a table column is underlined. 

This behavior is illustrated in the following example: 

If an element is linked to multiple items, the Select a Link dialog box will 
open. Select the link you want to open, and click OK.

Selecting Elements

You can select one element or multiple elements. After you select an element, 
handles outlining the element indicate that it has been selected. The following 
figure shows examples of selected elements:

Hand cursor
Blue border 

Hand cursor

Underlined 
text

Blue border 

Rectangle Tabbed Area Label
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Selecting an Element

To select an element, do any of the following:

• In the Report window, click the element. The element is highlighted in the 
Components tree.

• Select the element in the Components tree. Handles appear around the 
object in the Report window.

• Place the pointer above and to one side of the element, then press and hold 
the left mouse button and drag the pointer so a rectangle surrounds the 
element.

Selecting Multiple Objects

To select multiple elements, do any of the following:

• Hold down the SHIFT key and click each element you want to select. 

• Place the pointer above and to one side of the elements, then press and 
hold the left mouse button and drag the pointer so a rectangle surrounds 
the elements. 

Canceling Element Selection

To cancel the selection of an element, move the pointer away from the selected 
element’s outline, and click the left mouse button anywhere in the Report 
window. 

To cancel the selection of all elements, do either of the following:

• Place the pointer outside of the selected group of elements, and then click 
the left mouse button

• Press ESC.

To cancel the selection of one element within a group of selected elements, 
place the pointer over the selected element’s outline, hold down the SHIFT key, 
and then click the element.

You cannot select multiple elements in the Components tree.
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Positioning and Transferring Elements

You can move, resize, copy and paste, and cut and paste elements. 

Moving Elements

To move an element:

1 Place the pointer on the element you want to move, and then press and 
hold CTRL.

The moving pointer (an arrow-ended crosshair) appears.

2 Drag the element to the new location.

Micropositioning Elements

You can move elements precisely, 1 pixel at a time. This type of movement is 
called micropositioning. 

To microposition an element or a group of elements:

1 Select the element or the group of elements you want to microposition (see 
Selecting Elements on page 107).

2 Press CTRL+ARROW key. (Press the appropriate arrow key to move the 
element left, right, up, or down.) 

For example, if you press CTRL+RIGHT ARROW, the selected element or 
elements will move one pixel to the right.

Resizing Elements

You can resize an element by dragging its sizing handles.

To resize an element:

1 Select the element you want to resize. For more information about how to 
select an element, see Selecting Elements on page 107.

Report Builder pastes an element in the same location where it was copied or 
cut. When pasted at the same location as an existing element, the element or 
elements are offset down and to the right of the original element.
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2 Place the pointer over a resize handle of the element. 

The sizing handle (a double-ended arrow) appears.

3 Drag the sizing handle until the element is the size you want. 

Alternatively, you can also change the size and position of an element by 
changing the element’s properties in the Components tree. For more 
information, see Changing Element Properties on page 133.

Copying and Pasting

You can copy and paste elements within a report or between reports.

To copy and paste an element or a group of elements:

1 Select the element or group of elements you want to copy (see Selecting 
Elements on page 107).

2 Do one of the following:

• On the Report Builder toolbar, click .

• From the Edit menu, click Copy.

• CTRL+C

3 Click in the Report window to paste the element or elements.

4 Do one of the following:

• On the Report Builder toolbar, click .

• From the Edit menu, click Paste.

• CTRL+V

Cutting and Pasting

You can cut and paste elements within a report or between reports.

To cut and paste an element or a group of elements:

1 Select the element or the elements you want to cut (see Selecting 
Elements on page 107).
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2 Cut the element or group of elements by doing one of the following:

• On the Report Builder toolbar, click .

• From the Edit menu, click Cut.

• CTRL+X

3 Click in the Report window to paste the element or elements.

4 Do one of the following:

• On the Report Builder toolbar, click .

• From the Edit menu, click Paste.

• CTRL+V

Deleting Elements

You can delete element in the Report window or in the Components tree. (To 
delete a tab or a tabbed area, see Deleting a Tabbed Area on page 92 and 
Modifying Tabs on page 93.)

To delete an element:

1 Select the element in the Report window (see Selecting Elements on 
page 107) or in the Components tree.

2 Do one of the following:

• On the Report Builder toolbar, click .

• From the Edit menu, click Delete. 

• Right-click the element in the Report window or in the Components 
tree, and choose Delete Element from the shortcut menu, where 
Element is the kind of element you selected. 

• Report window only: Press DELETE. 
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Aligning Elements

You can rearrange elements in the Report window by aligning them relative to 
each other.

To align one or more elements:

1 Select the elements you want to align (see Selecting Elements on 
page 107). 

2 Select an alignment option. 

The elements are aligned with the element that is the closest to the 
alignment location. For example, if you want to align the tops of two 
elements, the element that is furthest from the top is aligned 
according to the placement of the element that is nearest to the top 
of the Report window.

To align... Toolbar Button Edit Menu Option

Left edges Align Left

Right edges Align Right

Top edges Align Top

Bottom edges Align Bottom

Element centers 
vertically

Align Vertical

Element centers 
horizontally

Align Horizontal
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Changing Element Names

After you create an element in your report, the element will appear in the 
Report window, and the element will appear in the Components tree of your 
report. For example, after you create an image, the text “Image” appears in 
the Components tree. You can change the element’s name. For example, you 
can rename “Image” to “Company Logo”. 

To change an element’s name:

1 Select the element.

Its properties are displayed in the Properties list of the Components 
window.

2 Click the Value box next to the Name property in the Properties list. 

3 Enter a name for the element. 

If you supply a name already used by another element, the following 
message appears.

4 Move the pointer to the Report window to apply the name change.

Refreshing Elements

To refresh the selected element or elements in the current Report window, do 
one of the following:

• On the Report Builder toolbar, click .

• From the Edit menu, click Refresh.

In a report, each element’s item name must be unique.
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To refresh all the elements in the current Report window, do one of the 
following:

• On the Report Builder toolbar, click .

• From the Edit menu, click Refresh All. 

Displaying Online Help

To display online Help, select Help Topics from the Help menu.

If you have not specified a Web browser in which the online Help will display, 
the Options dialog box opens, displaying only the Browser tab. 

For more information about how to specify a Web browser, see Specifying a 
Web Browser for Online Help on page 122. If you click Cancel in the Options 
dialog box, a message appears reminding you that you must specify a Web 
browser and how to do so. 

For more information about Help Topics, see the section on “Displaying Online 
Documentation” in the HP OpenView Performance Insight Administration 
Guide.

Setting Report Builder Preferences

By default, Report Builder has a standard set of properties that it uses when 
you create a report. You can set these properties using the Preferences dialog 
box. 
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To set preferences, choose Preferences from the Edit menu. The Preferences 
dialog box appears. 
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Alternatively, you can change these properties in report’s Properties list on a 
report-by-report basis. The following example shows the properties displayed 
on the General tab of the Preferences dialog box as they appear in a graph’s 
Properties list:

Types of Report Preferences

There is a default set of preferences for following report areas: General, Title 
Area, Graph, Legend, Statistics, Table Headers, Table Cells, and Table Data 
Properties.

In addition to setting the values of these options as preferences, you can also 
change their values at any time in the report’s Properties list. See Appendix A, 
Element Properties for details.

Foreground

Allowable Drilldowns

Background
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General

Following are the options available for graph and table elements when you 
select the General tab in the Preferences dialog box: 

• Foreground (See page 334.) 

• Background (See page 324.)

• Allowable Drilldowns (See page 322.) 

Title Area

Following are the options available for graph and table elements when you 
select the Title Area tab in the Preferences dialog box: 

• Border Style (See page 325.)

• Background (See page 324.)

• Foreground (See page 334.)

• Font Name (See page 333.)

• Font Size (See page 333.)

• Bold (See page 325.)

• Italic (See page 339.)

Graph

Following are the options available for graph data when you select the Graph 
tab in the Preferences dialog box:

• Graph by (See page 335.)

• Rotation (See page 352.)

• Elevation (See page 331.)

• Depth (See page 329.)

• Foreground (See page 334.)

• Background (See page 324.)

• Border Style (See page 325.)

• Border Thickness (See page 325.)
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• Font Name (See page 333.)

• Font Size (See page 333.)

• Bold (See page 325.)

• Italic (See page 339.)

Legend

Following are the options available for graph legends when you select the 
Legend tab in the Preferences dialog box:

• Format (See page 334.)

• Orientation (See Legend Orientation on page 343.)

• Foreground (See page 334.)

• Background (See page 324.)

• Border Style (See page 325.)

• Border Thickness (See page 325.)

• Font Name (See page 333.)

• Font Size (See page 333.)

• Bold (See page 325.)

• Italic (See page 339.)

Statistics

Following is the option available for table and graph elements when you select 
the Statistics tab in the Preferences dialog box: Font. 

You can choose a default font for the text in your tables and graphs, including 
a typeface (such as Times New Roman) and type size (such as 10 point). You 
can also select bold (B) or italic (I) as the type style.

Table Headers

Following are the options available for graph and table elements when you 
select the Table Headers tab in the Preferences dialog box:

• Foreground (See page 334.)
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• Background (See page 324.)

• Border Style (See page 325.)

• Border Thickness (See page 325.)

• Font Name (See page 333.)

• Font Size (See page 333.)

• Bold (See page 325.)

• Italic (See page 339.)

Table Cells

Following are the options available for table cell values when you select the 
Table Cells tab in the Preferences dialog box:

• Foreground (See page 334.)

• Background (See page 324.)

• Border Style (See page 325.)

• Border Thickness (See page 325.)

• Border Sides Left (See Show Cell Left Border on page 355.)

• Border Sides Right (See Show Cell Right Border on page 355.)

• Border Sides Top (See Show Cell Top Border on page 356.)

• Border Sides Bottom (See Show Cell Bottom Border on page 355.)

• Margin Width (See page 346.)

• Margin Height (See page 346.)

• Border Thickness (See page 325.)

• Show Column Labels (See page 356.)

• Allow Column Resize (See page 322.)

• Multiline Column Labels (See page 348.)

• Show Row Labels (See page 356.)

• Track Cursor
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Table Data Properties

Following is the option that is available for fixed table columns when you 
select the Table Data Properties tab in the Preferences dialog box: Number of 
Fixed Columns. See page 349.

A fixed column is one that does not scroll horizontally. Specifically, the 
Number of Fixed Columns option specifies that the n leftmost columns of a 
table should not scroll horizontally. For example, suppose the leftmost column 
of a table contained a device name. You would set the Number of Fixed 
Columns option to 1 to be able to view the device name. 

Setting Preferences for a Report

To set your report preferences:

1 From the Edit menu, click Preferences. The Preferences dialog box opens.

2 Select the tab for the type of preference you want to change. For more 
information about the preference types, see Types of Report Preferences 
on page 116.

3 Change any settings necessary.

4 Click OK.

Specifying Options

Using the Options dialog box (Figure 25 on page 121), you can do the 
following:

• Change the Web Access Server’s host name, port number or both (Server 
tab).

• Specify a Web browser in which the online Help will display (Browser tab).

• Enable or disable logging, specify a destination directory for the log file, 
and enable or disable debug tracing (Logging tab).

• Override the Cell Background color defined by a rule and use the color 
specified by the table’s Selected Cell Background property instead and set 
the look and feel of the application (Display tab).
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• Set the look and feel for the graphical user interface.

• Use all or minimal features of the wizards for graphs, tables, and combo 
boxes (Wizards tab). 

• Specify character encoding.

Figure 25 shows the Options dialog box for Report Builder. 

Figure 25 Options Dialog Box

Changing Web Access Server Information

When you installed OVPI, you supplied information about the Web Access 
Server. The Web Access Server controls Report Builder’s access to the 
database. Using the Options dialog box, you can change the Web Access 
Server’s host name, port number or both after your initial installation of 
OVPI.

To change Web Access Server information:

1 From the Edit menu, click Options. The Options dialog box opens, as 
shown in Figure 25 on page 121.

The Options dialog box for Report Viewer contains only the Server, Logging, 
and Browser tabs.
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2 Click the Server tab.

3 Do one or both of the following:

• In the Host box, enter the name of the Web Access Server.

• In the Port box, enter the port number of the Web Access Server.

4 Click the Reset to System Defaults button to reset the values for the Host 
and Port boxes to their original default values.

5 Click OK. 

Specifying a Web Browser for Online Help

Before you can display the online Help documentation, you must specify a 
Web browser in which the documentation will display. For a list of supported 
Web browsers, see Prerequisites on page 16.

To specify a Web browser:

1 From the Edit menu, click Options. The Options dialog box opens, as 
shown in Figure 25 on page 121.

2 Click the Browser tab, and do one of the following:

• Enter the Web browser’s full path and application file name in the 
Browser Application box. 

• Click the ellipsis button. The Open dialog box opens. Locate the Web 
browser’s application file name and double-click it. 

For example, the full path and application file name for Microsoft Internet 
Explorer might be as follows:

C:\Program Files\Plus!\Microsoft Internet\IEXPLORE.EXE 

3 Click OK.

You must close and reopen Report Builder to have the Web Access 
Server changes take effect.
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Specifying Log File and Debug Settings

Logging information is generic and not always useful when trying to identify 
problems. Debugging information is usually more helpful when trying to find 
out where an error has occurred.

Using the Options dialog box, you can enable or disable logging, specify a file 
name, path, or both for the application’s log file, and enable or disable debug 
tracing. 

The application’s defaults are as follows:

• Logging is enabled.

• The application’s log files are located in installation_directory/log and 
called viewer.log (Report Viewer) and builder.log (Report Builder), 
respectively. In this instance, installation_directory is the directory into 
which you installed OVPI.

• Debug tracing is disabled. 

To specify logging and debugging settings:

1 From the Edit menu, click Options. The Options dialog box opens, as 
shown in Figure 25 on page 121.

2 Click the Logging tab.

3 To specify logging status, do one of the following:

• To enable logging, select Enable logging.

• To disable logging, click to clear the Enable logging check box.

4 To change the name or path of the application’s log file, do one of the 
following:

• Enter the new location, file name, or both in the Log File box.

• Click the ellipsis (...) button to display the Open dialog box, locate the 
log file, and then click Open. 

5 To specify debug tracing status, do one of the following:

• To enable debug tracing, select Enable debug tracing.

If the log file you specify does not exist, the application will create it 
for you in the directory you specified.
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• To disable debug tracing, click to clear the Enable debug tracing check 
box.

Note the following points:

• If logging and debug tracing are enabled, the debug tracing 
information is included in the application’s log file. 

• If logging is disabled and debug tracing is enabled, the debugging 
information is sent to a window only if the application was started 
from a shell window (UNIX). 

• If the application was not started from a window, you will not be able 
to see the debug tracing information unless you enable logging and 
view the application’s log file.

6 Do one of the following:

• Click Apply to apply each change.

• Click OK to apply all of your changes and close the Open dialog box. 

Overriding a Rule’s Cell Background Property 

When you select a row in a table, it is highlighted. If there is a rule applied to 
the statistic that specifies a specific color for the Cell Background property, 
the row is highlighted with that color. For example, suppose you created a rule 
for the Key ID statistic that applies a red background to any Key ID data that 
is less 3. If you select the row associated with the Key ID statistic, the row is 
highlighted with red.

If there is no rule associated with the statistic in the selected row, Report 
Builder uses the color associated with the table’s Selected Cell Background 
property; by default, this is yellow. To see this value, expand the table in the 
component’s tree and click Cell Properties. You can override the Cell 
Background color applied by a rule and use the table’s Selected Cell 
Background color instead for all table rows.

To override a rule’s Cell Background color:

1 From the Edit menu, click Options. The Options dialog box opens, as 
shown in Figure 25 on page 121.

2 Click the Display tab.

3 Click the Selection color will override colors defined by Rules.
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4 Click Apply.

Setting the Look and Feel

You can set the look and feel of the graphical user interface.

To set the look and feel:

1 From the Edit menu, click Options. The Options dialog box opens, as 
shown in Figure 25 on page 121.

2 Click the Display tab.

3 Select one of the following options from the Look and Feel list:

• Windows. Uses the Windows look and feel.

• Metal. Uses the default Java look and feel.

• Motif. Uses the Motif look and feel (UNIX only).

• System Default. Uses the look and feel of your current operating system 
(Windows or Motif).

4 Click OK.

Specifying Wizard Features

You can specify whether you want to use all or minimal features of the wizards 
for graphs, tables, and combo boxes. By default, Report Builder uses the full 
wizards. 

To change the features of the wizards:

1 From the Edit menu, click Options. The Options dialog box opens, as 
shown in Figure 25 on page 121.

2 Click the Wizards tab.

3 Click one of the following:

• Use full wizards—The full wizard walks you through all the steps 
needed to fully create an element.

• Use minimal wizards—The minimal wizard walks you through only the 
most basic steps needed to create an element. You must complete the 
remaining required steps later.
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4 In the Display Statistics by box, select how you want statistics to appear 
in any report that you create. For example, if you want statistics to display 
by their alias, click Alias.

5 Click OK.

Specifying Statistic Display

You can select how statistics will display in wizard windows. For example, 
suppose you decide to display statistics by their descriptions rather than by 
their alias names, which is the default. When you run the graph wizard, the 
Select Statistic window will list the available statistics by their descriptions.

To specify statistic display:

1 From the Edit menu, click Options. The Options dialog box opens, as 
shown in Figure 25 on page 121.

2 Click the Wizards tab.

3 Click one of the following:

• Alias. Displays statistics by their aliases. 

• Description. Displays statistics by their descriptions.

• Label. Displays statistics by their labels.

• Name. Displays statistics by their names.

4 Click OK.

Specifying Character Encoding

Character encoding is the method used to represent characters digitally by 
assigning a unique code to each character in order to convert it to bytes. When 
you import or export non-ASCII data using any file other than XML, OVPI 
lets you specify character encoding. 

If a statistic does not have a description, its alias is displayed 
instead.
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Character encoding may be necessary when you save a file as CSV or import a 
group definition. For example, Japanese typically uses UCS or SJIS character 
encoding. By default, OVPI uses the default encoding for the operating system 
you are using. 

To specify character encoding:

1 From the Edit menu, click Options. The Options dialog box opens, as 
shown in Figure 25 on page 121.

2 Click the Encoding tab.

3 Select the encoding you want to use from the File encoding box.

4 Click OK.

Saving Reports

After you create a report, you can save it to one of the following formats: 

• Dataset (.srep)

• Report Definition (.rep)

To save a report:

1 Do one of the following:

• To save a report with its current file name, choose Save from the File 

menu or click  on the General toolbar. 

• To save all reports with their current file names, choose Save All from 

the File menu or click  on the General toolbar.

• To save a report with a different file name or format, choose Save As 
from the File menu. 
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If you chose Save As from the File menu, or if you have never saved the 
report, the Save dialog box opens. 

2 Do one or both of the following:

• Enter the file name in the File Name box.

• Click the Files of Type arrow, and select a format.

3 Click Save.

Exporting Reports

You can export a report to the following formats: CSV (comma separated 
value) and PDF (Portable Document Format).

To export a report:

1 From the File menu, click Export As.

The Export dialog box opens.

2 Navigate to the folder in which you want to save the report.

3 Click the Files of type arrow, and select a format (PDF, CSV, or Zipped 
CSV).

Choosing the zipped CSV format produces a zip file that contains a.csv 
file for each element in the report.

If you want to use TrueType fonts in a PDF file, see Appendix B, 
Using TrueType Fonts in PDF Files for more information about 
how to configure OVPI for TrueType fonts.
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4 Type a file name in the File name box.

5 Click Save.

Printing Reports

To print a report:

1 Do one of the following:

• Click . 

• From the File menu, click Print. 

The Print dialog box opens.

The dialog box contains the following tabs:

• General. This tab lets you specify a printer, whether you want to print 
to a file, a print range, and the number of copies to print.

• Page Setup. This tab lets you specify the paper size, the printer tray 
for the paper, the paper orientation, and the paper margins.
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• Appearance. This tab lets you specify color appearance, color quality, 
how the image should appear on the printed page, and job attributes 
(a banner page, printing priority, a job name, and a username).

2 Make any changes necessary, and click OK.

Closing Reports

To close a report, do one of the following:

• From the File menu, click Close to close the current Report window.

• From the File menu, click Close All to close all open Report windows

If you have not saved the report, the following dialog box opens:

To save a report before you close it, click Yes. The Save dialog box opens. For 
more information about saving a report, see Saving Reports on page 127.

Exporting Elements or Data to CSV Format

You can export an element (graph or table) or graph overlay data to comma 
separated value (CSV) format.

To export to CSV format:

1 Right-click the element.

2 Do one of the following:

• Choose Export Element as CSV if you want to export a graph or a table.

• Choose Export Graph Overlay Data as CSV if you want to export graph 
overlay data.

The Open dialog box opens.
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3 Navigate to the folder in which you want to save the CSV file.

4 Specify a file name in the File name box, and then click Open.

Printing Graphs and Tables

To print a graph or a table:

1 Right-click the graph or the table.

2 Choose Print Graph or Print Table from the shortcut menu.

The Print dialog box opens.

3 Make any changes necessary, and click OK.
Creating Reports 131



132 Chapter 3



4 Modifying Reports
This chapter describes how to modify the features of a report. Specifically, it 
describes how to do the following:

• Change element properties.

• Modify graphs and tables.

• Create reports with deferred selections.

Changing Element Properties

There are a few ways to change the properties of an element in a report. 
Depending on where you choose to change an element’s properties (the Report 
window or the Components window) affects the ways in which you can change 
the element. 

Using the Report Window

To change an element’s properties:

• Right-click the element you want to change. A shortcut menu displays. 
Depending on the type of element, the commands on the shortcut menu 
will differ. 

If you change the properties of any element frequently, you should consider 
changing the defaults that Report Builder uses when it creates that element. 
For more information about setting report building preferences, see Setting 
Report Builder Preferences on page 114.
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The shortcut menu for graphs displays as follows:

For more specific instructions about how to modify graphs and tables 
using the shortcut menu, see Modifying Graphs on page 136 and 
Modifying Tables on page 158, respectively.

Using the Components Window

To change an element’s properties using the Components window:

1 In the report’s Components tree, expand Elements. A list of the report’s 
elements are displayed. 

When you click on an element, its properties appear in the associated 
Properties list. 

2 Click the Value box next to the property you want to modify.

You can expect to change a property using one of the following:

• Text box
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• Drop-down combo box

• Select a Color dialog box

• Property Name window

This window opens when carriage returns are allowed in text. 
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3 Do one of the following:

• To change a value using a text box or a drop-down combo box, do one of 
the following:

— Type a value in the text box.

— Select the value from the drop-down combo box.

The value is updated when you move the pointer to the Report 
window.

• To change a value using the Select a Color dialog box, select a color, 
and click OK. 

• To change text using the Property Name window, type the text you 
want, and click OK.

Modifying Graphs

Report Builder supplies defaults for several of a graph’s properties when the 
graph is created. (For more information about these defaults, see Setting 
Report Builder Preferences on page 114.) 

This section describes how to change some of the most common features. 
Specifically, it describes how to do the following:

• Add an overlay.

• Display a grid.

• Reposition a legend.

• Modify legend text.

• Change a graph’s style.

• Change the maximum number of rows of data that is returned from the 
database.

• Display a data table or an overlay data table.

• Modify a graph’s title.

• Change the rotation and depth of bar and stacked bar graphs.

• Zoom in on a region of a graph.
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• Define axis properties.

• Change y-axis labels and weighted values (GOS graphs only).

• Select how to display missing data in a graph.

You can also do the following:

• Change nodes, interfaces, or both (see Selecting Nodes and Interfaces on 
page 190).

• Change the time period (see Selecting a Time Period on page 194).

• Modify constraint values (see Modifying Constraint Values on page 199).

Adding Overlays

After you create a graph, you can specify whether it will contain an overlay. 
An overlay is a set of data that is superimposed over another set of data. A 
sample overlay is shown in Figure 26. The first set of data is referred to as the 
main data. The second set of data is referred to as the overlay data. 

Figure 26 shows an overlay report where the plot (which represents Percent 
Memory Used) overlays a bar, which represents CPU Utilization. 

Figure 26 Graph Overlay Example

Main data

Overlay data
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The main data and overlay data can share the same y-axis or can use a 
different y-axis. If the main graph and the overlay graph share the y-axis, 
they must display the same type of data, for example, utilizations. Figure 27 
shows an example of a shared y-axis.

Figure 27 Graph Overlay Example – Shared Y-Axis

When you create a graph, you can also specify that it have one of the following 
types of overlays:

• Basic – A basic overlay graph displays data for multiple statistics on the 
same graph for the same time period. 

For example, the difference between an overlay graph and any graph 
displaying multiple statistics, is that with an overlay report one statistic 
may appear as one type of graph (for example, a bar graph) and the other 
statistic may appear as a different graph type (for example, a line graph). 

• Baseline – A baseline overlay graph is similar in appearance to an overlay 
graph. For a baseline graph, data is collected over a period of time (the 
default is 42 days) and then used as a baseline or average to compare 
against data for a specific time period. A baseline can be thought of as an 
average or expected value. Therefore, when baseline data is superimposed 
over raw data, the raw data can be determined to be normal or abnormal 
based on its relationship to the baseline.

For example, data for Cisco router performance can be collected for 42 
days and then averaged so that you have data about typical router 
performance for each day of the week. That baseline data can then be 

Main data

Shared y-axis

Overlay data
138 Chapter 4



displayed on the same report as data for the current week. By viewing a 
baseline report, you can compare the current week’s router performance 
against an average week. 

Adding an Overlay to a Graph

To add an overlay to a graph:

Task 1: Choose the overlay option. 

1 Do one of the following:

• Right-click the graph in the Report window.

• Right-click a Graph level in the report’s Components tree.

2 Choose Add Overlay from the shortcut menu. 

The Create a Graph Overlay window opens.

A graph can only have one overlay. If you add an overlay to a graph that 
already has an overlay, the current overlay will be replaced by the new 
overlay.
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Task 2: Select the type of overlay.

Do one of the following depending on the type of overlay you want.

• If you want a basic overlay, do the following:

a Click Basic Overlay, which lets you overlay the data from one graph 
onto another.

b If necessary, select the Use Separate Y-Axis box if the data being 
displayed in the basic graph and the overlay graph have very different 
y-axis values. 

For example, the y values for the basic graph might range from 1 to 
1000 and the values for the overlay graph might only range from 1 to 
100. If you use the same y-axis, the overlay graph will appear almost 
flat. If you choose a second y-axis, then the basic graph axis appears 
on the left and the overlay axis appears on the right. The overlay 
graph in Figure 26 on page 137 has two y-axes, although they both 
have the same scale.

c Click Next. 

• If you want a baseline overlay, do the following:

a Click Baseline Overlay, which lets you overlay baseline data over data 
for a different time period.

b In the Baseline Type list, click the type of baseline which specifies the 
level of detail for the baseline data. Available options are Hour of Day, 
Hour of Day of Week, and Day of Week. 

c Click Next.
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The Select a data source for the Overlay window opens.

Task 3: Select a data table for the overlay.

1 Expand the folder that contains the data table you want for the overlay. 
The contents of the folder displays.

2 Click the data table you want.

3 Click Next. 

The Select Statistics window opens. See Figure 11 on page 70.

Task 4: Select statistics for the overlay.

1 To select a statistic, do one of the following: 

• Double-click a statistic in the Choose from box.

• Select a statistic in the Choose from box, and click .

2 If needed, to remove a statistic, do one of the following:

• Double-click a statistic in the Selected statistics box.

• Select a statistic in the Selected statistics box, and click .
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3 Click Next. 

The Summary window opens.

4 Click Finish.

Changing Overlay Properties Using the Components Window

After you create an overlay graph, you can specify the time period is uses and 
whether or not it should use a new y-axis. 

To change overlay properties:

1 In the report’s Components tree, expand Elements and then expand the 
graph that contains the overlay. 

2 Click Overlay Properties.

3 In the Properties list, click in the Value box next to any of the following 
properties to modify their values:

• Use main time period in overlay. Lets you specify if the overlay graph 
will use the main graph’s time period.

• Use new Y axis in overlay. Lets you specify if the overlay graph will 
use a new y-axis.
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• Use source time period in overlay. Lets you specify if the overlay graph 
(the destination object) will use the source object’s time period. For 
more information about source and destination objects, see Chapter 5, 
Linking Report Elements.

4 Select an option from the list (True or False).

The value is updated when you click in another Value box or move the 
pointer to the Report window.

Deleting an Overlay

To delete an overlay:

1 Right-click the graph.

2 Choose Remove Overlay from the shortcut menu.

Displaying Grid Lines

You can specify grid lines for a graph’s x-axis, y-axis, or both. You can display 
grid lines using the shortcut menu or a report’s Components tree.

Using the Shortcut Menu

To display grid lines for a graph using the shortcut menu:

1 Right-click a graph in the Report window.

2 On the shortcut menu, point to Grid, and select the axis on which you want 
the grid lines to display. 

The Change Grids dialog box opens.

3 Enter the number of grid lines you want on the axis in the Grids box, and 
then click OK.

Using the Components Tree

To display grid lines for a graph using the Components tree:

1 In the report’s Components tree, expand Elements  Graph Name  
Properties, and then click X Axis or Y Axis.
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2 Click the Value box next to Grids, and type the number of grid lines you 
want to appear on the axis.

3 Move the pointer to the Report window to apply the change.

Repositioning Legends

You can control where a graph’s legend is positioned or not display it. Table 10 
lists the legend position options.

You can change a legend’s position using the shortcut menu or a report’s 
Components tree.

Table 10 Legend Position Options

Option Displays...

None No legend

North At the top of the graph

South At the bottom of the graph

East To the right of the graph

West To the left of the graph

NorthEast To the top and to the right of the graph

NorthWest To the top and to the left of the graph

SouthEast To the bottom and to the right of the graph

SouthWest To the bottom and to the left of the graph
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Using the Shortcut Menu

To change a legend’s position using the shortcut menu:

1 Right-click a graph in the Report window.

2 On the shortcut menu, point to Legend, and then select a legend position 
(see Table 10 on page 144).

Using the Components Tree

To change a legend’s position using a report’s Components tree:

1 In the report’s Components tree, expand Elements  Graph Name, and 
then click Legend Area.

2 In the Properties list, click the Value box next to Anchor, and select an 
option from the list (see Table 10 on page 144).

3 Move the pointer to the Report window to apply the change.

Modifying Legend Text

To modify a legend’s text:

1 In the report’s Components tree, expand Elements  Graph Name, and 
then click Legend Area.

2 In the Properties list, click the Value box next to Format.

3 Type text, one or more variables from Table 11, or both.
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Using Variables in Graph Legends

You can use variables in graph legends. A variable is set to display a certain 
type of information. You can combine a variable with other variables and text 
in any legend. Table 11 lists the variables that are supported. 

Table 11 Report Builder Legend Variables

Variable Output

$C$ Displays the content specified in one of the 
following:
• dsi_descr if dsi_descr is not NULL 
• dsi_key_table if dsi_descr is NULL

$L$ Displays a statistic’s label

$M$ Displays the content specified in one of the 
following:
• dsi_target_name
• dsi_target_name followed by dsi_table_key, if 

the graph contains multiple nodes

$N$ Displays the content specified in one of the 
following:
• dsi_target_name followed by the content of 

dsi_descr if dsi_descri is not NULL
• dsi_target_name followed by the content of 

dsi_table_key if dsi_descr is NULL
• dsi_target_name, dsi_table_key, dsi_descr, if 

the graph contains multiple nodes

!{X} This is a substitution variable where X 
represents the alias of one of the selected 
statistics in the graph. For example, to display 
the value of the Description statistic, you would 
use the following: 

!{Description}
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When $C$, $M$, and $N$ are used in the legend of a graph that is the 
destination of a link, they will display the information for the data being 
displayed in that graph.

Changing Graph Style

Report Builder supports the following graph types: plot, scatter plot, hi-lo, 
hi-lo-open-close, candle, area, bar, stacking bar, pie, and stacking area.

You can change the style of a graph using the shortcut menu or a report’s 
Components tree. 

Using the Shortcut Menu

To change a graph’s style using the shortcut menu:

1 Right-click a graph in the Report window.

2 On the shortcut menu, point to Style, and select the style you want.

Using the Components Tree

To change a graph’s style using the Components tree:

1 In the report’s Components tree, expand Elements  Graph Name, and 
then click Properties.

2 In the Properties list, click the Value box next to Graph Style, and select a 
style from the list.

3 Move the pointer to the Report window to apply the change.

Changing the Maximum Number of Rows Returned

The database can contain thousands of data entries, which span gigabytes of 
disk space. Thus, you can constrain the amount of data that is returned and 
subsequently displayed. The default number of rows returned is 50. 

The data returned depends on the nature of the query. For example, if you 
specify in the query to sort the data by time in descending order, OVPI 
displays the most recent 50 rows of data.
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Depending on the type of report you are viewing and how its data is 
distributed, 50 rows may not be enough data. You can change the number of 
rows displayed using the shortcut menu or a report’s Components tree.

Using the Shortcut Menu

To change the number of rows using the shortcut menu:

1 Right-click a graph in the Report window.

2 Choose Change Max Rows from the shortcut menu. The Change Maximum 
Number of Rows dialog box opens.

3 In the Max Rows box, enter the number of rows you want, and then click 
OK.

Using the Components Tree

To change the maximum number of rows using the Components tree:

1 In the report’s Components tree, expand Elements  Graph Name  
Data, and then click Query.

2 In the Properties list, click the Value box next to Maximum Rows. 

3 Enter the number of rows. 

4 Move the pointer to the Report window to apply the change.

Displaying Data Tables

You can display the data represented by each point on a graph or on an 
overlay graph by displaying the graph’s data table.

To display a data table:

1 Right-click a graph.

2 Do one of the following:
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• Choose Display Data Table from the shortcut menu.

• Select Display Overlay Data Table from the shortcut menu. 

The data table will appear in a separate window similar to the following:

3 To close the window, click  in the upper-right corner of the window. 

Modifying Graph Titles

When you create a graph using the Graph wizard, you can enter up to three 
titles for the graph. 

To modify a title:

1 In the report’s Components tree, expand Elements  Graph Name  Title 
Area, and then click Titlen.

2 In the Properties list, click the Value box next to Title Text, and type text, 
one or more variables from Table 11 on page 146, or both.

3 Move the pointer to the Report window to apply the change.

4 Repeat the steps to change another title. 
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Using Variables in Titles and Legends

You can use variables in graph titles and legends. A variable is set to display a 
certain type of information. You can combine a variable with other variables 
and text in any title. Table 12 lists the variables that are supported. 

You should only use the $C$, $M$, and $N$ variables in the title of a graph 
that is the destination of a link. For a linked graph, they will display the 
appropriate data for the row selected in the source table. For an unlinked 
graph, they will display no data.
Table 12 Report Builder Title and Legend Variables

Variable Displays...

$C$ Displays the content specified in one of the 
following:
• dsi_descr if dsi_descr is not NULL 
• dsi_key_table if dsi_descr is NULL

$D$ The time range selected in the Set Time Period 
dialog box.

$E$ The end time of the time range selected in the 
Set Time Period dialog box.

$M$ Displays the content specified in one of the 
following:
• dsi_target_name
• dsi_target_name followed by dsi_table_key, if 

the graph contains multiple nodes

$N$ Displays the content specified in one of the 
following:
• dsi_target_name followed by the content of 

dsi_descr if dsi_descri is not NULL
• dsi_target_name followed by the content of 

dsi_table_key if dsi_descr is NULL
• dsi_target_name, dsi_table_key, dsi_descr, if 

the graph contains multiple nodes
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Changing Rotation, Elevation and Depth

Report Viewer displays graphs in three dimensions. You can change the depth, 
rotation, and elevation of a bar or stacked bar graph to give it a 
three-dimensional appearance. Values are evaluated in terms of degrees. A 
value of zero for any of these properties will result in a two-dimensional 
object.

Thus, you can increase:

• The elevation, which creates the effect of looking down on the graph

• The depth, which makes the graph’s x-axis wider 

• The rotation, which creates the effect as if you moved to the right of the 
graph

$S$ The start time of the time range selected in the 
Set Time Period dialog box

$T$ The range of dates with available data in the 
database (which may differ from the time range 
specified depending on the availability of data)

#{X} This is a substitution variable is only used when 
two elements are linked. The value of X is the 
alias of a selected statistic from a selected row in 
the source element. If there are multiple source 
elements, the first source is used. 

For example, to take the value of Target Name 
from a selected row in a source table and have 
that value display in the title of a target graph or 
table, you would use the following:

#{Target Name}

Table 12 Report Builder Title and Legend Variables (cont’d)

Variable Displays...
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The following figure shows a graph before and after its rotation and depth has 
been changed:

Using the Pointer

To change the rotation, elevation, or depth of a graph using the mouse:

1 Place the pointer over the graph.

2 Hold the SHIFT key and the left mouse button and drag the mouse in any 
direction until you reach the desired effect. 

Using the Components Tree

To change the rotation, elevation, or depth of a graph using the Components 
tree:

1 In the report’s Components tree, expand Elements  Graph Name, and 
then click Chart Area.

2 In the Properties list, do the following:

• Click the Value box next to Rotation, and type a number of degrees.

• Click the Value box next to Elevation, and type a number of degrees.

• Click the Value box next to Depth, and type a number of degrees. 

Before After
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3 Move the pointer to the Report window to apply the changes.

To return a graph to its original appearance:

1 Press and hold CTRL-SHIFT.

2 Double-click on the graph.

Zooming In

You can zoom in to focus on details in a graph. The following figure shows a 
graph before zooming in and after a selected area has been zoomed in on:

To zoom in on a graph:

1 Place the pointer over the graph. 

2 Press and hold CTRL+SHIFT, and then drag the pointer over the portion of 
the graph you want to zoom in on.

The graph will adjust to show the portion of the graph you selected.

To return a graph to its original appearance:

1 Press and hold CTRL-SHIFT.

2 Double-click on the graph.

Before After
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Displaying Data Detail

When you view a graph, you may want to display information about a 
particular point on the graph. The following figure shows how data detail 
displays for a graph:

To display data detail for a point on a graph:

1 Place the pointer over a data point.

2 Press and hold the left mouse button. 

The information appears, showing the date and time at which the data 
was collected and the value of the data at that time.

Displaying Selected Statistics

You can specify which statistics you want to appear in a graph when you view 
it.

To select statistics:

1 Right-click the graph.

2 Choose Displayed Data from the shortcut menu. A submenu lists the 
currently displayed statistics.

3 Select a statistic. you do not want to display, which should remove the 
check mark next to the statistic.

If you want to add your own custom statistics for use in graphs and tables, see 
Creating Custom Statistics on page 187.
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Changing GOS Y-Axis Labels 

To change the y-axis labels for a GOS graph:

1 In the report’s Components tree, expand Elements  Graph Name  
Properties.

2 Right-click Y Axis, and choose Add Y Axis Labels from the shortcut menu. 
The Specify GOS Y-Axis Labels dialog box opens.

3 To change an axis label, click the Axis Label box, and enter a new label. 

4 To change the value of an axis label, click the axis label’s Value box, and 
enter a new value.

5 To reorder the labels, select the label you want to reorder, and do one of 
the following:

— Click  to move the label up in the list.

— Click  to move the label down in the list.

6 To delete a label, select the label, and click .

7 To add a label, do the following:

a Click . A blank box appears below the last statistic in the list.

b Click the box, and type the label in the Axis Label box.

c Type its value in the Value box.

8 Click OK. 
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Changing GOS Weighted Values

To change the weighted values for a GOS graph:

1 In the report’s Components tree, expand Elements  Graph Name  Data 
 Query.

2 Right-click Selected Statistics, and choose Set GOS Weights from the 
shortcut menu. The Set GOS Weights dialog box opens.

3 Click in a box, and enter a new value.

4 Click OK. 

Displaying Missing Graph Data

Occasionally, there is no data available for a graph; for example, this can 
happen when polling cycles are missed or network errors occur. You can select 
a visual cue to represent missing data in a graph by setting the graph’s Hole 
properties.

To specify a visual cue for missing data: 

1 In the report’s Components tree, expand Elements  Graph Name.

2 Click Properties. You will see the following properties pertaining to holes in 
graph data:

• Hole Style. Lets you select how missing data is represented.

• Hole Mark. Lets select a visual cue for missing data in a graph.

• Hole Mark Color. Lets you select the color of the Hole Mark.

You cannot change the values in the Statistic and Critical boxes.
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• Hole Mark Shape. Lets you select the shape of a symbol when symbol 
is selected as the Hole Mark.

• Hole Mark Size. Lets you select the size of a symbol when symbol is 
selected as the Hole Mark.

• Hole Mark in Legend. Lets you select whether the missing data is 
shown in the graph’s legend.

• Hole Mark Label. Lets you select the text that will represent the 
missing data in the legend.

3 Click the Value box for Hole Style, and select one of the following values: 

• Not Plotted. The graph plots a line, which will contain a hole (white 
space) where the missing data is located. 

• Interpolation. The graph plots a line from the last known data point to 
the next known data point, interpreting what it thinks the missing 
data points might be.

• Last Value. The graph plots a straight line from the last known data 
point until it detects a known data point on the y-axis.

• Zero. The graph plots a line from the last known data point down to 
the x-axis until it detects a known data point on the y-axis.

4 Click the Value box for Hole Mark, and select one of the following values:

• None. The graph plots a line, which will contain a hole (white space) 
where the missing data is located.

• Bar. A bar will appear in the area of the graph containing the missing 
data.

• Symbol. A symbol will appear on the x-axis to indicate missing data. 

5 If you chose a bar or symbol for the visual cue, click the Value box for Hole 
Mark Color, and select a color for the cue.

6 If you chose a symbol for the visual cue, do the following:

a Click the Value box for Hole Mark Shape, and select the shape of the 
symbol.

b Click the Value box for Hole Mark Size, and type the size in points for 
the symbol.

7 If you want the missing data to be noted in the graph’s legend, do the 
following:
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a Click the Value box for Hole Mark in Legend, and select True.

b Click the Value box for Hole Mark Legend, and type the text that you 
want to use in the legend (for example, “Missing Data”).

8 Move the pointer to the Report window to apply the changes.

Modifying Tables

Report Builder supplies defaults for several of a table’s properties when the 
table is created. You can change many table properties using Report Builder. 
(For more information about these defaults, see Setting Report Builder 
Preferences on page 114.)

This section describes how to change some of the most common features. 
Specifically, it describes how to:

• Modify a table’s title.

• Change the order in which table columns appear.

• Add row labels.

• View a table in a new frame.

• Change the date or time format of a selected statistic.

You can also do the following:

• Change the maximum number of rows of data that is returned from the 
database (see Changing the Maximum Number of Rows Returned on 
page 147).

• Change nodes, interfaces, or both (see Selecting Nodes and Interfaces on 
page 190).

• Change the time period (see Selecting a Time Period on page 194).

• Modify constraint values (see Modifying Constraint Values on page 199).
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Changing Titles

To change a table’s title:

1 In the report’s Components tree, expand Elements  Table Name  Title 
Area.

2 Click Title Line n.

3 In the Properties list, click the Value box next to Title Text. 

4 Change the text.

5 Move the pointer to the Report window to apply the change or click in 
another Value box.

Changing the Order of Columns

You can change the order in which columns appear in a table. 

To change the order of a table column: 

1 Place the pointer on the column heading you want to move. 

2 Drag the pointer over a column in either the left or right direction. 

As you move the pointer, the column that you drag the current column 
over moves (to the left or to the right, depending on the direction in which 
you are dragging the pointer) past the column you are dragging.

3 Release the left mouse button.

4 Repeat steps 1 through 3 to move the column again.

Resizing Table Columns

You can resize the columns of a table displayed in a report.

To resize a table column: 

1 Place the pointer before the column you want to resize and look for the 
double-ended arrow to appear. 

2 Drag the arrow in either the left or right direction to expand the column.

You can only move one column at a time.
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3 Release the left mouse button when you reach the desired size.

4 Repeat steps 1 through 3 to resize a column again.

Adding Row Labels

You can add row labels to a table. The following figure shows how row labels 
appear when added to a table:

To add row labels to a table:

1 In the report’s Components tree, expand the following: Elements  Table 
Name.

2 Click Row Properties.

3 In the Properties list, click the Value box next to Show Row Labels, and 
select True.

Viewing a Table in a New Frame

You can choose to view a table from a report in a window separate from the 
report’s window.

To view a table in a new frame:

1 Right-click the table.

2 Select View in new Frame from the menu.

The table is displayed in its own window.

Row labels
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Changing the Date or Time Format of a Statistic 

To change the date or time format of a selected statistic:

1 In the report’s Components tree, expand the following: Elements  Table 
Element  Data  Query  Selected Statistics  Statistic Name. 

2 In the Properties list, click the Value box next to Text Date Format.

The Edit the Date Format combo box displays the current format. 

3 Click the drop-down arrow to display and select from the standard date 
and time formats, or type the desired format in the box.

Table 13 lists and describes each available component of the date and time 
format. 

Table 13 Date and Time Format Values

Value Description Format Example

a Specify AM or PM 
(use with h option)

Text (AM or PM) hh:mm aa can display 
02:21 AM

d Day in month Number (1-31) 5 or 05

D Day of year Number (1-366) 4 or 04

E Day of week Text Tuesday

G Era Text (AD or BC) AD

h Hour in AM/PM 
(use with a option)

Number (1-12) 8 or 08

H Hour in day Number (0-23) 0 or 00

k Hour in day Number (1-24) 19

K Hour in AM/PM 
(use with a option)

Number (0-11) 2 or 02

m Minute in hour Number (0-59) 6 or 06
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In most cases, the number of times you type a letter in the pattern determines 
how that piece of information is presented. Text information is displayed in an 
abbreviated form if the pattern letter is repeated less than four times. 
Otherwise, the unabbreviated form is used. For example, a zzzz pattern can 
display Pacific Daylight Time, and a z, zz, or zzz pattern can display PDT.

For numerals, the number of times a pattern letter is repeated determines 
how many digits are presented. For example, hh:mm:ss can present 01:51:15, 
but h:m:s displays the same time value as 1:51:15. Also, you can represent 
the year with two digits or four digits, as follows: yy can display 04, and yyyy 
can display 2004.

Finally, M or MM causes the month to be displayed as one or two digits (for 
example, 4 or 04). However, three or more repetitions of M cause the month to 
be displayed as a text string (for example, April).

Creating Reports with Deferred Selections

Sometimes you may want to create a report that has a deferred selection. 
When you view the report, you must supply additional information before 
Report Viewer or the Web Access Server will display the report. 

A report with a deferred selection asks you to specify one or both of the 
following for each element in the report that has a deferred selection:

M Month in year Text or Number July, 7, or 07

s Second in minute Number (0-59) 9 or 09

w Week in year Number (1-52) 3 or 03

W Week of month Number (1-5) 4 or 04

y Year Number 2004 or 04

z Time zone Text EDT or Eastern Daylight 
Time

Table 13 Date and Time Format Values (cont’d)

Value Description Format Example
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• Nodes and interfaces – A node can contain multiple interfaces. For 
example, a node may be a Cisco router which has an Ethernet interface 
and a Token Ring interface. You can select a node and all its interfaces or 
you can select only certain interfaces. For more information about 
selecting nodes, see Selecting Nodes and Interfaces on page 190.

• Time range – A time range is the time period for the report. You can select 
an absolute period (specific dates) or a relative time period (a period of 
time relative to the time you view the report).

For example, a router performance report is an example of a report that can 
require a user to enter the following information before she can view the 
report: 

• The router or routers to report on

• The time period to report on (if the time selection is deferred)

After you supply the information, the report is run based on that information. 
Additionally, you could view the report numerous times using different 
routers and time selections.

To create a report with a deferred selection:

1 In the report’s Components tree, do one of the following:

• Expand Elements  Element Name.

• Expand Tabbed Area  Tabs  Tab Name  Element Name.

2 Expand Data  Query. 

3 Do one or both of the following:

• To defer the time period selection, do the following:

— Click Time Period. Its properties appear in the Properties list.

— Click the Value box for the Deferred property, and choose True from 
the drop-down list.

• To defer the node and interface selection:

— Click Query in the Components tree. Its properties appear in the 
Properties list.

— Click the Value box for the Deferred Node property, and choose 
True from the drop-down list.
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When you open the report, a dialog box appears asking you to supply nodes 
and interfaces, a time period, or both. For more information about opening a 
report with a deferred selection, see Opening a Report with a Deferred 
Selection on page 272 (Report Viewer) and Deferred Selections on page 297 
(Web Access Server).
164 Chapter 4



5 Linking Report Elements
After you create the elements for a report, you will probably want to link 
them. You create links between elements in order to display more detailed 
information about a selected item. For example, you might link a table to 
multiple graphs or link multiple combination boxes to a single table. This 
detailed information is referred to as a drilldown.

For example, you may want to create a link between a table and several 
graphs; the table would display summary statistics while the graphs would 
display other details about a selected item in the table. Figure 28 on page 167 
shows a table linked to multiple graphs. As you select rows in the table, the 
graphs update with detailed data for the selected element in the table. (In this 
example, the table is the source object, and the graphs are the destination 
objects.) 

You can link elements in any of the following manners:

• One source object linked to one destination object

• One source object linked to multiple destination objects

• Multiple source objects linked to one destination object

A source object displays summary statistics. A source object can be any table 
or graph that shows data by node. This kind of graph displays nodes and 
interfaces along its x-axis. The link has no effect on the data displayed in the 
source table. 

A destination object displays the detailed information about an item from the 
source object. A destination object can be a table, a graph of any type, or a 
tabbed area (an element that contains multiple tables and graphs). The 
information in the destination object is dynamic; it changes based on what is 
selected in the source object. 

If you have a destination object with multiple source objects, it may cause 
data set reports (.srep) to become extremely large.
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Link Type Examples

This section shows examples of the kind of link types that are possible when 
you build element links. The example link types shown are as follows:

• One table linked to multiple graphs 

• One graph linked to another graph

• One table linked to multiple graphs in a tabbed area 

• Multiple combination boxes linked to a single table
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Using a Table as a Source Object

You can link a table (source object) to a graph or to another table (destination 
object). Figure 28 shows how you can use this type of link to display summary 
information in a table and detailed information in several linked graphs. 

Figure 28 Linked Elements—Table as a Source Object 

Selected row

Link source

Link destinations

(table)

(three graphs)
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Using a Graph as a Source Object

You can link a graph with node and interface information displayed on its 
x-axis (source object) to either a graph or a table (destination object). This 
kind of graph is called a graph-by-node graph.

Figure 29 shows how you can use this type of link to display summary 
information in a graph and detailed information in a linked graph. 

Figure 29 Linked Elements—Graph as a Source Object 

Selected node

Link source

Link destination

$N$ variable
$D$ variable

Using variables ($N$, $T$, and $D$) in a graph’s title is an effective way to 
clarify the destination object in a report. Figure 29 uses $N$ and $D$ for the 
second and third lines of the title in the destination object. For more 
information about title variables, see Using Variables in Titles and Legends 
on page 150.
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Linking to Elements in a Tabbed Area

You can create a link from a table or a graph (source object) to the elements in 
a tabbed area. A link is created to each element in the tabbed area; the tabbed 
area is not part of the link.

Following are the ways in which you can configure a link to a tabbed area:

• Selecting a source row updates current tab panel only – As 
different rows are selected in the source table, only the selected tab is 
updated. 

• Selecting a source row updates all tab panels – As rows are selected 
in the source table, each tab in the tabbed area is updated to display 
detailed information for the node or interface selected. Typically, each tab 
in the tabbed area contains a graph or table that depicts a different 
statistic associated with the selected row in the source table. Each tab 
represents a link that you configure separately.

Figure 30 shows how you can use this type of link to display summary 
information in a table that is linked to detailed information in a tabbed area. 
Each tab could contain a different statistic associated with an item selected in 
the source.

When you select this option, you link to the tab that is selected when you 
create the link.
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Figure 30 Multiple Destination Objects (Tabbed Areas)

Multiple Combination Boxes Linked to a Single Table

You can link multiple source objects to a single destination object. Figure 28 
shows two instances of how multiple combination boxes can be linked to a 
single table. 

Selected row

Link source

Link destinations
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In this example, the combination boxes are linked to two different tables. 
Using the combination boxes, you select the interfaces you want to display in 
the devices table; the table will show all the interfaces that meet your 
selection criteria. In addition, the combination boxes are also linked to a table 
that shows the total number of interfaces that meet the selection criteria.

Figure 31 Linked Elements—Multiple Source Objects

Linking Elements

The procedure in this section assumes that you have already created the 
source and destination objects (graph, table, or tabbed area) in your report. 
For more information about adding elements to a report, see Adding Elements 
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on page 53. For more information about deleting, modifying, or displaying 
report links, see Deleting Links on page 180, Modifying Links on page 181, 
and Displaying Links on page 182.

To link two report elements:

Task 1: Start the Link wizard. 

1 Do one of the following:

• Click  on the toolbar.

• On the Insert menu, click Link Elements. 

• In the report’s Components tree, right-click the Links level, and 
choose Insert Relation from the shortcut menu.

The pointer changes to a crosshair.

2 Place the pointer on the source object in the Report window, and drag the 
pointer to the destination object. 

As you drag the pointer, a line is drawn. 

The following procedure creates a link between one source and one 
destination object. When multiple source or destination objects are involved, 
you will need to repeat the procedure depending on how many links are 
involved. For example, to link two tables to one graph, you would first link 
one table to the graph, and then you would repeat the procedure to create a 
link from the second table to the same graph.

When you reach the destination object, the will turn be red if the link is valid. 
(For more information about the types of objects you can link, see Link Type 
Examples on page 166.) If you cannot link the two objects, the line is black 
and disappears when you release the mouse button.
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Task 2: Enter a name and description for the link.

Figure 32 shows the Link Name and Description window.

Figure 32 Link Name and Description Window

Supplying a name and description is optional. Do either of the following:

• Supply a name and a description by doing the following: 

a In the Name box, enter a name for the element. This becomes the 
element’s Name property in the report’s Components list.
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b In the Description box, enter a description of the element. This 
becomes the element’s Description property in the report’s 
Components list.

c Click Next.

• Click Next and go to Task 3.

Task 3: Select the kind of link you want to create and specify how its time range will be created. 

Figure 33 shows the Configure Link window. 

Figure 33 Configure Link Window

1 In the Link Type box, select one of the following options:

• Link Using Element ID. When an item is selected in the source object, 
the element ID is passed to the destination object. For example, the 
source object can contain information about a particular device and its 
interfaces and the destination object can show more detail on a 
particular interface.

The Link Configuration box in the window only appears when the link’s 
destination object is a tabbed area.
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• Link Using Target Name. When an item is selected in the source object, 
the target name of the selected item is passed to the destination 
object. For example, starting with information about an interface on a 
specific device, you can drill down to information about that device.

• Link Using Other Properties (advanced).Lets you link a source object and 
a destination object based on one statistic. When an item is selected in 
the source object, a user-specified set of columns is passed to the 
destination object. For example, the source object can contain 
information about a particular device, and the destination object can 
show information related to that device. For more information about 
Advanced Properties links, see Advanced Property Links on page 179.

2 In the Time Range box, select one of the following options:

• Use Existing Time Range. Uses the time range that currently exists for 
the destination object.

• Define New Time Range. Lets the source and destination have different 
time ranges. For example, the source object could display daily 
utilization information for the past month, and the destination object 
could display hourly utilization information for the past 12 hours.

• Use Time Range From Link Source. Forces the source and destination 
objects to use the source object’s time range.

3 In the Link Configuration box, select one of the following options: 

• Selecting a source row updates the current tab panel only. As different 
rows are selected in the source table, only the selected tab is updated.

• Selecting a source row updates all tab panels. As rows are selected in the 
source table, each tab in the tabbed area is updated to display detailed 
information for the node or interface selected. Typically, each tab in 
the tabbed area contains a graph or table that depicts a different 
statistic associated with the selected row in the source table.

4 Click Next.

The Link Configuration box in step 3 only appears when the link’s 
destination object is a tabbed area. If your destination object is not 
a tabbed area, go to step 4.
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Task 4: Do one of the following:

• If you selected Link Using Other Properties and Define New Time Range in the 
Configure Link window, the Create Link Constraints window opens. Go to 
Task 5. 

• If you selected the Link Using Element ID or Link Using Target Name options 
and the Define New Time Range option in the Configure Link window, go to 
Task 7.

• If you did not select the Link Using Other Properties option or the Define New 
Time Range option in the Configure Link window, go to Task 8.

Task 5: Create the link constraints.

Figure 34 shows the Create Link Constraints window.

Figure 34 Create Link Constraints Window
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1 In the Destination Statistics box, click the destination statistic you want.

2 In the Source Statistics box, click the source statistic you want. 

3 Select an operator from the list that will be used to link the statistics.

4 Click Add to link the statistics together using the statistics.

The resulting constraint appears in the Constraints box.

5 Repeat steps a through c to add additional constraints.

6 If necessary, select a constraint in the Constraints box, and click Delete to 
remove it.

7 When you are finished, click Next.

Task 6: Do one of the following:

• If you selected the Define New Time Range option, the Set Time Period 
window opens. Go to Task 7. 

• If you did not select the Define New Time Range option, go to Task 8.

When choosing statistics to link, it is important to choose statistics 
that can be compared. For example, if you choose a statistic which 
is an integer in the Source Statistics box, you should not choose a 
string in the Destination Source box.

Do not choose the equals or not equals operators for floating point 
statistics that have fractional values. Equality-based comparisons 
are not likely to work as expected due to rounding.
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Task 7: Set a relative or absolute time period for data selection.

Figure 35 shows the Set Time Period window.

Figure 35 Set Time Period Window

1 Do one of the following:

• Click Use Relative Time. See the instructions in Step 12 on page 73.

• Click Use Absolute Time. See the instructions in Step 13 on page 74. 

2 Click Next in the Set Time Period window. 
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Task 8: Review the link summary and create the link.

Figure 36 shows the Summary window. 

Figure 36 Summary Window

1 Review the Summary window. 

2 If necessary, click Back to return to a previous window to make a change. 
After you make any change, click Next until you return to the Summary 
window.

3 Click Finish to create the link.

Advanced Property Links

A link between two statistics represents a constraint that is resolved when the 
report is viewed. For example, each time a row is selected in a drill-down 
source, new data is supplied to the drill-down destinations.

When a source and a destination objects have advanced links, destination 
data is retrieved as follows:

1 The user selects a row in a table or a bar in a graph.
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2 HP OpenView Performance Insight begins to update all the destination 
graphs and tables.

3 If a destination object has an advanced link, it resolves data from its 
source, and applies the link. 

For example, in the Create Link Constraints window that follows, the 
AVGmemUtil values for the source and destination objects are linked 
together. 

The destination object extracts the AVGmemUtil value from the selected row 
in the source object. It uses that value as a constraint on its own data and 
displays data where its AVGmemUtil would equal the AVGmemUtil value 
from the source object. The destination object then constrains the data it 
displays by all other links listed in the Constraints box.

Deleting Links 

To delete a link:

1 In the report’s Components tree, expand the Links level. The list of links 
appears.
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2 Right-click on the link you want to delete, and select Delete Link from the 
shortcut menu.

Modifying Links

You can modify a link by doing any of the following:

• Change the link’s name. 

By default, a link is assigned a number as a name when you create it. You 
can change this to a more meaningful name comprised of text.

• Create a description for the link. 

You can create a description for a link, which will appear in its Properties 
list.

• Change the link’s type.

• Specify whether or not the link uses the source object’s time period.

• Advanced link only: Change the link’s constraints.

To modify a link:

1 In the report’s Components tree, expand the Links level. A list of links 
appear.

2 Click the link you want to modify. Its properties appear in the Properties 
list.

3 Do any of the following:

— Click the value next to the Name box, and type a name for the link.

— Click the value box next to the Description box, and type a description 
for the link.

— Click the value box next to the Link Type box, and select one of the 
link types. 

— Click the value box next to Use Source Time Period box, and select a 
value.

4 To modify an advanced link’s constraints, do the following:
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a Expand the link you want to modify. The Link Constraints folder 
appears.

b Right-click the Link Constraints folder, and select Add Additional Link 
Constraints from the shortcut menu. 

The Modify Constraints dialog box opens. See Task 5 for instructions 
to modify and delete constraints.

5 Click another value box in the Properties list to apply the change.

Displaying Links

When you view a report, you can display the linked elements by selecting 
Links from Report Builder’s View menu. A line is drawn from source objects to 
any destination objects as shown in Figure 31 on page 171.
182 Chapter 5



6 Modifying Data Selection
When you first created graphs and tables for a report using the graph and 
table wizards, you chose how those elements would select data from the 
database. You selected one or more statistics, a time period, and the nodes and 
interfaces; this information formed the criteria for how the data would be 
selected from the database. After you create a report, you can change how its 
elements select data from the database and devise more advanced ways to 
select data.

This chapter describes how to do the following:

• Modify the data selection (statistics, time period, nodes, and interface) for 
graphs and table elements.

• Create constraints and parameters, which are more advanced ways to 
select data from the database. 

• Create rules, which let you monitor the data that a statistic displays by 
applying an image or background color to its data. 

Selecting Statistics

This section discusses how to do the following:

• Select, remove, order, and sort statistics.

• Create, modify, and delete custom statistics.

Creating constraints and parameters are features that you may not need to 
use or may use infrequently.
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Selecting a Statistic

To select a statistic for an element:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Query  Statistics. 

The Statistics level displays the list of available statistics for the element.

2 Right-click the statistic you want to select, and then click Select Statistic on 
the shortcut menu. The selected statistic is added to the Selected 
Statistics level.

Removing a Statistic

To remove a statistic from a table or a graph: 

1 In the report’s Components tree, expand Elements  Element Name  
Data  Query  Selected Statistics.

The Selected Statistics level displays a list of the selected statistics for the 
element.

2 Right-click the statistic you want to remove, and then click Unselect 
Statistic on the shortcut menu. 

The selected statistic will no longer appear when you expand the Selected 
Statistics level. 

Ordering Statistics

You can change the order in which statistics appear in a table or graph. By 
default, Report Builder displays statistics in a table or graph in the order in 
which they appear in the Selected Statistics level. 

To change the order of the statistics for a graph or table:

1 In the report’s Components tree, expand Elements,  Element Name  
Data  Query  Selected Statistics. 

You cannot delete a selected statistic; you can only remove it from the 
Selected Statistics level.
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The Selected Statistics level displays the list of selected statistics for the 
element.

2 Right-click Selected Statistics, and then click Order Statistics on the 
shortcut menu. The Order Statistics dialog box opens.

3 In the Order Statistics dialog box, do the following:

a Select the statistic that you want to reorder.

b Do one of the following:

— Click  to move the statistic up in the list.

— Click  to move the statistic down in the list.

c To unselect a statistic, select the statistic, and click .

d To select a statistic, do the following:

— Click . A blank box appears below the last statistic in the list.

— Click the box, and select the statistic you want add from the list.

4 Click OK. 

Sorting Statistics

You can select the sort order of the data returned from the database.

To sort statistics for a table or a graph:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Query. 
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2 Right-click Sort Order, and then choose Set Sort from the shortcut menu. 
The Set Sort dialog box opens.

3 To add a statistic to the list, do the following:

a Click the  button. A Statistic and Sort Order box appear. 

b Click the box, and select the statistic you want add from the list of 
statistics.

If you need to create a custom statistic, see Creating Custom Statistics 
on page 187.

4 To change the order in which the data is sorted, click the Sort Order box 
next to each statistic, and select one of the following from the list:

• Click ASC to sort the statistic in ascending order.

• Click DESC to sort the statistic in descending order.

5 To delete a value from the list, click the  button.

6 To rearrange the order of the statistics in the list, do one of the following:

• Click the  button to move a statistic up in the list.

• Click the  button to move a statistic down in the list.

7 Click OK.
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Creating Custom Statistics

To create a custom statistic for a graph or a table:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Query. 

2 Right-click the Statistics level, and then choose Add Custom Statistic from 
the shortcut menu. The Add Custom Statistic dialog box opens.

3 In the Alias box, enter the statistic’s alias. If needed, this is how the 
statistic is referred to. For example, this is how the statistic will appear in 
the Statistic list in the Add a Constraint dialog box.

4 In the Label box, enter the statistic’s label. A statistic’s label is displayed 
when the statistic is shown in graph legends and table titles.

5 In the Expression box, enter the statistic’s expression. This is the actual 
SQL expression (for example, AVGutilization_score*0.6). 

To create the statistic’s expression in the Expression box, do the following:

a Click the Statistics arrow, select a currently-defined statistic, and 
choose Insert.

b Click any operator.

c Enter text.

6 Click OK. 
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The statistic is added to the list of available statistics. To select this 
statistic for a graph or table, see Selecting a Statistic on page 184. 

Modifying Statistics

To modify a selected statistic for a graph or table:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Query  Selected Statistics. 

2 Click the statistic you want to modify.

The statistic’s properties appear in the Properties list. There are a number 
of properties for a statistic. They are grouped into the following categories:

For a detailed explanation of each statistic, see Appendix A, Element 
Properties.

3 Click the value box next to the property you want to modify.

Unlike a regular statistic, you can delete a custom statistic. For more 
information about deleting a custom statistic, see Deleting a Custom Statistic 
on page 189.

Category Applies to a statistic when...

Text It is displayed as text, such as when a statistic is displayed in 
a table. The properties that apply to text are as follows: 
alignment, color, date format, font name, font size, font style 
(bold or italic), and precision. If the statistic is a date, the 
Text Date Format value is used; however, if it is a real 
number, the Text Precision value is used. 

Line It is plotted in a graph. The properties that apply to a plotted 
line are as follows: color and width. The color value of a 
statistic can have a specific value or be cycled. When the color 
is cycled, a new color is used each time another instance of 
the statistic is encountered, eventually repeating the same 
set of colors. Symbol styles can also affect line styles.

Fill It is displayed in a pie chart, stacked bar chart, bar chart, or 
an area chart. When statistics are graphed in these kinds of 
charts, fill style determines the color of the display area. The 
property that applies to fill is color.
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For example, suppose you want to change a statistic’s text color and its 
alias. A statistic’s alias appears in graph legends and table headings. 
When you click the Value box for Text Color, the Select a Color dialog box 
opens from which you can select a color. When you click the Value box for 
Alias, you type the value for the alias.

4 To change the value in the property’s value box, do one of the following:

• Type the value.

• Select a color from the Select a Color dialog box.

• Select the value from the drop-down list that appears.

The statistic is updated with the new value when you click anywhere in 
another value box.

Deleting a Custom Statistic

To delete a custom statistic for a graph or a table:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Query  Statistics.

2 Right-click the statistic you want to delete, and then choose Delete Custom 
Statistic from the shortcut menu. 

If the statistic is being used, the following dialog box opens, indicating that 
you cannot delete the statistic:

Click OK to close the Delete Custom Statistic dialog box. If you want to delete 
the statistic, ensure that you remove it from the Selected Statistics list (see 
Removing a Statistic on page 184).

Modifying a Custom Statistic’s Expression

To modify a custom statistic’s expression: 

1 In the report’s Components tree, expand Elements  Element Name  
Data  Query  Statistics.
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2 Click the custom statistic you want to modify. The statistic’s properties 
appear in the Properties list.

3 Click the Value box for the SQL Expression. The SQL Expression dialog 
box opens.

4 Edit the statistic’s expression, and then click OK.

Selecting Nodes and Interfaces

When you created graph and table elements for your report, you specified the 
nodes and interfaces from which the elements should select data. You can 
change the selected nodes and interfaces by using Select Nodes/Interfaces 
dialog box.

To change selected nodes and interfaces: 

Task 1: Start the Node wizard. 

Do one of the following:

• Right-click a graph or table element in the Report window, and click Select 
Nodes/Interfaces on the shortcut menu.

• In the report’s Component’s list, expand Elements  Element Name  
Data  Query, right-click Nodes, and click Add Node on the shortcut menu. 
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Task 2: Choose whether you want to select nodes and interfaces individually or in groups.

The Select Node Selection Type window opens.

Figure 37 Select Node Selection Type Window

1 Select one of the following options:

• Select nodes and interfaces individually. The Select Nodes/Interfaces 
window opens. Go to Task 3.

• Select a group of nodes and interfaces. The Select Group window opens. 
Go to Step 4 on page 193. Groups of nodes and interfaces are defined 
by the reporting solutions that you have installed. 

2 Click Next. 
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Task 3: Select nodes and interfaces individually.

The Select Nodes/Interface window opens. 

1 To select nodes and interfaces individually, do one of the following:

• To collect data from all nodes, select Use All Nodes/Interfaces, and then 
click Next. See Step 4 on page 193. 

• To collect data from only certain nodes, select Use Selected 
Nodes/Interfaces. In the Choose from box, each node is represented by a 
folder. See step 2 below.

2 To collect data from only certain nodes, do the following: 

a Expand a node’s folder to display its interfaces. 

b To select a node or an interface, do one of the following: 

— Double-click a node or an interface in the Choose from box.

— Select a node or an interface in the Choose from box, and click .

c To remove a node or an interface, do one of the following:

— Double-click a node or an interface in the Selected 
Nodes/Interfaces box.
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— Select a node or an interface in the Selected Nodes/Interfaces box, 

and click .

d Click Next. Go to Task 5 .

Task 4: Select a group of nodes and interfaces.

1 Select a group from the Groups box. The Managed Objects For Group box 
displays the members of the selected group.

2 Click Next.

Task 5: Review the summary.

1 If necessary, click Back to return to make a change. After you make any 
changes, click Next until you return to the summary.

2 Click Finish. 

Unselecting Nodes or Interfaces

To unselect nodes or interfaces from an element’s Nodes list:

1 In the report’s Components tree, Elements  Element Name  Data  
Query  Nodes.

2 Do either of the following:

• Right-click the node you want to delete, and select Delete Node from 
the shortcut menu. Click Yes in the Delete Node dialog box.

• Right-click the group of nodes you want to delete, and select Delete 
Group from the shortcut menu. Click Yes in the Delete Node dialog 
box.

You can defer node selection until a report is viewed. For more information 
about how to defer node selection, see Creating Reports with Deferred 
Selections on page 162.
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Selecting a Time Period

When you created graph and table elements for your report, you specified the 
time range during which each of the report’s elements should collect data. You 
can change the time period for an element by using the Set Time Period dialog 
box.

Additionally, you can change the nodes from which each of the report’s 
elements should select data. For more information about changing selected 
nodes, see Selecting Nodes and Interfaces on page 190.

The available types of time ranges are as follows:

• Relative – Sets a variable time period for the report. The relative time 
selected (for example, a value of This week) is converted to an absolute 
time when you view the report. 

• Absolute – Sets a specific start and end time for the report to use.

To select a time period for a table or graph element:

Task 1: Open the Set Time Period dialog box. 

1 Do one of the following to open the Set Time Period dialog box:

— Right-click a graph or table element in the Report window, and click 
Set Time Period on the shortcut menu.

— In the report’s Component’s list, expand Elements  Element Name  
Data  Query, right-click Time Period, and click Set Time Period on the 
shortcut menu. 
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Figure 38 shows the Set Time Period dialog box.

Figure 38 Set Time Period Dialog Box

2 Set a relative or an absolute time period for the data selection.

a Click Use Relative Time or Use Absolute Time. 

b Do one of the following:

— To set a relative time period, follow the procedure in Task 12, and 
then click OK to close the Set Time Period dialog box.

— To set an absolute time period, follow the procedure in Task 13, 
and then click OK to close the Set Time Period dialog box.

Creating Constraints

This section discusses how to do the following:

• Create basic and custom constraints.

• Create AND and OR clauses.

• Modify and delete constraints. 

A constraint specifies how the data for a graph or table is retrieved from the 
database. You can create a basic or a custom constraint. A basic constraint 
comprises a statistic, an operator, and a value. A custom constraint can 
contain any valid SQL expression, and there are no limitations placed on the 
structure of the constraint as with basic constraints. 
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Creating a Constraint

To create a constraint for a table or graph element:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Query.

2 Right-click Constraint List, and click Add Constraint on the shortcut menu. 
The Add a Constraint dialog box opens.

3 In the Add a Constraint dialog box, do the following:

a Click the Statistic arrow, and select a statistic.

b Click the Operator arrow, and select an operator.

c In the Value box, type a value, or you can select a parameter, if 
available (see Creating a Parameter on page 201.)

4 Click OK.

Do not choose the equals or not equals operators for floating point 
statistics that have fractional values. Equality-based comparisons 
are not likely to work as expected due to rounding.
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Creating a Custom Constraint

A custom constraint can contain any valid SQL expression; there are no 
limitations placed on the structure of the custom constraint. 

To create a custom constraint for a table or a graph element:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Query.

2 Right-click Constraint List, and click Add Custom Constraint on the shortcut 
menu. The Add a Custom Constraint dialog box opens.

3 In the Label box, enter the constraint’s label. A constraint’s label is 
displayed in the Components tree.

4 To create the constraint’s expression in the Expression box, do the 
following:

a Click the Statistics arrow, select a currently-defined statistic, and click 
Insert.

b Click any operator.

c Enter text.

5 Click OK.

Report Builder does not verify the syntax of the statement; it only passes the 
statement to the database as part of the WHERE clause of a Select statement. 
If the syntax is incorrect, the Select will fail and the table or graph will not be 
populated until the syntax is corrected or the constraint is deleted.
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Adding an AND or OR Clause

The difference between an AND clause and an OR clause is how the constraint 
will be processed. The database will process the list of constraints from top to 
bottom, applying boolean logic to return a list of matching rows.

To add an AND or OR clause:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Query.

2 Right-click Constraint List, and click Add And or Add Or on the shortcut 
menu.

An AND or OR clause is added to the list of constraints.

3 To add a constraint, right-click AND or OR, and click Add Constraint or Add 
Custom Constraint on the submenu.

Report Builder adds the constraint to the ADD or OR level in the 
Components tree. 

The list of constraints is passed to the database as part of an SQL query. The 
ADD or OR level dictates the order in which the constraints are issues to the 
database. Ensure that you carefully define this list because the order of the 
list can impact the performance of the SQL query.
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Modifying Constraint Values

To modify a constraint’s value:

1 Right-click a table or a graph element in the Report window, and click 
Change Constraint Values on the shortcut menu. The Change Constraint 
Values dialog box opens.

2 Double-click the Value box, and type a new value.

3 Click OK.

When the value of a constraint is a parameter, the parameter name 
appears in italics in the Value box. You must edit the parameter 
using the Modify Parameter dialog box. To modify a parameter, see 
Modifying Parameter Values on page 207.
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Deleting Constraints and Clauses

To delete a constraint or clause:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Query  Constraint List  AND or OR.

2 Do one of the following:

• Right-click the clause you want to delete, and click Delete Clause on the 
shortcut menu.

• Right-click the constraint you want to delete, and click Delete 
Constraint on the shortcut menu.

Creating Parameters

In a report or form, a parameter specifies a name for a value. This name is 
used in constraints, and the current value will be automatically substituted. 
For example, if you want to display statistics for a particular router in your 
network, you can create a parameter that represents the router for which you 
want to display statistics. 

Additionally, you can override a parameter’s current value by specifying a new 
value when you open the report using the command line (refer to the HP 
OpenView Performance Insight Reference Guide) or the Web Access Server (see 
Viewing a Report Using a URL on page 295).

A parameter has the following characteristics:

• An integer, string, Boolean, double, float, or date value 

• Global to all elements in a report

• Can be used as a constant in constraints to control selection. 

For example, you can create a constraint that equals a parameter 
(dsi_target_name = target, where target is a parameter that equals a 
specific node name). 

• Evaluates to a constant at runtime.

You can specify a range for numeric or date values.
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For example, suppose the Router parameter has the default value of 
Thunderbolt. When the report is generated, the value Thunderbolt is used 
anywhere Router appears.

• May have a default value.

• If you create a parameter that has no value (default or one you specify at 
the command line) and that parameter is used in a constraint, the 
constraint is ignored when the report is run.

For more information about supplying parameter values on the 
command-line when using Report Builder, refer to the HP OpenView 
Performance Insight Reference Guide.

Creating a Parameter

To create a parameter:

1 In the report’s Components tree, right-click the Parameter level, and click 
Add Parameter on the shortcut menu. The Add a Parameter dialog box 
opens.

2 In the Name box, enter a name for the parameter.

3 Click the Datatype arrow, and select a data type for the parameter. 

• If you select integer or double, go to step 4.

• If you select any other value, go to step 5 on page 202.

4 Use Start Range to specify the highest acceptable numeric value, and use 
End Range to specify the lowest acceptable numeric value. 
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These fields are available only if the datatype is integer or double. They 
are not required; you can specify just one (that is, Start Range or End 
Range), or both, or neither.

5 In the Default Value box, you can do one of the following (optional):

• If the datatype is boolean, click the Default Value drop-down arrow, 
and select a value (true or false).

• If the datatype is date, click the browse button next to the Default 
Value box. The Edit Date Value dialog box opens. 

To select a date, click the drop-down arrow. 

Click the Month and Year arrows and select the month and year you 
want, click a day in the calendar. In the Time box, type or select the 
part of the time you want to change (hours, minutes, seconds, or time 
of the day). Click OK to close the Edit Date Value dialog box.

• If the datatype is string, enter the text in the Default Value box.

• If the datatype is Property, the value will depend on the types of 
categories available to the table associated with the table or graph. 
For example, if the property type is device, the value will be the name 
of the selected device.

• If the datatype is table, the value will be the name of a table in the 
database. Select a table from the Datatype list. 
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6 In the Description box, type a description of the parameter.

7 Click OK. When you save the report, the parameter is saved with it.

When you view the report, you can change the default by selecting Parameter 
Values from the Report Builder’s Edit menu. See Modifying Parameter Values 
on page 207 for details.

Example: Creating a Parameter for Use in a Constraint 

Suppose in a report you want to create a parameter called Router that will 
collect all particular statistics for a router called Thunderbolt. After you 
create the parameter, you want to use it in a constraint. For example, you 
could create a constraint to collect all particular statistics for the router 
named Thunderbolt and display them.

To create this parameter and constraint:

1 In the report’s Components tree, right-click the Parameter level, and click 
Add Parameter on the shortcut menu. The Add a Parameter dialog box 
opens.

2 In the Name box, type Router.

3 Click the Datatype arrow, and select string. 

4 In the Default Value box, type Thunderbolt. 

5 In the Description box, type a description of the parameter. This is 
optional.

6 Click OK. When you save the report, the parameter is saved with it.

When you create the constraint, you want to make the statistic Target 
Name equal to the value of the parameter you created for the Thunderbolt 
router. 

7 In the report’s Components tree, expand Elements  Element Name  
Data  Query.

8 Right-click Constraint List, and click Add Constraint on the shortcut menu. 
The Add a Constraint dialog box opens.

9 In the Add a Constraint dialog box, do the following:

a Click the Statistic arrow, and select Target Name.

b Click the Operator arrow, and select the equals sign (=).
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c In the Value box, select Router.

10 Click OK.

Example: Creating a Property Parameter to Display a Custom Report or 
Form in Object Manager

Suppose you have the Interface_Reporting solution and all its dependent 
packages installed, and you create a custom interface report or form that you 
want to use with the Management Console’s Object Manager application. 

When you create the report or form, you need to also create a property 
parameter and associate it with the table used to create the form or the tables 
used to create the report’s elements. A form will require one property 
parameter and a report will require a property parameter for each of its 
elements. For example, if a report has a table and three graphs, you need to 
create four property parameters. Note that you only need to create a property 
parameter for each top-level element; that is, if a graph drills down to a second 
graph, the second graph does not require a property parameter. 

To create a property parameter:

1 Create your report. See Chapter 3, Creating Reports for details. 

Suppose you create an element in the report (for example, a table) that 
will use the KIRDevPort table.

After you finish your report, you want to create a parameter named 
Device, which will associate the parameter with the KIRDevPort table.

2 In the report’s Components tree, right-click the Parameter level, and click 
Add Parameter on the shortcut menu. The Add a Parameter dialog box 
opens.

3 In the Name box, type Device for the name of the parameter.

4 Click the Datatype arrow, and select Property. 

When the datatype is Property, the value will depend on the types of 
categories available to the table associated with the table or graph. For 
example, if the property type is device, the value will be the name of the 
selected device.

5 In the Description box, type a description of the parameter. This is 
optional.

6 Click OK. 
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7 Save the report to save the parameter with it.

8 Expand the Parameters folder in the Components tree. The property list 
displays the parameter’s properties and their values.

9 Click the Table Name property’s Value box. 

10 Select KIRDevPorts from the list.

11 Click the Category property’s Value box, and select Device.

12 Expand Elements  Element Name  Data  Query.

13 Right-click Query, select Add Property Parameter, and then select Device 
from the menu.

The list should show all of the property parameters that use the same 
property table as the element (table or graph) you created in the report.

If the Add Property Parameter option is dimmed, it means that there are no 
available property parameters. Make sure that the element’s (table or 
graph) property table name is the same as the parameter’s.

The parameter is automatically added to use the object model defined. The 
object model is created by the report pack. 

14 Deploy your completed report to the systems folder. See Deploying a 
Report on page 238 for details.

To use the report or form using the Object Manager application, refer to the 
HP OpenView Performance Insight Administration Guide. 

Displaying Parameters

To display a parameter and its properties:

1 Expand the report’s Parameters level.

The report’s parameters appear.
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2 Click a parameter name to display its properties in the Properties list.
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Modifying Parameter Values 

To modify the value of a parameter:

1 From the Edit menu, click Parameter Values. The Modify Parameter Values 
dialog box opens.

2 Click the Current Value box, and enter a new value for the parameter.

3 Click OK.

Deleting Parameters

To delete a parameter:

1 In the report’s Components tree, expand the Parameters level.

2 Right-click the parameter you want to delete, and click Delete Parameter on 
the shortcut menu. 

Depending on the status of the parameter, one of the following will occur:

You cannot change a parameter’s name.
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— If the parameter is being used by a constraint, the Delete Parameter 
message opens.

You cannot delete the parameter. Click OK to close the message box.

— If the parameter is not being used by a constraint, the Delete 
Parameter dialog box opens.

Click Yes to delete the parameter.

Creating Rules

By applying a rule to a selected statistic, you can monitor the data that 
statistics display. When the conditions of the statistic’s rule are true, Report 
Builder will flag the statistic’s data by displaying a particular color, an image, 
text, or a statistic. For example, you can create a rule for the Key ID statistic 
that will apply a red background to any Key ID data that is less 3.

Creating a Rule

To create a rule:

Task 1: Start the Rule wizard.

1 In the report’s Components tree, expand Elements  Element Name  
Data.
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2 Right-click Rules, and then click Add Rule on the shortcut menu.

Task 2: Type a name and description for the rule.

Figure 39 shows the Rule Name and Description window.

Figure 39 Rule Name and Description Window

Do one of the following:

• Click Next. Supplying a name and description is optional.

• Enter a name and a description for the rule, and then click Next.
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Task 3: Select the statistics to which you want to apply the rule.

Figure 40 shows the Apply Rule to Selected Statistics window.

Figure 40 Apply Rule to the Selected Statistics Window

1 Do one of the following: 

• Double-click a statistic in the Choose from box.

• Select a statistic in the Choose from box, and click .

2 To remove a statistic from the Select Statistics dialog box, do one of the 
following:

• Double-click a statistic in the Selected statistics box.

• Select a statistic in the Selected statistics box, and click .

3 Click Next. 
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Task 4: Add clauses to the rule.

Figure 40 shows the Add Rule Clauses window.

Figure 41 Add Rule Clauses Window

1 Click the  button. A clause row is added. 

2 Click the Operator box, select an operator, and then press the TAB key. 

3 Type a value in the Value box, and then press the TAB key. 

4 Type a label for the clause in the Clause Label box, and then press the TAB 
key. 

For example, if Key ID is the statistic, your clause might be less than 3 if 
you wanted the rule to flag all Key ID data with a value of less than 3. 

5 Select one of the following options from the Set box to indicate what will 
occur when a rule is satisfied: 

• Background. Displays a color behind the statistic’s data. When a rule is 
satisfied, the statistic’s data can be highlighted with red.

• Image. Displays an image instead of the statistic’s data. When a rule is 
satisfied, an image of a check mark can display.
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• Text. Displays user-specified text instead of the statistic’s data. When a 
rule is satisfied, the text “Full” can display. 

• Statistic. Displays the data for a different statistic instead of the 
current statistic’s data. When a rule is satisfied (for example, Statistic 
A is greater than 1000), the value of Statistic B can display. 

6 Click the To box, then do one of the following depending on the option you 
selected in the Set box:

• Background. Select a color from the Select a Color dialog box.

• Image. Locate an image using the Open dialog box. 

• Text. Type the text you want to display in the To box.

• Statistic. Select an available statistic from the To box.

7 Repeat step 1 through step 6 to add additional clauses.

8 To delete a clause from the list, select the clause, and then click .

9 To rearrange the order in which the clauses will be evaluated, select the 
clause, and then do one of the following:

• Click  to move the clause up in the list.

• Click  to move the clause down in the list.

10 Click Next.

Task 5: Review the rule summary and create the rule.

1 Review the Summary window. 

2 If necessary, click Back to return to a previous window to make a change. 
After you make any change, click Next until you return to the Summary 
window.

3 Click Finish to create the link.

Changing a Rule Clause Using the Components Window

You change the clause label, operator, value, and associated color or image for 
a rule using the Properties list after you create the rule. 
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Alternatively, you can modify the clause label, operator, and value using the 
Add Rule Clause dialog box. See Modifying or Adding a Clause on page 215 for 
details.

To change a rule using the Components:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Rules  rule_name.

2 Click on the clause name. 

The Properties list displays the values for the rule.

3 To change a value, click the box to the right of the property you want to 
modify, then do any of the following:

• Label and Value. Type a value in a text box.

• Operator. Select a value from the drop-down combo box.

• Result. Depending on the option you selected, the method will vary; 
select a new color, image, or statistic, or type new text. 

The value is updated when you click in another Value box or move the 
pointer to the Report window.

Applying a Rule to a Different Statistic

When you created a rule, you applied it to a specific statistic or statistics. 
After the rule is created, you can change the statistic or statistics to which it 
will be applied.

To apply a rule to a different statistic or statistics:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Rules.
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2 Right-click on a rule, and then click Apply Rule to. The Apply rule to the 
Selected Statistic dialog box opens.

3 To modify the statistic or statistics to which the rule is applied, do the 
following:

a To add a statistic, do one of the following:

— Double-click a statistic in the Choose from box.

— Select a statistic in the Choose from box, and click .

b To remove a statistic, do one of the following:

— Double-click a statistic in the Selected statistics box.

— Select a statistic in the Selected statistics box, and click .

c Click OK. 

Deleting a Rule

To delete a rule:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Rules.

2 Right-click on a rule, and then click Delete Rule.
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Modifying or Adding a Clause

To modify or add a rule clause:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Rules.

2 Right-click on a rule, and then click Add/Modify Rule Clauses.The Add Rule 
Clause dialog box opens.

3 Do either of the following:

• Click the  button to create a new clause. See step 1 on page 211 for 
details.

• Modify the operator, value, or clause label for a clause.

4 Click OK.

Deleting a Rule Clause

To delete a rule clause:

1 In the report’s Components tree, expand Elements  Element Name  
Data  Rules  rule_name.

2 Right-click the clause that you want to delete, and then click Delete Rule 
Clause on the submenu.
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7 Scheduling and Generating Reports
After you create a report, you can schedule it for generation. This chapter 
describes how to schedule and generate reports using the Web Access Server. 

Using the Web Access Server 

This section describes how to use the Web Access Server to:

• Create schedules.

• Add events (reports) to schedules.

• Generate reports.

• View report generation results.

• Disable schedules and events.

• Delete schedules and events. 

You can also schedule and generate reports using the schedule and generate 
commands. Refer to the HP OpenView Performance Insight Reference Guide 
for more information.

The procedures in this section assume that the Web Access Server is 
displayed. For more information about how to display the Web Access Server, 
see Displaying the Web Access Server on page 19.

The Administrator can view all the schedules, create entries in the system 
schedule, and create entries in the system schedule on the behalf of other 
users.
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Graphic Display Requirements

You need a graphics display to generate reports.

UNIX Requirements

For report generation to occur on UNIX systems, you need to do the following:

• Log on to the system where the Web Access Server is installed.

• Set the display so it is opened for connections (xhost + localhost). For 
more information, see Setting the Display for Connections.

• Run Report Scheduler with its display set to this DISPLAY.

If you have locked the system by assigning a screen-saver password during 
the time that reports are being generated, then the screen lock must be 
configured to allow report generation.

If access to the X environment cannot be granted, the administrator can 
generate dataset reports (.srep) because the process for dataset reports does 
not require a graphics context.

Alternatively, you can create a virtual display using xvfb. This is a 
pseudo-display; it draws into memory rather than on the screen. You can edit 
the HP OpenView Performance Insight (OVPI) startup scripts to use this 
display. For more information about xvfb, see your UNIX system 
documentation.

Setting the Display for Connections

To set your UNIX display:

1 On the system where the Web Access Server is installed, log in as root.

2 Type the following command, and then press ENTER.

xhost + localhost 

3 Stop and start the Web Access Server. For more information about how to 
stop and start these services, refer to the HP OpenView Performance 
Insight Administration Guide.

4 Do not log off of the system. 

You can switch the monitor off, let the screen saver run with or without 
password protection, or both.
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Specifying a Drill-Down Depth Constraint

When you schedule a report, you will need to supply a drill-down depth 
constraint. A drill-down depth constraint controls the number of queries to 
the database when elements in a report are linked. For more information 
about how to link elements in a report, see Chapter 5, Linking Report 
Elements.

When elements in a report are linked, you can change the contents of multiple 
elements in a graph by changing a row selection or by selecting a column in a 
graph. 

HTML and dataset reports (.srep) are static reports that do not interact with 
the database. To support link source and link targets, the report generation 
process fills in a number of link targets by retrieving the data. 

For example, suppose two tables are linked in a report, and the source object 
has 100 rows. When you view the report, you can issue up to 100 database 
queries. You can specify the number of queries performed when you schedule 
the report’s generation. (See step  on page 224 in the procedure discussed in 
Scheduling Report Generation on page 219.)

You can choose how much data you want to retrieve. You can retrieve data as 
follows:

• All the data available by issuing all queries to the database

• Return a specific number of queries to the database

When you retrieve data from all the link sources, you can create a 
comprehensive static report; however, this creates large dataset reports and 
lengthy HTML files. By default, OVPI’s scheduling mechanism uses a value of 
5 when you schedule a report. This lets the user see the first five drilldowns 
for each source in the report. 

Scheduling Report Generation

To generate a report, you must create a schedule that includes information 
about how and when the Web Access Server should run the schedule. Then 
you must add the events (reports) you want to generate to the schedule. You 
can add one or more reports to any schedule.

A value of -1 will generate all possibilities; however, this may result in a very 
large file set and is not recommended.
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To schedule a report:

Task 1: Click Schedule on the links bar. 

The Schedule page opens.
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Task 2: Expand the Schedules folder, and click New Schedule.

The Create a new schedule page opens.

1 In the Schedule Title box, enter a name for the schedule you want to 
create.

2 Select Add to Generator Timer if you want the Web Access Server to run the 
schedule automatically to generate the reports. 

If you do not select this option, you can generate the reports in the 
schedule manually (see Generating Reports Manually on page 229) or by 
using trendtimer (see Generating Reports Using trendtimer on page 230). 

3 Click the Hours arrow, and select the hour when the schedule will run. 
(Select Every Hour to run the schedule every hour of the day.)

4 Click the Minutes arrow, and select the number of minutes past the hour.

5 Click the Time of Day of arrow, and select AM or PM.

6 Click Create. The schedule_name page opens.
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Task 3: Add events (reports) to the schedule.

1 Click Add Event. The New Schedule Event page opens.

You can specify the report you want to schedule by using either of the 
following methods:

• Type the schedule information. Go to step 2. 

• Click the Browse button, which will let you search for a report and 
automatically fill in schedule information after you have selected the 
report you want to schedule. Go to step 3. 

2 To type schedule information, do the following:

a In the Template box, enter the directory path for the report you want 
to schedule.

b In the Title box, enter a title for the report.

c In the Description box, enter a description of the scheduled report.

d Click Next.

3 To browse for schedule information, do the following:
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a Click Browse to display the Report Browser window, which lets you 
view the deployed reports that you can schedule.

b Expand the folders to locate the report you want to schedule.

c Click the report when you locate it. The Report Browser window 
closes, and OVPI updates the New Schedule Event page with the 
information you supplied when you deployed the report. For more 
information about deploying reports, see Deploying and Undeploying 
Reports on page 284.

After you complete the New Schedule Event page, it may look similar to 
the following:

4 Click Next. 
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The Formats page displays the report information you entered in step 2 on 
page 222, and requests additional information about the kind of report 
information that should be generated.

Task 4: Specify the formats for the report.

To specify what kind of report information should be generated, do the 
following:

1 If it is not already selected, click the Activate button, which ensures that 
the report is generated according to the schedule you specify.

2 In the Drill Down Depth box, type the number for the drilldown depth. 
The default value is 5. 

The report will return only the number of queries specified for each source 
element. This reduces the resources required to generate and store the 
report. For example, suppose a source object (a table) contained 10 rows, 
and the drill-down depth is set to 5; you will only be able to drilldown on 
the first five rows in the table. For more information about drill-down 
constraints, see Specifying a Drill-Down Depth Constraint on page 219.

Every graph and table element in a report has an Allowable Drilldowns 
property. When you schedule a report, the value that you set for the Drill 
Down Depth option overrides the value set for the Allowable Drilldowns 
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property for all elements. (To see the Allowable Drilldowns property for an 
element, click the element in the navigation frame of Report Builder, and 
locate the property in the associated properties list.)

3 Select the appropriate boxes for the report formats you want to generate. 
The available formats are as follows:

• .html – You can view HTML reports on your local system using the 
Web Access Server.

• .srep – A dataset report is a repository of queried data. Once it is 
generated, it does not access the database; therefore, it is a fast and 
efficient way to view data. 

• .csv (hybrid) – A comma separated value file in which tables are 
displayed in CSV format and charts and graphs are displayed as 
images. 

• .pdf – A Portable Document Format (PDF) file lets you view the report 
using Adobe Acrobat Reader. 

• .csv (simple) – A comma separated value file in which all elements are 
displayed in CSV format. 

4 In the Keep report for n days box, type the number of days that you want 
to keep the report. The default is -1; this means that OVPI will keep the 
report indefinitely. You can keep a report for any number of days.

5 Click Next to continue. (Alternatively, you can click Reset Page to remove 
the information you entered and reenter it.) 

If you want to use TrueType fonts in a PDF file, see Appendix B, 
Using TrueType Fonts in PDF Files for more information about 
how to configure OVPI for TrueType fonts.
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The Triggers page opens.

Task 5: Schedule when the report will run.

1 Do one of the following:

• To generate the report on a specific day of the month, click the 
appropriate box for the day or days of the month.

• To generate the report on a specific day of the week, click the box for 
the day or days of the week.

• To generate the report quarterly, click Generate Report Quarterly.

Even if the daily and monthly settings overlap, reports will only run once 
a day.

2 Click Next or Finish to continue. 

3 Do one of the following:

• If you selected PDF for the format of the generated report in Step 4 on 
page 224 of this procedure, then the Email Generated PDF page opens 
as shown in Figure 42 on page 227. If you want to email the generated 
PDF, go to Task 6. 

• If you do not want to email the PDF, click Next in the Email Generated 
PDF page, and then go to Step 6 on page 227.
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• If you did not pick PDF as the report format, go to Step 7 on page 228.

Task 6: Select the recipients who will receive the generated PDF report.

Figure 42 shows the Email Generated PDF page.

Figure 42 Email Generated PDF Page

1 To select the users who you want to receive the report, select a user in the 
Available Users/Groups box, and click Add. The user is added to the 
Recipient list. Repeat this for each user. 

If you mistakenly add a user to the Recipient list, select the user in the 
Recipients list, and click Remove.

2 In the Subject box, type the subject text for the email message.

3 In the Message box, type the message you want to send in the email 
message to the recipients.

4 Click Next. 
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Task 7: Specify the parameters for the report.

If the report you are scheduling contains parameters, the Parameters page 
opens as shown in Figure 43. If the Parameters page does not open, see 
Task 8.

Figure 43 shows the Parameters page.

Figure 43 Parameters Page

1 Type the values for any parameters listed.

2 Click Finish to schedule the report or reports for generation.

Task 8: Change the schedule, if necessary.

After you create an event for the schedule, the Schedule Title page may look 
similar to Figure 44.

Figure 44 Schedule Title Page

1 Click the title of an event or the Edit Event button  to display the 
Formats page. See step  on page 224.
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— Click the View Details button  to display a window that contains 
detailed information about the event. A window similar to the 
following appears:

2 Do one of the following:

— Click Finish to schedule the report for generation.

After you create a schedule, it will run and generate its events (reports) at the 
time that you specified, and then you can view the generated results (see 
Viewing Report Generation Results on page 231).

You can schedule report generation using cron or the trendtimer daemon. For 
more information about using trendtimer, see Generating Reports Using 
trendtimer on page 230. 

Generating Reports Manually

You can generate reports manually in the following circumstances:

• You want to generate reports independently of the generation time 
specified by their schedule.

• You did not select automatic generation for a schedule; that is, you did not 
select the Add to Generator Timer box on the Create a new schedule page 
when you created a schedule.

To generate reports manually:

1 Click Schedule on the links bar. The Schedule page appears. 

2 Expand the Schedules folder.

3 Click the schedule that contains the report you want to generate. The 
Schedule Title page appears.
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4 Do one of the following:

— Select the Select box next to the report you want to generate.

— Click Select All to select all the reports.

5 Click Run.

As the reports are scheduled for generation and generated, the Status 
column on the Schedule Title page changes as follows: Queuing, Queued, 
Started, and Completed. 

Depending on the size of a report and the amount of data available, you 
may or may not see the percentage of the report generated between the 
Started and Completed phase of generation. If you are generating a 
dataset report (.srep), you will not see any percentages. 

After the reports are generated, expand the Results folder to view the 
generated reports.

Generating Reports Using trendtimer

To generate reports using trendtimer:

1 Do one of the following:

• Edit the default trendtimer.sched file, which has the following path:

— Windows:

installation_directory\lib 

— UNIX:

installation_directory/lib 

In this instance, installation_directory is the directory into which 
you installed OVPI.

• Edit the alternative schedule file that you created. 

2 Add a line which specifies the interval at which the Generate tool should 
run. 

For example, suppose you want to run a schedule every Monday at 7AM. 
Then, you would add the following line at the end of the trendtimer.sched 
file:
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MO+7:00 - - generate -user generation -pass generation -host 
wizzywig -port 80 -schedule jkatter\schedule01 -log 
\tmp\generate.log 

3 Save the file. The change takes effect when trendtimer runs next.

For more information about how to create your own schedule file and specify 
intervals, refer to the HP OpenView Performance Insight Reference Guide.

Viewing Report Generation Results

You can view the results of the report generation after the generation is 
completed.

To view the results of report generation:

1 Click Schedule on the links bar. The Schedule page appears. 

2 Expand the Results folder.

3 Expand the schedule. A folder appears representing each format that was 
generated for the report.

4 Click the format folder to view the results of the report generation. The 
Result Listing page appears, displaying report’s generation date, the 
report’s title, and a link to the generated report. 

You can add multiple generation lines to this file.

When OVPI generates HTML reports containing Japanese Characters using 
the scheduling mechanism, the HTML reports may contain some garbled 
characters. This is caused when the Auto Detect feature of the browsers does 
not automatically select the encoding (in this case Shif-JIS), resulting the 
garbled characters. You need to set the encoding manually in the browsers.

If you generate the reports manually (see Generating Reports 
Manually on page 229) by clicking the Run button, you will need to 
refresh the navigation pane to see the generated report or reports. 
To do this, click the Schedule folder (not the Schedules folder) in 
the navigation pane and then expand the Results folder.
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For example, the Result Listing page may appear similar to the following 
when you view the results of report generation.

Disabling Report Generation

You can prevent report generation by disabling an entire schedule or by 
disabling only a few events (reports) in a schedule. When you disable report or 
schedule generation, the disabled reports or schedule are not deleted; they are 
only prevented from being generated at the time specified by the schedule. 

This is useful when you want to prevent the generation of specific reports 
without deleting the reports from a schedule or deleting an entire schedule. 
Thus, when you want to generate the reports or the schedule again, all you 
have to do is enable them and not recreate them.

To disable report generation:

1 Click Schedule on the links bar. The Schedule page appears.
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2 Click the Schedules folder. The Schedule Listing page appears.

3 To disable a schedule:

a Do one of the following:

– Select the Select box next to the schedule you want to disable.

– Click Select All to select all the schedules.

b Click Disable.

4 To disable an event (a report) in a schedule:

a Click on the schedule in the Navigation frame that contains the report 
or reports you want to disable.

b Click the report’s title. The Format page appears.

c Change the report’s enabled status by clicking disable.

d Click Next. If you do not want to make any further changes, click 
Finish.

Conversely, to enable a schedule or report, repeat step 1 through step 3 
and click Enable in step 3 and click enable in step 4.
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Deleting Schedules and Events

You can delete a schedule or an event (a report) from a schedule.

Deleting a Schedule

To delete a schedule:

1 Click Schedule on the links bar. The Schedule page appears.

2 Click the Schedules folder. The Schedule Listing page appears. 

3 Do one of the following:

• Select the Select box next to the schedule you want to delete.

• Click Select All to select all the schedules. 

4 Click Delete.

A confirmation dialog box appears, asking if you want to delete the 
schedule or schedules.

5 Click OK.

Deleting an Event from a Schedule

To delete an event (a report) from a schedule:

1 Click Schedule on the links bar. The Schedule page appears.

2 Click the Schedules folder. The Schedule Listing page appears. 

3 Click the schedule in the Navigation frame that contains the event or 
events you want to delete.

You cannot delete the system schedule.
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4 Do one of the following:

• Select the Select box next to the event you want to delete.

• Click Select All to select all the events. 

5 Click Delete Event.

A confirmation dialog box appears, asking if you want to delete the event.

6 Click OK.

When you delete an event from a schedule, the previously 
generated results are not deleted.
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8 Deploying Reports
To view a report or form using the Web Access Server, the report first must be 
deployed there. Deployment publishes reports and forms to the Web Access 
Server.

You can use any one of the following methods to deploy reports:

• Deployment Wizard. This method is discussed in this chapter.

• Web Access Server. For more information, see Deploying and Undeploying 
Reports on page 284.

• The deploytool command. Refer to the HP OpenView Performance Insight 
Reference Guide for more information.

You can view reports that you deploy using Report Viewer or the Web Access 
Server. For more information about using Report Viewer and the Web Access 
Server, see Chapter 10, Using Report Viewer and Chapter 11, Using the Web 
Access Server, respectively.
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Using the Deployment Wizard

The Deployment Wizard is a utility that guides you through each step 
necessary to deploy reports to or undeploy reports from the Web Access Server. 
You can start the wizard from Report Builder or from the OVPI program 
group.

Deploying a Report

To deploy a report:

Task 1: Start the Deployment Wizard.

Do one of the following:

• From Report Builder’s File menu, click Deploy. The Login dialog box opens. 
Enter your report username and password, and then click OK. (For more 
information about your user account or about creating user accounts, see 
your Administrator or the HP OpenView Performance Insight 
Administration Guide.)

• From the Windows desktop, click Start, point to Programs, HP OpenView, 
Performance Insight, and then click Deployment Wizard on the menu.
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Task 2: Select the deploy option.

Figure 45 shows the Select Deployment Action window.

Figure 45 Select Deployment Action Window

Select Deploy report and click Next.
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Task 3: Specify the information needed to deploy the report to the Web Access Server.

Figure 46 shows the Select Web Access Server window.

Figure 46 Select Web Access Server Window

By default, this window displays the name and port number of the current 
Web Access Server. The Web Access Server is the server that contains the HP 
OpenView Performance Insight (OVPI) Web site and domain.

Do the following:

1 In the Web Access Server Host box, leave the default value supplied or 
type the name of the Web Access Server where you want to deploy the 
report.

2 In the Web Access Server Port box, leave the default value supplied or 
type the port number of the Web Access Server specified in the Web Access 
Server Host box.

3 Do one of the following:

• Select the Communicate over SSL check box to enable SSL.

• Click to clear the Communicate over SSL check box to disable SSL. 
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The Communicate over SSL option enables Secure Socket Layer (SSL) 
communication between the Web Access Server and any supported Web 
browser. When this option is not used, the communication between the 
two is over HTTP.

4 Click Next to continue. 

5 Do one of the following:

• Go to Task 4 if the Log on window opens; this window opens if one of 
the following conditions is true:

— You started the Deployment Wizard from the HP OpenView 
program group.

— You are not logged on to the Web Access Server you specified in 
Step 3 on page 240.

• Go to Step 5 on page 242 if the Select Report window opens.

Task 4: Log on to the Web Access Server.

If you are not currently logged on to the Web Access Server you specified, the 
Login window opens. 
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Task 5: Select the report you want to deploy.

Figure 47 shows the Select Report window.

Figure 47 Select Report Window

1 Click Add. 

The Open dialog box opens; navigate to the folder that contains your 
reports. 

2 Do any of the following in the Open dialog box, then click Open:

• To select a single report, click the report file name.

• To select consecutive reports, click the first report, press and hold 
down the SHIFT key, and then click the last report. 

• To select reports that are not consecutive, press and hold down the 
CTRL key, and then click each report. 

3 If you need to remove a report that you added, select it, and click Remove.

4 Click Next. 
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Task 6: Select a folder in which to deploy a report or reports.

Figure 48 shows the Select Location window. 

Figure 48 Select Location Window

Do one of the following:

• Expand the tree, and select the folder where you want to store the 
report(s), and click Next. 

• Expand the tree, and select the folder where you want to create a new 
folder, then click Add Folder. 

A New Folder entry appears in the tree. Do the following:

a Click the New Folder entry and type the name of the new subfolder.

b Click Next.
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Task 7: Deploy the reports.

Figure 49 shows the Summary window.

Figure 49 Summary Window

1 Click Finish.

If the reports is deployed successfully, a confirmation message displays.

2 Click OK. 

If you deploy a report when your Web browser is open, you must click your 
browser’s Refresh button to see the report you deployed.

When OVPI generates HTML reports containing Japanese Characters using 
the scheduling mechanism, the HTML reports may contain some garbled 
characters. This is caused when the Auto Detect feature of the browsers does 
not automatically select the encoding (in this case Shif-JIS), resulting the 
garbled characters. You need to set the encoding manually in the browsers.
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Undeploying a Report

To undeploy a report:

Task 1: Start the Deployment Wizard.

Do one of the following:

• From Report Builder’s File menu, click Deploy. The Login dialog box opens. 
Enter your report username and password, and then click OK. (For more 
information about your user account or about creating user accounts, see 
your Administrator or the HP OpenView Performance Insight 
Administration Guide.)

• From the Windows desktop, click Start, point to Programs, HP OpenView, 
Performance Insight, and then click Deployment Wizard on the menu.

Task 2: Select the deploy option.

The Select Deployment Action window opens. See Figure 45 on page 239.

Select Undeploy report and click Next.

Task 3: Specify the information needed to deploy the report to the Web Access Server.

The Select Web Access Server window opens. See Figure 46 on page 240.

By default, the window displays the name and port number of the current Web 
Access Server. The Web Access Server is the server that contains the OVPI web 
site and domain.

Do the following:

1 In the Web Access Server Host box, leave the default value supplied or 
type the name of the Web Access Server where you want to deploy the 
report.

2 In the Web Access Server Port box, leave the default value supplied or 
type the port number of the Web Access Server specified in the Web Access 
Server Host box.

3 Do one of the following:

To undeploy reports from the system folder, you must log on to Report Builder 
or the Deployment Wizard using an account that has Administrator 
privileges.
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• Select the Communicate over SSL check box to enable SSL.

• Click to clear the Communicate over SSL check box to disable SSL. 

The Communicate over SSL option enables Secure Socket Layer (SSL) 
communication between the Web Access Server and any supported Web 
browser. When this option is not used, the communication between the 
two is over HTTP.

4 Click Next to continue. 

Task 4: Select the report you want to undeploy.

The Select Location window opens. See Figure 48 on page 243.

1 Navigate to the folder that contains the report or reports you want to 
undeploy. 

2 Select a report or reports by doing any of the following:

• To select a single report, click the report file name.

• To select consecutive reports, click the first report, press and hold 
down the SHIFT key, and then click the last report. 

• To select reports that are not consecutive, press and hold down the 
CTRL key, and then click each report. 

3 Click Next. 

Task 5: Undeploy the reports.

The Summary window opens. See Figure 49 on page 244.

1 Click Finish.

If the report is undeployed successfully, a confirmation message displays.

2 Click OK.

If you started the Deployment Wizard from the HP OpenView 
program group, the Login page opens. Enter your report username 
and password, and click OK.

If you deploy a report when your Web browser is open, you must click your 
browser’s Refresh button to see the report you deployed
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9 Creating Forms
Forms are a special kind of report, which let you modify the data contained in 
the database when using the Management Console’s Object Manager 
application. Forms are provided with some of the reports from the Reporting 
and Network Solutions report packs. For example, the Common Properties 
Report Pack supplies forms that let you create new customers, locations, and 
nodes or modify the same information for specific reports. Figure 50 shows the 
Create New Customer form.

Figure 50 Create New Customer Form

A form is an easy way to modify or create new data in the database. 
Specifically, a form lets you change the data for a single database table. For 
more information about how to use the forms supplied with a report pack, 
refer to the user guide for the report pack.
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In addition to using the forms supplied with report packs, you can create 
forms. After you create a form and deploy it, use the Management Console’s 
Object Manager application to access it. Refer to the HP OpenView 
Performance Insight Administration Guide for details.

Forms Overview

A form updates a single database table. You create a form similarly to how you 
create a report using the form wizard. In addition to containing regular report 
elements such as labels and images, a form contains a table element that 
defines the database table that the form will modify and specific form 
elements (input field and input combination box) that let you modify the 
columns of the database table. See Chapter 3, Creating Reports for more 
information about how to add other elements to a form. 

Form Elements

You add form elements to edit the columns of the database table. You can 
associate each form element with a single statistic (column) of the database 
table. Form elements are as follows:

• Input field. An input field can accept arbitrary values like text, numbers, 
or a range of numbers. Examples of table columns that can be updated 
using this element are as follows: descriptions, labels, and speeds. 

• Input combination box. An input combination box is assigned a list of 
values or you specify that it query the database to build a list of values. 

In order for the form to display in Object Manager, you need to create a 
property parameter when you create the form and associate it with the table 
used to create the form. See Example: Creating a Property Parameter to 
Display a Custom Report or Form in Object Manager on page 204 for details.
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Creating a Form

The procedures in this section assume, for example purposes, that you are 
creating a form that will let you update a customer in the database for the 
Common Properties Table report pack. 

To create a form:

Task 1: Start the Form Wizard.

Do one of the following:

• From the File menu, click New and then click Form on the submenu.

• Click the New button  on the general toolbar. Click Form on the 
Create New dialog box, and then click OK.

The Form Wizard window opens as shown in the following figure:
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Task 2: Select the data table that the form will update.

The Select a data source for the form window opens.

To select the table that the form will update:

1 Expand either the Property Tables or Generic folder.

2 Select a table.

3 Click Next.

For example, to update a customer in the database, expand the Property 
Tables folder, and select the Customer_Property_Table.

Task 3: Select the table statistics that the form will update.

The Select Statistics window opens.

1 Do one of the following: 

• Double-click a statistic in the Choose from box.

• Select a statistic in the Choose from box, and click .

2 To remove a statistic from the Select Statistics dialog box, do one of the 
following:

• Double-click a statistic in the Selected statistics box.

• Select a statistic in the Selected statistics box, and click .

3 Click Next. 

For example, to update a customer in the database, select the following 
statistics: cust_id, cust_name, and Description.

Do one of the following depending on the folder from which you selected a 
table:

• Property Tables folder. Go to Task 5 to complete the Summary window.

• Generic folder. Go to Task 4 to complete the Select Statistics to Form a 
Unique Key window. 
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Task 4: Select the statistic that will be used in the database query to uniquely identify the row in 
the table.

Select the statistics that will be used in the database query to uniquely 
identify the row in the table; follow the instructions in Task 3.

Tables in the Property Tables folder automatically select the key ID column.

Task 5: Review the form summary and create the form.

1 Review the summary of the information that the form will contain. 

2 If necessary, click Back to return to make a change. After you make any 
changes, click Next until you return to the summary.

3 Click Finish.

After you create the form, the following occurs:

• A window titled untitledn.frep appears.
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• A Form Table folder appears below the Elements folder in the 
Components window. This folder contains all the information that you 
entered using the Form wizard.

Displaying the Database Table

After you create a form, you will not be able to see the database table. By 
default, it is set not to display.

To display the database table in the form:

1 Expand Elements in the form’s components list, and then click Form Table. 

2 In the Properties list, click on the value box next to Visible, and select True 
from the list.

The table appears. If using the example given in the procedure in Creating a 
Form on page 249, the table would appear in the form as follows:
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After you create the form, you can add the following form elements: input 
fields and input combination boxes. These elements will let you update the 
table’s columns or data. You can also use any of the standard report elements 
on the form to provide additional information or improve its appearance.

Specifying the Form Type

You can create a form that will either update the data in a table or create new 
data in a table. You specify the type for your form after you create the form.

To specify the form type:

1 Click on the form’s file name (for example, Untitled-3.frep) in the 
Components list, for example:

2 Click the Value box next to Mode, and then select one of the following 
options:

• Modify. The form will modify the data for the table.

• Create. The form will create new data for the table.

3 Click another Value box in the Components list or click in the Form 
window to make the change take effect.

Creating an Update or Modify Statement

After you create your form by clicking OK or Apply in the form window, Report 
Builder automatically generates a SQL statement that is used to access the 
information in the database table. When the Update Stmt or Create Stmt 
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properties are blank, the statement is automatically generated. Alternatively, 
you can create this statement yourself before you click OK or Apply in the form 
window. 

To create a SQL statement:

1 Click on the form’s file name (for example, Untitled-3.frep) in the 
Components list. 

2 Click the Value box next to one of the following properties:

• Update Stmt. This property appears when the form’s Mode property is 
set to Modify. The Edit Update Statement dialog box opens.

• Create Stmt. This property appears when the form’s Mode property is 
set to Create. The Edit Create Statement dialog box opens.

3 Use the following variables to create your update or create statement in 
the dialog box:

• #{column_name} - This substitutes the value of the column named 
column_name from the Form Table element. This column must be a 
selected statistics for the table.

• !{column_name} - This substitutes the value from the Form Input 
element (input field or input combination box) that is assigned to the 
column named column_name. 

For example, following is a statement for a form that creates a customer:

4 When you finish creating your statement, click OK. 

HP recommends that you create this statement yourself only if you are an 
experienced SQL user; otherwise, use the statement generated by Report 
Builder after you click OK or Apply in the form window.
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Adding an Input Field

An input field is a box in which you can type text (alphabetic or numeric) that 
will be used to update the value of a statistic. You might use an input field to 
update a statistic that has many possible values, such as a customer name.

To add an input field to a form:

1 Do one of the following:

• On the Report Builder toolbar, click .

• From the Insert menu, select Input Field.

• Right-click the form’s Elements level, and click Insert Input Field.

2 Position the pointer (a crosshair) in the Form window where you want the 
upper-left corner of the element, and then drag the pointer until you reach 
its desired size.

The Enter Element Name and Description window opens.

3 Do one of the following:

• Click Next. Supplying a name and description is optional.

• Enter a name and a description for the input field, and then click Next.

The Select a Statistic for Input window opens.

4 In the Statistic list, click the statistic (column) from the database table 
that you want to assign to the input field, and then click Next.

The list of available statistics are the ones that you selected in Step 3 on 
page 250.

If using the example given in the procedure in Creating a Form on 
page 249, you would select cust_id from the Statistic list. You would also 
repeat this procedure to create input field boxes for the cust_name and 
Description statistics.

5 Do the following: 

a Review the summary of the information that the input field will 
contain. 

b If necessary, click Back to return to make a change. After you make 
any changes, click Next until you return to the summary.

c Click Finish.
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An input field is placed in the form window. If using the example given in the 
procedure in Creating a Form on page 249, the input field would appear in the 
form as follows:

Adding an Input Combination Box

An input combination box is a box that displays a list of values. It can display 
a list of values that it obtains as a result of querying the database or a list of 
values that you manually entered when you create the box. You might use an 
input combination box for a statistic when there are a limited set of values for 
a statistic like the location of a device.

To add an input combination box to a form:

1 Do one of the following:

• On the Report Builder toolbar, click .

• On the Insert menu, select Input Combo Box.

• Right-click the form’s Elements level, and select Insert Input Combo Box 
from the shortcut menu.

2 Position the pointer (a crosshair) in the Form window where you want the 
upper-left corner of the element, and then drag the pointer until you reach 
its desired size.
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The Enter Element Name and Description window opens.

3 Do one of the following:

• Click Next. Supplying a name and description is optional.

• Enter a name and a description for the input field, and then click Next.

The Select a Statistic for Input window opens.

4 In the Statistic list, click the statistic (column) from the database table 
that you want to assign to the input combination box, and then click Next.

The list of available statistics are the ones that you selected in Step 3 on 
page 250.

The Select the Data Source for the ComboBox Entries window opens.

5 To select how the values displayed in the input combination box list are 
created, select one of the following options:

• Query. Queries the database for the list of values that it will display 
when you click the drop-down arrow next to the combination box.

• Manual. Lets you enter the values that the list will display when you 
click the drop-down arrow next to the combination box.

If you chose Manual, go to step 6. If you chose Query, go to step 7.

6 To enter the values that the box will display in its list:

a Click the  button. A row is added. 

b Click the box in the Data Value column, type a value, and then press 
the TAB key. Repeat step a and step b to enter additional values.

c To delete a value from the list, select the value, and then click .

d To rearrange the order in which the values will appear in the list, 
select the value, and then do one of the following:

— Click  to move the value up in the list.

— Click  to move the value down in the list.

e Click Next, and go to step 9.

7 Select the table that the query will use to build the list of values that will 
be available in the input combo by doing the following:
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a Expand either the Property Tables or Generic folder.

b Select a data table.

c Click Next.

8 Select the statistic whose value will be used in the form and the statistic 
that will be displayed in the input combination box by doing the following: 

a Click the Statistic arrow to select the statistic from the database table 
that you want to assign to the input combination box.

b Click in the Statistic arrow to select statistic from which the box will 
get its values.

9 Do the following: 

a Review the summary of the information that the input combination 
box will contain. 

b If necessary, click Back to return to make a change. After you make 
any changes, click Next until you return to the summary.

c Click Finish.

Adding Other Elements to Forms

After you create a form and its form elements, you can add regular report 
elements. For example, you will probably want to reposition the table and 
form elements and add other elements, such as a logo, graphic objects, and 
labels. Figure 50 on page 247 shows a form with an image, a graphic object 
(line), and labels. 

For more information about adding other elements and moving elements, see 
Adding Elements on page 53 and You can move, resize, copy and paste, and 
cut and paste elements. on page 109. To save the form, see Saving Reports on 
page 127.
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Deploying Forms

After you create a form, you must deploy it to the Management Server. Once 
the form is deployed, you can start Object Manager, which is available from 
the Management Console application, which lets you access the forms to 
update managed objects. Refer to the Performance Insight Administration 
Guide for details.

You can deploy a form using any of the following methods:

• Package Manager. Refer to the Performance Insight Reference Guide for 
details about the form and formdir directives for the install.pkg file. 

• The formdeploytool command. Refer to the Performance Insight 
Reference Guide for details.

• Form Deployment wizard. 

Using the Form Deployment Wizard

You can use the Form Deployment wizard to deploy or undeploy a form.

Starting the Form Deployment Wizard

To start the form deployment wizard:

Do one of the following:

• UNIX

a Open a new shell window.

b Navigate to the following directory:

installation_directory/bin 

In this instance, installation_directory is the directory into which you 
installed OVPI.

c Type the following command:

./formdeploywizard 

• Windows 

a Navigate to the following directory:
Creating Forms 259



installation_directory\bin

where installation_directory is the directory into which you installed 
OVPI.

b Double-click the following:

formdeploywizard.exe 

The Select Deployment Action window opens.

Deploying a Form

To deploy a form:

1 Start the Form Deployment wizard. See Starting the Form Deployment 
Wizard on page 259 for details.

The Select Deployment Action window opens.

2 Select Deploy form.

The Select Web Access Server window opens.

By default, this window displays the name and port number of the Web 
Access Server. The Web Access Server contains the HP OpenView 
Performance Insight (OVPI) Web site and domain.

3 Do the following:

a In the Web Access Server Host box, leave the default value supplied or 
type the name of the Web Access Server where you want to deploy the 
form.

b In the Web Access Server Port box, leave the default value supplied or 
type the port number of the Web Access Server specified in the Web 
Access Server Host box.

The Communicate over SSL option enables Secure Socket Layer (SSL) 
communication between the Web Access Server and any supported 
Web browser. When this option is not used, the communication 
between the two is over HTTP. Refer to HP OpenView Performance 
Insight Administration Guide for more information about SSL.

c Do one of the following:

— Select the Communicate over SSL check box to enable SSL.

— Click to clear the Communicate over SSL check box to disable SSL. 
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d Click Next to continue. 

The Login Server window opens.

4 Type your username, your password, and then click Next. 

The Select Admin Server window opens. 

5 Select the administration server on which you want to deploy the form 
from the list of available servers, and click Next.

The Select Report window opens.

6 In the Select Report window, do the following:

a Click Add. 

The Open dialog box opens. 

b Navigate to the folder that contains your forms.

c Do any of the following:

— To select a single form, select the form, and then click Open or 
double-click the form.

— To select consecutive forms, click the first form, press and hold 
down the SHIFT key, and then click the last form. 

— To select forms that are not consecutive, press and hold down the 
CTRL key, and then click each form. 

If you need to remove a form, select it in the Select Form window, and 
then click Remove.

d Click Next. 

The Select Location window opens.

7 Expand the Admin folder, and select the folder in which you want to 
deploy the form, and then click Next.

To create a new subfolder below the Admin folder, click Add Folder. 

The Summary window opens.

8 Click Finish.

If the form is deployed successfully, a confirmation message displays.

9 Click OK to close the confirmation message.
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Undeploying a Form

To undeploy a form:

1 Start the Form Deployment wizard. See Starting the Form Deployment 
Wizard on page 259 for details.

The Select Deployment Action window opens.

2 Select Undeploy form.

The Select Web Access Server window opens.

By default, this window displays the name and port number of the current 
Web Access Server. The Web Access Server contains the HP OpenView 
Performance Insight (OVPI) Web site and domain.

3 Do the following:

a In the Web Access Server Host box, leave the default value supplied or 
enter the name of the Web Access Server where you have deployed the 
form.

b In the Web Access Server Port box, leave the default value supplied or 
enter the port number of the Web Access Server specified in the Web 
Access Server Host box.

The Communicate over SSL option enables Secure Socket Layer (SSL) 
communication between the Web Access Server and any supported 
Web browser. When this option is not used, the communication 
between the two is over HTTP. Refer to HP OpenView Performance 
Insight Administration Guide for more information about SSL.

c Do one of the following:

— Select the Communicate over SSL check box to enable SSL.

— Click to clear the Communicate over SSL check box to disable SSL. 

d Click Next to continue. 

The Select Location window opens.

4 Do the following:

a Expand the Admin folder, and locate the folder in which the form is 
deployed.

b Select the form, and then click Next.
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The Summary window opens.

5 Click Finish.

If the form is undeployed successfully, a confirmation message displays.

6 Click OK to close the confirmation message.
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10 Using Report Viewer
This chapter describes how to use Report Viewer to do the following:

• Open and view reports

• Modify reports

• Save reports

• Print reports 

Alternatively, you can also use the Web Access Server to view reports that you 
or the Administrator have deployed to the Web Access Server. For more 
information about the Web Access Server, see Chapter 11, Using the Web 
Access Server. 

The procedures in this chapter assume that Report Viewer is started. For 
more information about how to start Report Viewer, see Starting Report 
Builder or Report Viewer on page 17.
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The Report Viewer Interface

After you start Report Viewer, the Report Viewer window appears. When you 
open a report, it appears in a Report window, as shown in the following figure:

Multiple Document Interface

Report Viewer has an MDI (Multiple Document Interface) desktop. The MDI 
desktop has one window that will contain the other windows that you open; 
thus, using MDI, Report Viewer lets you open, modify, and preview multiple 
reports at the same time. Additionally, the reports you open can have different 
formats (for example, .rep or .srep). The MDI desktop uses dockable and 
document windows. For more information about dockable and document 
windows, see Docking Windows on page 27 and Undocking Windows on 
page 28.
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Title Bar

The title bar is the horizontal bar at the top of the Report Viewer window. It 
displays information about the current window.

Menu Bar

The Report Viewer has the following menus: File, Edit, View, Window, and 
Help.

File Menu

Table 14 lists the options on the File menu.

Table 14 Report Viewer File Menu Options

Menu 
Option Description

Open  Displays the Open dialog box, which lets you open a 
report. 

Browse Displays the Browse window, which lets you open 
reports that have been deployed to the users and 
system folders on the Web Access Server (see 
Undeploying a Report on page 245 and Deploying and 
Undeploying Reports on page 284).

Close  Closes the active Report window.

Close All Closes all of the Report windows.

Export As Displays the Export dialog box, which lets you export a 
report to CSV (Comma Separated Value) or PDF 
(Portable Document Format).
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Edit Menu

Table 15 lists the option on the Edit menu.

Save As Displays the Save As dialog box, which lets you save 
your report to any of the available formats (see Saving 
Reports on page 127).

Print Displays the Print dialog box, which lets select a 
printer, the portion of the report to print, and the 
number of copies to print (see Printing Reports on 
page 129).

Exit Exits Report Viewer.

Table 14 Report Viewer File Menu Options (cont’d)

Menu 
Option Description

Table 15 Report Viewer Edit Menu Option

Menu 
Option Description

Refresh All Refreshes all the elements in the current Report 
window. 

Options Displays the Options dialog box, which you can use to 
change information about the Web Access Server, 
specify your Help Web browser, and set logging and 
debugging options (see Specifying Options on 
page 120).

Parameter 
Values

Displays the Modify Parameter Values dialog box, if 
the current report has parameters defined, which lets 
you change any of the report’s parameters (see 
Creating Parameters on page 200). 
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View Menu

Table 16 lists the options on the View menu.

Window Menu

The Window menu lets you control Report Viewer windows. Table 17 lists the 
options on the Window menu. 

Table 16 Report Viewer View Menu Options

Menu 
Option Description

Toolbars Lets you show or hide the active toolbars.

Status Bar Lets you show or hide the status bar.

View Log 
Output

Lets you view the log file for Report Viewer 
(viewer.log).

Ensure that all the windows that you want to tile or cascade are open. You 
cannot display closed or minimized windows.
Table 17 Report Viewer Window Menu Options

Menu Option Description

Tile  Arranges the open Report windows so that they 
fill the entire Report Builder window without 
overlapping.

Tile Vertically Arranges all of the open Report windows 
side-by-side, so that they fill the entire window 
without overlapping.

Tile Horizontally Arranges the open Report windows top to bottom 
so that they fill the entire window without 
overlapping.

Cascade Arranges all of the open Report windows in an 
overlapping fashion so that each title bar is 
visible.
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Help Menu

Table 18 lists the options on the Help menu.

Status Bar

The status bar displays messages about the current operation. For example, 
when a report is loaded, the following message appears in the status text area: 

Ready 

Toolbar

The Report Viewer toolbar contains buttons for the most frequently used 
tasks. 

The following figure shows the Report Viewer toolbar:

Table 18 Report Viewer Help Menu Options

Menu Option Description

Help Topics Displays a list of topics available within the Help 
system.

About Report 
Viewer 

Displays copyright and version information about 
Report Viewer.

1

1. Browse
2. Open
3. Print
4. Tile Horizontally
5. Tile Vertically

6. Tile
7. Cascade
8. Refresh

2 3 4 5 6 7 8
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Report Window

After you start Report Viewer and open a report, the Report window will 
appear. (For more information about opening a report, see Viewing Reports on 
page 272).

When the Report window is active, you can modify the report it displays. The 
current list of Report windows appears in the Window menu in the order in 
which they are opened. When you close the Report window, you close the 
report file.
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Viewing Reports

Using Report Viewer, you can do the following:

• View reports that are located on your system and on the Web Access 
Server. 

• Change how the data is displayed.

• Save and print reports.

Opening a Report

You can open the following types of reports: 

• Dataset (.srep)

• Report Definition (.rep)

You can open a report by using any one of the following methods:

• Open dialog box – Lets you open reports that are located on your system 
(see Opening Reports on Your System on page 50).

• Browser window – Lets you open report that have been deployed to the 
Web Access Server (see Opening Reports on the Web Access Server on 
page 51).

• Drag-and-drop – Lets you drag a report from your file management 
application (for example, Windows Explorer) and drop it into the Report 
Viewer window (see Opening Reports Using Drag-and-Drop on page 52).

• viewer command – Lets you open reports on your system or those that 
have been deployed to the Web Access Server using a command-line 
interface. Refer to the HP OpenView Performance Insight Reference Guide 
for details. 

Opening a Report with a Deferred Selection

When you open a report that has a deferred selection, Report Viewer will 
prompt you for information before it will open the report. 

Most reports do not require you to make deferred selections.
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A report with a deferred selection will prompt you to specify nodes and 
interfaces, a time range, or both. A node contains multiple interfaces. A time 
range is the time period for which the report should display data. 

After you supply the information, the report is run based on that information. 
Additionally, you could run the report numerous times using different nodes 
and interfaces or time selections. For information about how to create a report 
with a deferred selection, see Creating Reports with Deferred Selections on 
page 162.

Selecting Nodes and Interfaces

When you open a report that has a deferred selection for nodes and interfaces, 
the Node Wizard opens displaying the Select Node Selection Type window. For 
more information about how to select nodes/interfaces, see Selecting Nodes 
and Interfaces on page 190.

Selecting a Time Period

When you open a report that has a deferred selection for its time period, the 
Set Time Period dialog box opens. See Figure 38 on page 195. 

The following types of time periods are available for reports:

• Relative – Sets a variable time period for the report. The relative time 
selected (for example, This week) is converted to an absolute time when 
you view the report. 

• Absolute – Sets a specific start and end time for the report to use.

For more information about how to select a time period, see Selecting a Time 
Period on page 194.

Drilling Down for Data

When you view a report, many elements in the report will be linked to other 
elements. For example, a table may be linked to a graph. (For more 
information about link types and how to create links, see Chapter 5, Linking 
Report Elements.) 
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In the case of a link from a table to a graph, the table may display summary 
statistics while the graph it is linked to displays details about a particular 
item (for example, a device) from the table. The table is the source object, and 
the graph is the destination object. The source object displays the summary 
statistics. The destination object displays the detailed information. 

The detailed information is referred to as a drilldown. For example, Figure 51 
on page 275 shows a table linked to several graphs. As you select devices in 
the table, the graphs will update with data for the selected device. Figure 51 
shows that device 15.2.144.1 is selected in the table, and the graphs, which are 
linked to the table, display detailed data about Grade of Service (hourly, daily, 
and monthly, Hours with/without exception, utilization, discards, and errors 
for device 15.2.144.1.
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Figure 51 Drilldown Example

Links in dataset reports (.srep) function similarly to the links in reports 
(.rep); however, the data for all links may not be available. 

When the Administrator schedules a report to generate dataset format 
(.srep), she can limit the number of link datasets that are generated by 
specifying a drilldown depth. If you need to maintain large quantities of 
dataset files, this reduces their size. Since the data is sorted, the most 
important n rows of the table will be the rows with links.

Selected device in 
the source object (table)

Destination objects (two
tabbed areas and a graph)
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For example, suppose a report contains a table that has 10 rows linked to a 
tabbed area. The Administrator could configure the generation of the dataset 
report so that the link data used to populate the graphs in the tab area is 
stored for only the first five rows. For more information about specifying 
drilldown depth, see Specifying a Drill-Down Depth Constraint on page 219.

To drill down for data:

• Click on a table row in a report. The destination object or objects will be 
updated with information from the source object.

Refreshing Elements in a Report

To refresh all the elements in the active Report window, do one of the 
following:

• On the Report Viewer toolbar, click .

• On the Edit menu, click Refresh All.

Opening Report Links

In addition to element links that are used to drilldown for data within a 
report, reports can also contain links to other reports, applications, and 
Uniform Resource Locators (URL). A report link takes specific information 
from an element (graph, table, image, or label) in a report (the source report), 
and uses the information as the input to a report parameter (in the case of a 
report to report link) or to an argument (in the case of a report to application 
or URL link). 

When you trigger the link in the source report, the destination of the link 
(report, application, or URL) is displayed with the specified information from 
the source report.

Report links are created in reports using the Management Console’s Catalog 
Manager application. To use Catalog Manager, you must have an account 
with Administrator privileges. Refer to the HP OpenView Performance Insight 
Administration Guide for more information about using Catalog Manager to 
create links.
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A report can be the destination for multiple report links. For example, you 
might view a report that displays customers; it contains a report link that 
displays a device report, showing only the devices for a specific customer. In 
addition, you might view another report that displays locations; it contains a 
report link that displays the same device report, showing only the devices for 
a specific location. In this instance, both the customer and location reports 
link to the same destination report, which shows devices. 

Likewise, one report can contain multiple links; for example, one report can be 
linked to any number of reports, URLs, and applications. 

If a report you are viewing contains a link, the cursor will change from an 
arrow to a hand when it is placed over the link. Additionally, depending on the 
type of element used for the link, the following occurs: 

• Elements that are the destination of a report link are surrounded by a 
blue border. 

• Text in a label or in a table column is underlined. 

This behavior is illustrated in the following example: 

To open a report link:

• Double-click it. The destination of the link (report, URL, or application) 
will open.

If an element is linked to multiple items, the Select a Link dialog box will 
open. Select the link you want to trigger, and click OK.

Hand cursor
Blue border 

Hand cursor

Underlined 
text

Blue border 
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Modifying Reports

You can modify graph and report elements using Report Viewer’s shortcut 
menus. 

To modify an element, right-click on the element. The shortcut menu differs 
depending on the type of element you select. 

Table 19 lists the options on the graph and table shortcut menus.

Table 19 Report Viewer Shortcut Menu Options

Menu Option Lets you...
Applies 
to... See...

Set Time Period Set the time period. Graph, 
Table

Selecting a Time 
Period on page 194

Change 
Constraint Values

Change constraint 
values.

Graph, 
Table

Modifying Constraint 
Values on page 199

Select Nodes/
Interfaces

Select nodes and 
interfaces.

Graph, 
Table

Selecting Nodes and 
Interfaces on page 190

Displayed Data Specify the statistics 
that will display in a 
graph when you view 
it.

Graph Displaying Selected 
Statistics on page 154

Grid Display grid lines or 
turn them off.

Graph Displaying Grid Lines 
on page 143

Legend Reposition a graph’s 
legend.

Graph Repositioning Legends 
on page 144

Style Change a graph’s 
style.

Graph Changing Graph Style 
on page 147

Change Max 
Rows

Control the amount of 
data returned from 
the database.

Graph, 
Table

Changing the 
Maximum Number of 
Rows Returned on 
page 147
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Modifying Parameters

If you are viewing a report with parameters, you can modify those parameters. 
A parameter specifies a name for a value. This name can be used in 
constraints, where the current value of the parameter will be automatically 
substituted. 

To modify parameter values, click Parameter Values on the Edit menu bar. The 
Modify Parameter Values dialog box appears. For more information about 
modifying parameters, see Modifying Parameter Values on page 207.

Display Data 
Table and 
Display Overlay 
Data Table

Display data for every 
point on a graph.

Graph Displaying Data 
Tables on page 148

Export Element 
as CSV

Export Graph 
Overlay as CSV

Export an element 
(graph or table) or 
graph overlay data to 
comma separated 
value (CSV) format.

Graph, 
Table

Exporting Elements or 
Data to CSV Format 
on page 130

View in new 
Frame

Display a report 
element in a new 
window.

Graph, 
Table

Viewing a Table in a 
New Frame on 
page 160

Print Graph
Print Table

Prints the selected 
table or graph.

Graph, 
Table

Printing Graphs and 
Tables on page 131

Table 19 Report Viewer Shortcut Menu Options (cont’d)

Menu Option Lets you...
Applies 
to... See...
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Saving Reports

You can save a report you modify; however, you can only save the report to a 
new file name (Save As option). 

To save a report, click Save As on the File menu. The Save As dialog box opens. 
For more information about saving a report, see Saving Reports on page 127.

Printing Reports

To print a report, do either of the following:

• On the toolbar, click .

• On the File menu, click Print. 

The Print dialog box appears. For more information about printing reports, 
see Closing Reports on page 130.
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11 Using the Web Access Server
The Web Access Server lets you deploy reports and URLs, schedule reports for 
generation, and view deployed items from any networked system that has 
Netscape Navigator or Microsoft Internet Explorer. (For a list of the supported 
Web browsers, see Prerequisites on page 16.) 

This chapter discusses how to:

• Deploy reports and Uniform Resource Locators (URL).

• View and modify reports.

• Set your preferences for viewing reports. 

The procedures in this chapter assume that the Web Access Server is 
displayed. For more information about how to display the Web Access Server, 
see Displaying the Web Access Server on page 19.

If the Web Access Server remains inactive for more than 30 minutes, the 
Enter Network Password dialog box will appear, requiring you to log on again.
 281



The Web Access Server Interface

Figure 52 shows the components of the Web Access Server. 

Figure 52 Web Access Server Interface

The Web Access Server has the following components:

• Links bar (1)

Contains the links to Web Access Server’s functions.

• Navigation frame (2)

Lets you access the folders associated with each link using a standard tree 
structure. 

• Results frame (3)

If the navigation frame does not display, refer to the 
Troubleshooting appendix in the HP OpenView Performance Insight 
Administration Guide.
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Displays the contents of the folder or the report currently selected in the 
navigation frame.

You open the folders in the navigation frame’s tree as follows:

• To preview the contents of a folder, click the plus sign (+). 

The folder’s contents (additional folders, elements, or both) are shown in 
the navigation frame; click on a folder or an element to see its contents in 
the results frame.

• To close an open folder, click the minus sign (-). 

Web Access Server Links Bar

The links bar comprises the following links:

• Home – Lets you view the reports that you viewed most recently 
(History), and the reports you view the most (Favorites). 

• Catalog – Lets you deploy reports to the Web Access Server, and view the 
list of reports that have been deployed in the system and users folders. 

• Preferences – Lets you change the appearance of the Web Access Server 
and history and viewing settings for deployed items.

• Schedule – Lets you schedule report generation. For more information 
about how to create schedules and generate them, see Chapter 7, 
Scheduling and Generating Reports.

• Help – Displays the online Help.

• Log off username – Logs you off from the Web Access Server. 

If your user account has Administrator privileges, the links bar will also 
contain an Administration link. For more information about using the 
Administration link, refer to the HP OpenView Performance Insight 
Administration Guide.
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Deploying and Undeploying Reports

Before you can view a report using the Web Access Server, you must deploy it 
there. You can deploy a report using the Web Access Server. 

Alternatively, you can also use the Deployment Wizard or Deployment Tool 
(command-line interface) to deploy reports to the Web Access Server. You can 
start the Deployment Wizard from the HP OpenView program group or from 
Report Builder. For more information, see Chapter 8, Deploying Reports.

When you want to remove a report from the Web Access Server, you can 
undeploy it. (For information about undeploying a report, see Undeploying a 
Report on page 287.)

Deploying a Report

To deploy a report:

1 Click Catalog on the links bar. The Catalog page appears.

2 Click Deploy New Report in the navigation frame. 

The Report Deployment page appears.

3 Do one of the following:

— In the Report box, type the name of the report you want to deploy.
284 Chapter 11



— Click the Browse button to display the Choose file dialog box, which 
lets you select a report from another location on your system or on 
your network. After you select a report, click Open.

4 In the Save To box, enter the location on the Web Access Server where the 
report should be saved. 

If you do not enter a path, the report is saved to your folder in the users 
folder. For example, if you are logged on to the Web Access Server on a 
Windows system using the user account, izgeorges, the path of your 
reports will be:

installation_directory\reports\deploy\users\izgeorges 

In this instance, installation_directory is the directory into which you 
installed HP OpenView Performance Insight (OVPI).

Suppose you want save your reports to a particular folder in your user 
folder. If you had a folder called general reports in your user folder, 
izgeorges, you would enter the following in the Save To box:

\users\izgeorges\general reports 

5 In the Display Name box, enter a name for the report. This name appears 
in the list of deployed items on the Catalog page.

6 In the Description box, enter a description of the report. A description is 
optional and does not appear when you view the list of deployed reports. 

You must have Administrator privileges to deploy reports to the 
system folder; however, any user can deploy reports to their folder 
in the users folder. For more information about deploying reports 
to the system folder, refer to the HP OpenView Performance Insight 
Administration Guide.
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For example, the Report Deployment page may appear similar to the 
following after you enter report information:

7 Click Deploy. If the Web Access Server deploys the report successfully, a 
message similar to the following appears:

You have successfully deployed “Location_TopTen.rep”. 

8 Expand the Users folder, and then expand your folder to view the 
deployed report. 

For example, the deployed report will appear in your user folder as follows:

If the Administrator deploys any reports while you are logged on to the Web 
Access Server, you must click the Catalog folder in the navigation frame or 
click the Catalog link in the links bar to update your list of deployed reports.

Your user folder
Deployed report
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Undeploying a Report

When you undeploy a report, it is deleted from the Web Access Server; thus, 
you can no longer view it using the application.

To undeploy reports:

1 Click Catalog on the links bar. The Catalog page appears.

2 Expand the users folder in the navigation frame. 

3 Click your user folder. The Deployed Items list displays the deployed 
reports in your user folder. 

4 Do one of the following:

• Select the Undeploy check box next to the report or reports that you 
want to undeploy.

• Click Select All to undeploy all the reports in your folder.

5 Click Undeploy.
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Deploying and Undeploying URLs

You can deploy a URL to the Web Access Server’s catalog in order to quickly 
access a website that you use frequently. For example, if your company has 
more than one Web Access Server system, you may want to deploy a URL for a 
particular report that you view frequently on one of those systems. 

When you select a URL, the specified website displays in your current browser 
window or in a new browser window, depending how you have configured the 
Web Access Server. (See Specifying Viewing Settings on page 316 for more 
information about changing how reports and URLs display.)

Deploying a URL

To deploy a report:

1 Click Catalog on the links bar. The Catalog page opens.

2 Click Deploy URL in the navigation frame. 

The URL Deployment page opens. 

3 In the URL box, type the URL you want to deploy. 
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For example, if you wanted to create a URL to access a report 
(Customer_Summary.rep) located in the wong user folder on another Web 
Access Server system (WAS2), the value for URL box may look similar to 
the following:

http://WAS2.ackcat.com/reports/
webview?rn=%2Fusers%2Fwong%Customer_Summary.rep

For more information about viewing a report using a URL, see Viewing a 
Report Using a URL on page 295.

4 Select users or system from the Save To list.

5 To specify a folder in the users or system folder, do either of the following:

• Type the folder in the Save To box. 

• Click the Browse button, which opens the Browser window, and locate 
and select a folder. After you select a folder, the Browser window will 
close automatically.

If you do not enter a path, the URL is saved to your folder in the users 
folder. For example, if you are logged on to the Web Access Server on a 
Windows system using the user account, ncanfield, the URL is saved in 
the following location:

installation_directory\reports\deploy\users\ncanfield 

In this instance, installation_directory is the directory into which you 
installed HP OpenView Performance Insight (OVPI).

Suppose you want save a URL to a particular folder in your user folder. If 
you had a folder called URLs in your user folder, ncanfield, you would 
enter the following in the Save To box:

\users\ncanfield\URLs 

6 In the Display Name box, enter a name for the URL. This is the name 
shown for the URL when you open the folder containing the URL.

7 In the Description box, type a description of the report. A description is 
optional; the description does not appear anywhere. 

8 Select the Open in New Browser option if you want the URL to display in 
a new browser window.
Using the Web Access Server 289



For example, the URL Deployment page may appear similar to the 
following after you enter information for a particular URL: 

9 Click Deploy. If the Web Access Server deploys the URL successfully, a 
message similar to the following appears:

You have successfully deployed “www.hp.com” 

10 Expand the Users folder, and then expand your folder to view the 
deployed URL. 

Undeploying a URL

When you undeploy a URL, it is deleted from the Web Access Server; thus, you 
can no longer view it.

To undeploy a URL:

1 Click Catalog on the links bar. The Catalog page appears.

2 Expand the users folder in the navigation frame. 

If the Administrator deploys any URLs while you are logged on to the Web 
Access Server, you must click the Catalog folder in the navigation frame or 
click the Catalog link in the links bar to update your catalog. 
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3 Click your user folder. The Deployed Items page shows the deployed 
reports and URLs in your folder. 

4 Select the Undeploy check box next to the URL or URLs that you want to 
undeploy.

5 Click Undeploy.

Viewing Deployed Items

Before you can view reports using the Web Access Server or launch URLs from 
the Web Access Server, you must deploy them. For more information about 
deploying reports and URLs, see Deploying and Undeploying Reports on 
page 284 and Deploying a URL on page 288. 

Using the Web Access Server, you can view any report or URL that has been 
deployed to the system or users folders. 
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When the list of deployed items is displayed in the Web Access Server’s 
catalog, an icon will indicate the type of item it is. Table 20 lists the icons for 
the deployed items.

For a description of the report types, see Report Types on page 16.

Opening a Report or URL

When you view a report or URL, it appears in the results frame of the Web 
Access Server. (Alternately, you can specify that the Web Access Server 
display each report or URL you view in a new Web browser window. For more 
information about setting this preference, see Specifying Viewing Settings on 
page 316.) 

To view deployed items:

1 Click Catalog. The Catalog page appears.

Table 20 Web Access Server — Deployed Item Icons

Item Icon

.srep (dataset) 

.rep (report definition)

URL

To ensure that your reports are formatted correctly when you view them with 
the Web Access Server, set your browser options to refresh each time you visit 
the page. See Setting Browser Options on page 320.

If the users or system folders are empty, you or the Administrator must 
deploy items (reports, URLs, or both) to the Web Access Server. For more 
information about deploying reports and URLS, see Deploying and 
Undeploying Reports on page 284 and Deploying and Undeploying URLs on 
page 288. Only the Administrator can deploy reports and URLs to the system 
folder. Refer to the HP OpenView Performance Insight Administration Guide 
for details.
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2 To view items in the users folder:

a Expand the users folder. 

b Click your user folder. The Deployed Items page displays the deployed 
reports and URLs in your folder. (The same list appears below your 
user folder in the navigation frame.)

For example, the navigation and results frames may look similar to 
the following:

c Click the item you want to view in the navigation frame or on the 
Deployed Items page.

The item will appear in the results frame. 

3 To view items in the system folder:

a Expand the system folder, and then click the system folder.

The Deployed Items page displays the deployed reports grouped by 
report pack and URLs in the system folder.

If the Administrator deployed any report packs to the Web Access 
Server, a folder for each report pack that was deployed appears in the 
system folder. The dataset reports for the report packs are located in 
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the Demo folder. For example, the navigation and results frames may 
look similar to the following if report packs were deployed to the 
system folder:

b Expand any folder in the navigation frame to display its contents, or 
click on any folder to display its contents in the Deployed Items page.

c Click the item you want to view in the navigation frame or on the 
Deployed Items page. The item will appear in the results frame.

On the results frame,  when you select a report, you can also view the Error 

Details by clicking the  icon. The information in the Error Details window 
is as follows:

The Administrator can deploy reports to the users folder as well.

Error During Execution Displays errors, if any, during execution of 
SQL expression.

Number of Rows Displays the number of rows returned by the 
execution of SQL expression.

Query Executed Displays the SQL expression.

Some reports may require that you select nodes/interfaces, a time period, or 
both before you can view them (see Deferred Selections on page 297). 
Additionally, some reports may contain drilldowns (see Drilldowns on 
page 300).
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 Viewing a Report Using a URL

You can view a report by entering a URL in your Web browser. The URL must 
have the following format:

http://hostname/reports/webview?rn=/report_path/
report_name.rep&p_parameter=value&p_parameter=value&ov_user=user
name&cmd=csv 

The syntax for the URL above is as follows:

hostname The name of the Web Access Server followed by the 
servlet path which is always /reports/webview. 
If the port number of the Web Access Server is not 80, 
you must supply the port number after the hostname, 
for example:
http://hostname:8001/reports/webview

? Indicates the start of a list of options for the URL.

rn=/report_path/
report_name.rep

The path of the report relative to the location on the 
Web Access Server where deployed reports reside. You 
only need to specify the report’s path beginning with 
the folder (system or users) in which the report is 
located relative to the deployed reports path. Deployed 
reports reside in the same default directory on both 
UNIX and Windows systems; for example, the default 
directory for Windows is as follows, where 
installation_directoy is the directory into which you 
installed OVPI:
 installation_directoy\reports\deploy
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Ensure that you adhere to the following rules when entering your URL:

• Precede each parameter name with “p_”.

• Separate parameters with the ampersand (&) character.

The following example will display the port_availability.rep report, 
which is located on the system, chaos, for the device numbered 38.201.173.97.

http://chaos/reports/webview?rn=/system/FrameRelay_Service/Port/
port_availability.rep&p_Device=38.201.173.97

Resetting Parameters

When you view a report and supply parameters, the Web browser saves the 
specified parameter settings for that session. Thus, if you went to view the 
same report using different parameters, the report would be displayed with 
both the saved and new parameters. Use the following argument to reset the 
parameters in a browser session: 

resetparams=true 

p_parameter The name of a parameter. This is optional.

ov_user Your username
The ov_user option is only needed if the 
Administrator has set URL authentication. If URL 
authentication is set, your username is required 
whenever you enter a URL. For more information 
about authentication, refer to the HP OpenView 
Performance Insight Administration Guide.

cmd=csv Creates a basic CSV file for just the data you are 
currently viewing. This format will not display 
drilldowns, labels, or graphic objects; however, it will 
show tables, graphs, and tabbed elements. This is 
optional.

hostname The name of the Web Access Server followed by the 
servlet path which is always /reports/webview. 
If the port number of the Web Access Server is not 80, 
you must supply the port number after the hostname, 
for example:
http://hostname:8001/reports/webview
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For example, you would type the following URL if you wanted to view the 
port_availability.rep report on the system chaos for the device numbered 
38.201.173.97:

http://chaos/reports/webview?rn=/system/FrameRelay_Service/Port/
port_availability.rep&p_Device=38.201.173.97 

Suppose you wanted to view the report again for the device numbered 
38.201.173.99 in the same browser session. You would type the following URL:

http://chaos/reports/webview?rn=/system/FrameRelay_Service/Port/
port_availability.rep&resetparams=true&p_Device=38.201.173.99 

Deferred Selections

Occasionally, a report will require you to select certain information (such as 
nodes and interfaces, time periods, or both) before you can view the report. 

For example, a router performance report is an example of a report that may 
require you to enter the following information before you can view the report: 

• The router or routers to report on

• The time period to report on (if the time selection were deferred)

After you supply the information, the report is run based on that information. 
Additionally, you could run the report numerous times using different routers 
and time selections.

A report with a deferred selection will ask you to specify one or both of the 
following:

• Nodes and interfaces. A node can contain multiple interfaces. For 
example, a node may be a Cisco router which has an Ethernet interface 
and a Token Ring interface. You can select a node and all its interfaces or 
you can select only certain interfaces. 

• Time period. A time period is the time range for the report. You can select 
an absolute period (specific dates) or a relative time period (a period of 
time relative to the time you view the report). 

Most reports do not require you to select nodes, interfaces, and time periods.
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Selecting Nodes and Interfaces

If a report has a deferred node/interface selection, the Select Deferred Node 
Mechanism page opens.

To select nodes and interfaces:

1 Select one of the following options:

• Use all nodes/interfaces. Lets you select all nodes and their interfaces. 

• Select nodes and interfaces individually. Lets you select individual nodes 
and interfaces. The Select Nodes/Interfaces page opens. To select a 
node or interface, select the box that appears next to it. 

• Select a group of nodes and interfaces. Lets you select a group of nodes 
and interfaces. The Select Group page opens. Select the group of nodes 
and interfaces you want.

2 Click Submit. 
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Selecting a Time Period

If a report has a deferred time period, the Select Time Period page will appear. 

The following time ranges are available for reports:

• Relative – Sets a variable time period. The relative time selected (for 
example, This week) is converted to absolute times when you view the 
report. For details, see Selecting a Relative Time Period on page 299.

• Absolute – Sets a specific start and end time. For details, see Selecting an 
Absolute Time Period on page 300. 

Selecting a Relative Time Period

To select a relative time period:

1 Click Relative. 

2 Do one of the following:

• To select a current time period, click This time period. Click the time 
period arrow and select an option. For example, if the time period is 
This week, the report displays data for the current week.

• To select a previous time period, click Last n time period. 

Since there will not be data for every time range in the database, the Select 
Time Period page displays only those time ranges that contain data.
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3 Type a number of hours, click the time period arrow, and then select an 
option. For example, if the time period is Last 1 week(s), the report displays 
data for the last full week (Sunday to Sunday) prior to the current date.

4 Select the Until Now check box to display data for selected time period up 
until the current time. For example, suppose it was Thursday, and you 
selected a time period of 1week; your report will display data for the prior 
week (Sunday to Sunday) through Thursday.

Selecting an Absolute Time Period

To select an absolute time period:

1 Click Absolute.

The start and end times represent the range of available data in the 
database. 

2 Enter the start time for the time period in the Start Time box.

3 Enter the end time for the time period in the End Time box.

4 Click Submit.

Drilldowns

When you view a report, some tables and graphs in the report may be linked. 
(For more information about link types and creating links, see Chapter 5, 
Linking Report Elements.) For example, a link can allow a table to display 
summary statistics while the graph it is linked to displays detailed 
information about a particular item from the table. The detailed information 
is referred to as a drilldown. 
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To drill down for data in a table, click on a drill icon next to a table row, for 
example:

The linked graphs are updated with information from the table. 

To drill down for data in a graph, click on a node in the graph, for example:

This action highlights the node name, and then updates all of the graph’s 
linked elements with data for the selected node. 

When drill-down data is not available for specific row in a dataset report, the 

drill icon will appear as follows: 
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Opening Report Links 

In addition to element links that are used to drilldown for data within a 
report, reports can also contain links to other reports, applications, and 
Uniform Resource Locators (URL). 

A report link takes specific information from an element (graph, table, image, 
or label) in a report (the source report), and uses the information as the input 
to a report parameter (in the case of a report to report link) or to an argument 
(in the case of a report to application or URL link). 

When viewing a report using the Web Access Server, any links are treated just 
like a URL; it will display using the same method that your browser used to 
display URLs. 

For example, if your browser underlines URLs, any links in the report will be 
underlined. Additionally, the cursor will change from an arrow to a hand when 
it is placed over a link. 

You cannot open report to application links using the Web Access Server. 
Instead, you must use Report Builder or Report Viewer to open these kinds of 
links. Additionally, the application must reside on the system from which you 
run Report Builder or Report Viewer to successfully invoke the application 
linked to the report.

Report links are created in reports using the Management Console’s Catalog 
Manager application. To use Catalog Manager, you must have an account 
with Administrator privileges. Refer to the HP OpenView Performance Insight 
Administration Guide for more information about using Catalog Manager to 
create links.
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The following figure shows an example of how links may appear in a report:

A report can be the destination for multiple report links. For example, you 
might view a report that displays customers; it contains a report link that 
displays a device report, showing only the devices for a specific customer. In 
addition, you might view another report that displays locations; it contains a 
report link that displays the same device report, showing only the devices for 
a specific location. In this instance, both the customer and location reports 
link to the same destination report, which shows devices. 

Likewise, one report can contain multiple links; for example, one report can be 
linked to any number of reports, URLs, and applications. 

To open a link in a report:

• Click the link in the report. One of the following will occur:

— A report or URL will display in the browser window. 

— The Report Link Selection window opens if the item has more than 
one link associated with it. Click the link you want to open.

By default, the destination of the link (report or URL) displays in the current 
browser window. You can specify that it display in a new browser window; see 
Specifying Viewing Settings on page 316 for details.
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Viewing Items in the History or Favorites Folders

By default, the Web Access Server stores the items (reports and URLs) that 
you view in its History folder. You can also add items that you view 
frequently to the Web Access Server’s Favorites folder.

To view reports in the Report History or Favorites folders:

1 Click Home on the links bar. 

In the navigation frame, the following folders appear:

• History – Contains the last n most-recently opened items during the 
current session, where n is a value you can set. By default, this value 
is 10. For more information about changing the number of items 
included in the History folder, see Specifying the History Folder 
Settings on page 313.

• Favorites – Lists the names of the items you have selected as your 
favorites in the Favorite Items folder. For more information about 
adding items to the Favorite Items folder, see Adding Items to the 
Favorites Items Folder on page 311.

2 To view the items in either folder, do the following:

a Expand the folder to display its contents. (If you expanded the 
Favorites folder, expand the Favorite Items folder to view the 
favorite items.)

b Click the item you want to view in the navigation frame. The item will 
appear in the results frame or a new browser window, depending on 
how you have set this preference for deployed items. For more 
information about setting preferences, see Setting Preferences on 
page 308.

Viewing Elements in Separate Frames

You can display report elements (graphs and tables) in a frame that is 
separate from the Web Access Server’s results frame. Additionally, you can 
control how large the element will be when it appears in the frame. 

To view a report element in a separate frame:

1 Make sure that the Allow Element Editing option on the View Settings 
page is selected. 
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See Specifying Viewing Settings on page 316 for details.

2 Click the Frame button  next to the element.

Modifying Reports

When the Edit button  appears next to an element, you can change any of 
the following attributes for that element:

• Maximum rows. Lets you constrain the amount of data returned and 
displayed by the Web Access Server. The default value is 50 rows of data. 
You can change this if you would like a report that displays more or less 
data. Typically, if you set a large value for maximum rows, the Web Access 
Server displays a graph or a table that will span a larger time range; 
however, when you set a large value for maximum rows, the report will 
require more processing, which may result in a longer delay while the Web 
Access Server transfers and renders the data.

• Constraints. Lets you change the report’s constraints. A constraint 
specifies how the data for a graph or table is retrieved from the database. 
For more information about constraints, see Modifying Constraint Values 
on page 199.

• Time period. Lets you specify a time period for the report. You can select 
an absolute period (specific dates) or a relative time period (a period of 
time relative to the time you view the report). For more information about 
specifying a time range, see Selecting a Time Period on page 299.

• Graph style. Lets you change the style of the graph. Available styles are as 
follows: area, stacking area, bar, stacking bar, pie, plot, and scatter plot.

Editing Graphs and Tables

You can change certain attributes of a graph or a table when you view a 
report. 

You must specify element editing as a report preference in order to modify 
tables and graphs in a report. For more information about setting this 
preference, see Specifying Viewing Settings on page 316.
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To edit a graph or table:

1 Click the Edit button  next to the element in the report you want to 
edit. The Table Edit or Graph Edit page appears. The Graph Edit window 
opens. 

2 Do any of the following:

a In the Max Rows box, type the number of rows of data to display.

b Do one of the following to specify a time range:

— Click Relative.

— Click Absolute.

See Selecting a Time Period on page 299 for details.

c Graphs only: Click the Graph Style arrow, and select a graph style.

3 Click Submit when you have made your changes. The report is updated 
with your changes.

The only difference between the Table Edit and Graph Edit pages is 
that the Graph Edit page allows you to change a graph’s style.
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Modifying Parameter Values

When the Parameter button  appears at the bottom of a report, it means 
that the report contains a parameter or parameters that you can edit.

To change the value of a parameter:

1 Click the Parameter button  at the bottom of the report. The Parameter 
Edit window opens.

2 In the any of the parameter boxes, enter a new value.

3 Click Submit to apply your change.

You cannot change a parameter’s name or type.
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Setting Preferences

Using the Preferences link, you can:

• Change the information in your user profile (name, department, telephone 
number, email address, and password)

• Change the appearance of the Web Access Server. 

• Add reports to the Favorites folder.

• Specify the number of items that will be saved in the History folder.

• Specify several report-viewing settings.

• Specify how often a displayed schedule is refreshed on the screen.

Changing Your User Profile

You can change the information in your user profile (name, department, 
telephone number, email address, and password) by using the Profile or 
Preferences link in the links bar.

To change the information in your user profile:

1 Do one of the following:

• Click Profile in the links bar.

• Click Preferences on the links bar, expand User Profile in the 
navigation frame, and then click User Profile.
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The User Profile for username page opens.

2 Modify the fields you want to change, and then click Apply.

Changing the Appearance of the Web Access Server

You can change the appearance of the Web Access Server using the 
Preferences link. You can change the font, font size, and font color for the links 
bar, navigation frame, and results frame. 

To change the appearance of theWeb Access Server:

1 Click Preferences on the links bar. The Preferences page opens.

2 Expand Site Appearance in the navigation frame.
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3 Click Settings. The Site Appearance Settings page appears.

The Highlighted Font Color option lets you select the color of the links on 
the links bar and the items in the navigation frame when the pointer is 
placed over them; the Regular Font Color is the color of the links or items 
when the pointer is not on them. 
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4 Do any of the following:

a To change a font or font size, click the Font or Font Size arrow to 
display a list of values, and then select a new value. 

b To change font color, do one of the following:

— In the Font Color box, enter an HTML standard color name (aqua, 
black, blue, fuchsia, gray, green, lime, maroon, navy, olive, purple, 
red, silver, teal, yellow, or white) or a hexadecimal color value.

— Click Select Color. The Color Selector window appears, which lets 
you select a color from a palette or enter a specific color value. 
Click OK after you select a color to apply your change and close the 
Color Selector window.

5 After you make the changes you want, click Apply on the Site Appearance 
Settings page.

6 Click your browser’s Refresh button.

Adding Items to the Favorites Items Folder

You can add items (reports and URLs) to the Favorite Items folder in order 
to access the items you view most frequently. 
Using the Web Access Server 311



Adding Items Using the Home Link

To add an item to the Favorite Items folder using the Home link:

1 Click Home on the links bar.

2 Expand Favorites in the Navigation frame.

3 Click Add Favorite. The Add Favorite page opens. 

4 Click Browse. The Browser window opens.

5 Locate the report or URL you want to add to the folder, and click it. The 
Browser window closes.

6 Click Apply on the Add Favorite page.

Adding a Report Using the Favorites Button

You can add the report you are viewing to the Favorites folder by clicking the 
Favorites button  at the bottom of the report.

If you have selected a report that contains parameters, the 
Parameter Edit page opens. You can modify these parameters. See 
Modifying Parameter Values on page 307 for details.
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Specifying the History Folder Settings

The History folder appears in the navigation frame when you click Home on 
the links bar. It contains the last n most-recently opened deployed items 
during the current session. The default is 10. Using the Preferences link, you 
can change the number of items that will be saved and how they will be sorted 
in the folder. 

To change the setting for the History folder:

1 Click Preferences on the links bar. The Preferences page appears.

2 Expand Deployed Items in the navigation frame.

3 Click History. The History Settings page opens. 

4 In the Size box, enter the number of items that Web Access Server should 
keep in the History folder. (The maximum number allowed is 99.)

5 Do one of the following:

• Click Name to sort items by name in the History folder.

• Click Date to sort items by date in the History folder.

6 Click Apply.
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Downloading Reports and Elements to Other Formats

You can download a report page to CSV, .srep (dataset report), and PDF 
formats; you can download a report element (graph or table) to CSV (comma 
separated value) format.

To download a report or report element:

1 Display the report you want to download. 

2 Click the Download button .

For a report page, this button is located at the bottom of the report. For a 
report element (graph or table), this button is located to the right of the 
element.

Depending on what you are download, one of the following dialog boxes 
opens: 

• Report page. The Download Options dialog box opens. 

To download the page:

— Select the format you want (CSV, SREP, or PDF). 

— Select the drilldown depth for the report. See step  on page 224 for 
details about drilldown depth.

— Click OK.

• Report element. The File Download dialog box opens. 

To down load the element:

— Click Save this file to disk. The Save As dialog box opens. Select a 
location for the file, and then click Save.

— Click Open this file from its current location. The file opens in an 
appropriate text-viewing application (for example, Microsoft Excel 
on Windows).

If you want to use TrueType fonts in a PDF file, see Appendix B, 
Using TrueType Fonts in PDF Files for more information about 
how to configure OVPI for TrueType fonts.
314 Chapter 11



Sending a Report URL in Email

You send a report’s URL in email to another user. You must have an SMTP 
mail server to be able to use this feature.

To send a report’s URL in email:

1 Display a report. 

2 Click the Email button .

The Email dialog box opens.

3 Do the following:

a In the To and CC boxes, enter any recipients for the e-mail message.

b In the Subject box, enter the subject for the message.

c In the Message text box, type your message.

The report URL that will be sent is displayed below the Message text 
box.
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4 Click Apply to send the message.

When the message is received, it will appear similar to the following:

Specifying Viewing Settings

You can change many features of the Web Access Server that control how you 
view reports and URLs, modify reports, and limit the report data that is 
displayed. 

To specify viewing settings:

1 Click Preferences on the links bar. The Preferences page appears.

2 Expand Deployed Items in the navigation frame.

3 Click View. 
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The View Settings page opens. 

4 Do any of the following: 

a Select Allow Add to Favorites within Report to display the Favorites 
button when you view a report. This is enabled by default. See Adding 
a Report Using the Favorites Button on page 312 for more 
information. 

b Select Allow Downloads to display the Download button when a report 
is viewed. See Downloading Reports and Elements to Other Formats 
on page 314 for more information.

c Select Allow Parameter Editing to be able to change the parameter 
value for a report. For more information on modifying parameter 
values, see Modifying Parameter Values on page 307. 

d Select the Open in new Browser box to display any report or URL that 
you open in a new browser windows.
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e Select the Allow Element Editing box to be able to change certain 
attributes of a table or graph when you view a report. This is enabled 
by default.See Modifying Reports on page 305 for more information.

f Select the Allow Element Query Info box to enable the Error Details 
button when you view a report.

g Select the Allow Viewing Element in New Frame box to display a report’s 
graphs and tables in new frames.

h Select Place Drilldown Icon on the Right to place the drill-down icon to 
the right of a table. This is enabled by default.

i Select Center Reports to center the report in the results frame. This is 
enabled by default.

j Select Enable Report Polling to access the latest data for a report. Enter 
the time interval for this period in the Report Polling Interval box.

k Select Enable Report Emailing to allow users to send report URLs to 
other users in email messages.

l Select Selection Color Overrides Rule Color to change the 
background color of table cells. You can select a cell background color 
for the table in the table’s Selected Cell Background property; by 
default, this is yellow. For more information on overriding a rules Cell 
Background Property, see Overriding a Rule’s Cell Background 
Property on page 124

m Type the maximum number of deferred nodes that you want to appear 
in the Select Nodes/Interfaces page in the Maximum Deferred Node 
Rows Per Page box. For more information about deferred node 
selection, see Deferred Selections on page 297.

n Type the zoom factor for graphs and table elements when they are 
displayed in a new frame in the Graph Element Zoom Factor and 
Table Element Zoom Factor boxes, respectively. 

For example, a zoom factor of 1 displays the element at the same size 
as it appears in the results frame of the Web Access Server; a zoom 
factor of 3 displays the element at three times that size.

o In the Report Border Size box, enter the size (pixels) for report 
borders. 

p In the Report Border Color box, do one of the following:
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— Enter an HTML standard color name (aqua, black, blue, fuchsia, 
gray, green, lime, maroon, navy, olive, purple, red, silver, teal, 
yellow, or white) or a hexadecimal color value.

— Click Select Color.The Color Selector window appears, which lets 
you select a color from a palette or enter a specific color value. 
Click OK after you select a color to apply your change and close the 
Color Selector window.

5 In the Report Polling Interval box, enter the interval (minutes) at which a 
report should access the latest data from the database. 

6 Click Apply.

Specifying a Schedule Refresh Time

To specify how often a displayed schedule is refreshed on the screen:

1 Click Preferences on the links bar. The Preferences page appears.

2 Expand Scheduler in the navigation frame.

3 Click Settings. The Scheduler Settings page opens.

4 Enter the interval (number of seconds) at which the schedule should 
refresh on the screen in the Seconds box. This value must be numeric, and 
the maximum number of seconds is 999.

5 Click Apply.

This is a floating-point value; therefore, you can enter half-minute 
intervals (0.5). The default value is 15 minutes.
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Setting Browser Options

To ensure that your reports are formatted correctly when you view them with 
the Web Access Server, your browser must refresh the display each time you 
access the report. 

If you use Microsoft Internet Explorer, perform the following steps:

1 From your Internet Explorer browser, select Internet Options from the Tools 
menu.

2 In the Temporary Internet Files section of the General page, click Settings.

3 Select Every visit to the page and click OK.

4 Click OK again.

If you use Netscape Navigator, perform the following steps:

1 From your Netscape Navigator browser, select Preferences from the Edit 
menu.

2 Expand the Advanced item in the Category list.

3 Click Cache.

4 In the cache options, select Every time I view the page.

5 Click OK.

Logging Off of the Web Access Server

To log off of the Web Access Server, click Log off username, which is located 
above the links bar. 

You must close all of your open browser windows to completely log off of the 
Web Access Server.
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A Element Properties
The appendix lists all of the report properties that are available when you use 
Report Builder. Each entry describes the function of the property, to what 
elements it applies, its available value or values, and any special information 
about its use.

Alias

Description: The alternate name for a table column.

Location: Graph or Table  Data  Query  Statistics, Graph or Table  
 Data  Query  Selected Statistics, Graph  Overlay Data  Query  
 Selected Statistics   Overlay Statistic

Values: This is a user-specified text value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None
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Allow Column Resize 

Allowable Drilldowns

Anchor

Description: Lets you resize the columns of a table in the Report 
window.

Location: Table  Column Properties

Values: True, False

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: See Resizing Table Columns on page 159.

Description: The number of queries to the database allowed when 
elements in a report are linked.

Location: Table, Graph

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: See Specifying a Drill-Down Depth 
Constraint on page 219.

Description: Changes the location of the legend area in the graph. (See 
also Visible.)

Location: Graph  Legend Area

Values: None, North, South, East, West, NorthEast, NorthWest, 
SouthEast, SouthWest

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: See Repositioning Legends on page 144 for 
details.
322 Appendix A



Annotation Font

Annotation Font Bold

Annotation Font Italic

Description: Lets you change the font of the annotation text that 
appears on the x-axis and y-axis of a graph.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis, 
Graph  Properties  Overlay Properties  Y Axis Overlay

Values: There are numerous font types available.

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: None

Description: Lets you change the weight of the annotation text that 
appears on the axis of a graph.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis, 
Graph  Properties  Overlay Properties  Y Axis Overlay

Values: True, False

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: None

Description: Lets you change the emphasis of the annotation text that 
appears on the axis of a graph.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis, 
Graph  Properties  Overlay Properties  Y Axis Overlay

Values: True, False

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: None
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Annotation Font Size

Annotation Rotation

Background

Description: Lets you change the font size of the annotation text that 
appears on the axis of a graph.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis, 
Graph  Properties  Overlay Properties  Y Axis Overlay

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you rotates a graph’s annotation on the x-axis.

Location: Graph  Properties  X Axis

Values: No Rotation, Rotate 270, Rotate 180, Rotate 90

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: None

Description: Lets you set the background color of the element.

Location: Report, Table, Graph, Form, Graph  Legend Area, Graph  
Chart Area, Table  Row Properties, Table  Column Properties

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: See Using the Components Window on 
page 134.
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Bold

Border Style

Border Thickness

Description: Lets you apply boldface to a text element.

Location: Graph or Table a tab_name, Graph a Title Area a Title Line x, 
Graph a Legend Area, Table a Row Properties, Table a Column 
Properties

Values: True, False

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: None

Description: Lets you select the border style of an element.

Location: Table or Graph  Title Area, Table  Row Properties, Table 
 Column Properties, Table  Row Properties, Table  Cell Properties, 

Graph  Legend Area, Graph  Chart Area, Graph  Properties  Y 
Axis  GOS Labels

Values: None, Plain, Etched In, Etched Out, Frame In, Frame Out, 
Shadow In, Shadow Out

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: See Using the Components Window on 
page 134.

Description: Lets you select the thickness of the shadow around the 
element.

Location: Table or Graph  Title Area, Table  Row Properties, Table 
 Column Properties, Table  Cell Properties, Graph  Legend Area, 

Graph  Chart Area, Graph  Properties  Y Axis  GOS Labels

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: See Using the Components Window on 
page 134.
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Cell Border Style

Cell Border Thickness

Column Name

Description: Lets you select a table cell’s border style.

Location: Table  Title Area  Cell Properties

Values: None, Plain, Etched In, Etched Out, Frame In, Frame Out, 
Shadow In, Shadow Out

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: None

Description: Lets you select the width of a cell’s border style.

Location: Table  Title Area  Cell Properties

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you view the name of a statistic’s column in the 
database.

Location: Graph or Table  Data  Query   Statistics  
statistic_name, Graph or Table  Data  Query   Selected Statistics  
statistic_name, Graph  Overlay Data  Query  Selected Statistic  
Overlay Statistic

Values: You cannot edit this value.

Usage: None

Documentation Reference: None
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Column Width

Columns

Comment

Description: Lets you control the width of a column assigned to a 
selected statistic.

Location: Table  Data  Query   Selected Statistics  
statistic_name

Values: This is a user-specified numeric value.

Usage: Click the Value box next to the property, and type a value.

Documentation Reference: None

Description: Lets you adjust the size of the columns in the legend area 
of a graph.

Location: Graph  Legend Area

Values: This is a user-specified numeric value.

Usage: A value of -1 specifies that the graph automatically adjust the 
columns as it sees fit. To change the value, click in the Value box, and 
type a value.

Documentation Reference: None

Description: Lets you supply a description for a report or form.

Location: Report, Form

Values: This is a user-specified text value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None
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Created

Default to No Constraints Option

Deferred

Description: Lets you view the date and time at which the report or 
form was created.

Location: Report, Form

Values: This is a system-supplied timestamp.

Usage: You cannot edit this value.

Documentation Reference: None

Description: Lets you specify that the Enable No Constraints option 
will always be selected instead of the first row of data when opening a 
report. 

Location: Combo Box

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: See Adding a Combination Box (Combo 
Box) on page 59 for details.

Description: Lets you specify if the time period for the element will be 
selected by the user when the report is opened.

Location: Graph  Data  Query   Time Period

Values: True, False

Usage: Click the Value box next to the property, and the select a value 
from the list.

Documentation Reference: See Creating Reports with Deferred 
Selections on page 162.
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Deferred Node

Depth 

Description

Description: Lets you specify if the nodes and interfaces for the element 
will be selected by the user when the report is opened.

Location: Graph  Data  Query

Values: True, False

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: See Creating Reports with Deferred 
Selections on page 162.

Description: Lets you increase a graph’s depth, which makes the 
graph’s x-axis wider.

Location: Graph  Chart Area

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: See Changing Rotation, Elevation and 
Depth on page 151 for details.

Description: Lets you specify a description for the element.

Location: Combo Box, Table, Graph, Tab, Links  link_name

Values: This is a user-specified text value.

Usage: You can enter a description when you use the wizard that creates 
the element. A description is optional.

Documentation Reference: None
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Destination

Destination Data Index

Destination Element

Description: Lets you view the destination statistic for a link’s 
constraint.

Location: Links  link_name  link_constraint

Values: You cannot edit the value for this property.

Usage: You specify the statistic when you use the Link wizard.

Documentation Reference: See step 5 on page 176 in the Linking 
Elements section for details.

Description: Indicates whether the link is to the main graph or the 
overlay.

Location: Links  link_name

Values: You cannot edit the value for this property.

Usage: You specify the value when you use the Link wizard.

Documentation Reference: See Linking Elements on page 171 for 
details.

Description: Lets you view the number of the element that is the 
destination object of a link.

Location: Links  link_name

Values: You cannot edit the value for this property.

Usage: You specify the destination element when you use the Link 
wizard.

Documentation Reference: See Chapter 5, Linking Report Elements 
for details.
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Distinct

Enable No Constraints Option

Elevation

Description: Indicates whether the generated SQL query is a SELECT 
DISTINCT

Location: Graph or Table  Data  Query

Values: True, False

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: None

Description: Lets you display a label (for example, “All Devices”, which 
will appear as the first option in a combination box. This option will 
choose data from the destination element without applying any 
constraints.

Location: Combo Box

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: See Adding a Combination Box (Combo 
Box) on page 59 for details.

Description: Lets you increase a graph’s elevation, which creates the 
effect of looking down on the graph.

Location: Graph  Chart Area

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and enter a value.

Documentation Reference: See Changing Rotation, Elevation and 
Depth on page 151 for details.
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End Time

File Name

Fill Color 

Description: Lets you specify the end of the time range for a query.

Location: Graph or Table  Data  Query  Time Period

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box to display the Edit Date Value 
dialog box, and then edit the value displayed or click the arrow button to 
display the Calendar dialog box.

Documentation Reference: See Step 11 on page 72.

Description: Lets you specify the file name of an image.

Location: Image

Values: This is a user-specified text value.

Usage: Click the property’s Value box, and type a file name.

Documentation Reference: See Adding Images on page 54 for details.

Description: Lets you select the color that will fill the representation of 
the statistic in a graph or table.

Location: Graph or Table  Data  Query  Selected Statistics

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: See Changing Element Properties on 
page 133 for details.
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Fill Pattern 

Font Name

Font Size

Description: Lets you select the pattern that will fill the representation 
of the statistic in a graph or table.

Location: Graph or Table  Data  Query  Selected Statistics

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: See Changing Element Properties on 
page 133 for details.

Description: Lets you select a font style.

Location: Tab, Table  Title Area  Title Line x, Graph  Legend Area, 
Table  Row Properties, Table  Column Properties

Values: There are numerous font types available.

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: None

Description: Lets you select a font size.

Location: Tab, Table  Title Area  Title Line x, Graph  Legend Area, 
Table  Row Properties, Table  Column Properties

Values: This is a user-specified text value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None
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Foreground

Format

Description: Lets you select the foreground color of an element.

Location: Combo Box, Table, Tab, Graph, Graph  Legend Area, Table 
 Title Area  Title Line x, Graph  Chart Area, Table  Row 

Properties, Table  Column Properties

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: See Using the Components Window on 
page 134

Description: Lets you specifies any variables that you want to use in a 
graph’s legend text.

Location: Graph  Legend Area

Values: $C$, $D$, $E$, $M$, $N$, $S$, $T$

Usage: Click the property’s Value box, and enter a variable, text, or a 
combination of both. For example, if you enter “Exception Counts for 
$M$”, the legend text would appear as “Exception Counts for 
99.3.229.80".

Documentation Reference: See Using Variables in Titles and Legends 
on page 150.
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GoS Weight

Graph By

Graph Style

Description: Lets you set the value for the statistic, which is needed to 
calculate its weighted average if the statistic belongs to a Grade of 
Service (GOS) graph.

Location: Graph  Data  Query  Selected Statistics

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and enter a value.

Documentation Reference: See Creating a GOS Graph on page 80 for 
details.

Description: Lets you view whether the graph’s data is graphed by time 
or by node.

Location: Graph  Properties

Values: You cannot edit the value.

Usage: You specify this value when using the Graph wizard.

Documentation Reference: None

Description: Lets you specify the style of a graph.

Location: Graph  Properties

Values: Plot, Scatter Plot, Hi-Lo, Hi-Lo-Open-Close, Candle, Area, Bar, 
Stacking Bar, Pie, Stacking Area

Usage: Click the property’s Value box, and select a value from the list.

Documentation Reference: See Task 4 in the Adding a Graph section 
for details.
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Grids

Header Alignment

Height

Description: Lets you adds grid lines to a graph.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis

Values: This is a user-specified numeric value.

Usage: None

Documentation Reference: See Displaying Grid Lines on page 143.

Description: Lets you position the heading name of a selected statistic 
in a table column.

Location: Table  Data  Query  Selected Statistics

Values: Top Left, Top Center, Top Right, Middle Left, Middle Center, 
Middle Right, Bottom Left, Bottom Center, Bottom Right

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: The height of the image.

Location: Label, Image, Circle, Rectangle, Report, Combo Box, Table, 
Tab, Form, Graph

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and enter a value.

Documentation Reference: None
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Hole Mark

Hole Mark Color 

Hole Mark in Legend

Description: Lets you select a visual cue for missing data in a graph.

Location: Graph  Properties

Values: None, Bar, and Symbol

Usage: Click the property’s Value box, and select a value.

Documentation Reference: See Displaying Missing Graph Data on 
page 156. 

Description: Lets you select the color of a Hole Mark.

Location: Graph  Properties

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: See Using the Components Window on 
page 134 and Displaying Missing Graph Data on page 156.

Description: Lets you select whether the missing data is shown in the 
graph’s legend.

Location: Graph  Properties

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: See Displaying Missing Graph Data on 
page 156.
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Hole Mark Legend Label

Hole Mark Shape

Hole Mark Size

Description: Lets you select the text that represents the missing data in 
the legend when Hole Mark in Legend is set to true.

Location: Graph  Properties

Values: This is a user-specified text.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: See Displaying Missing Graph Data on 
page 156.

Description: Lets you select the shape of a symbol when symbol is 
selected as the Hole Mark.

Location: Graph  Properties

Values: None, Dot, Box, Triangle, Diamond, Star, Vertical Line, 
Horizontal Line, Cross, Circle, Square

Usage: Click the property’s Value box, and select a value.

Documentation Reference: See Displaying Missing Graph Data on 
page 156.

Description: Lets you select the size of a symbol when symbol is selected 
as the Hole Style.

Location: Graph  Properties

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and enter a value.

Documentation Reference: See Displaying Missing Graph Data on 
page 156.
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Hole Style

Italic 

Join Operator

Description: Lets you select how missing data is represented.

Location: Graph  Properties

Values: Not Plotted, Interpolation, Last Value, Zero

Usage: Click the property’s Value box, and select a value.

Documentation Reference: See Displaying Missing Graph Data on 
page 156.

Description: Lets you apply italic text.

Location: Tab, Title Line x, Legend Area, Row Properties, Column 
Properties

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Indicates whether the child nodes of the current node are 
to be ANDed or ORed.

Location: Query, Constraint List

Values: AND, OR

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
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Label

Label Background

Label Font

Description: Lets you create a description for an element.

Location: Graph  Data  Query  Selected Statistics  
statistic_name, Graph  Data  Query  Statistic  statistic_name, 
Graph  Properties  X Axis, Graph  Properties  Y Axis, Graph  
Data  Query  Constraint List  constraint_name 

Values: This is a user-specified text value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you specify a background color for the x- or y-axis 
label.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis

Values: This is a user-specified value.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: None

Description: Lets you specify the font for the x- or y-axis label.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis

Values: This is a user-specified value.

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
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Label Font Bold

Label Font Size

Label Font Italic

Description: Lets you specify whether the font for the x- or y-axis label 
is bold.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify the font size (points) for the x- or y-axis 
label.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify whether the font for the x- or y-axis label 
is italic.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
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Label Foreground

Label Placement

Label Rotation

Description: Lets you specify the foreground text color for the x- or 
y-axis label.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: None

Description: Lets you specify whether the x- or y-axis label should be 
placed in relation to the graph.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis

Values: None, North, South, West, East, NorthEast, NorthWest, 
SouthEast, SouthWest

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify how the x or y-axis label should be 
rotated.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis

Values: No Rotation, Rotate 90, Rotate 180, Rotate 270

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
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Last Modified

Left Hand Side

Legend Orientation

Description: Lets you view the date and time at which the report or 
form was last modified.

Location: Report, Form

Values: This is a system-supplied timestamp.

Usage: None

Documentation Reference: None

Description: Lets you specify the statistic that appears to the left of the 
operator in a constraint statement.

Location: Graph  Query  Constraint List  constraint_name

Values: You can select from a list of available constraints.

Usage: Click the property’s Value box, and select a statistic from the list.

Documentation Reference: See Creating a Constraint on page 196.

Description: Lets you specify the location of the legend in relation to the 
graph’s location.

Location: Graph  Legend Area

Values: None, North, South, East, West, NorthEast, NorthWest, 
SouthEast, SouthWest

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
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Length

Line Color

Line Pattern

Description: Lets you change the length of time for the type of time 
period used.

Location: Graph or Table  Data  Query   Time Period

Values: This is a user-specified numeric value.

Usage: Click the Value box next to the property, and type a value.

Documentation Reference: See Selecting a Time Period on page 194.

Description: Lets you specify the line color used to represent the 
statistic in a plot graph.

Location: Graph  Data  Query  Selected Statistics  
statistic_name

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: None

Description: Lets you specify the line pattern used to represent a line in 
a plot graph.

Location: Graph  Data  Query  Selected Statistics  
statistic_name

Values: None, Solid, Long Dash, Short Dash, Long Short Dash, Dash Dot

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
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Line Width

Link Type

Linked Row

Description: Lets you select the width of a line in a plot graph.

Location: Graph  Data  Query  Selected Statistics  
statistic_name

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you specify if the link is one of the predefined link 
types or a custom link.

Location: Links  link_name

Values: Key ID, Target Name, Custom

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify which row in the link source is used to 
select data on the target node.

Location: Links  link_name

Values: This is a system-supplied value.

Usage: None

Documentation Reference: None
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Logarithmic

Margin Height

Margin Width

Description: Converts annotation values to logarithmic values.

Location: Graph  Properties  Y Axis

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify the empty space, in pixels, between the 
rows of a table.

Location: Table  Cell Properties

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you specify the empty space, in pixels, between the 
columns of a table.

Location: Table  Cell Properties

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None
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Maximum Rows

Maximum Value

Minimum Value

Description: Lets you specify the maximum number of rows to be 
returned from the query.

Location: Table or Graph  Data  Query

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Sets the maximum value of the y-axis.

Location: Graph  Properties  Y Axis

Values: autoselect or numeric

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Sets the minimum value of the y-axis.

Location: Graph  Properties  Y Axis

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None
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Mode

Multiline Column Labels

Name

Description: Lets you specify whether the form will create or modify 
entries in the database.

Location: Form

Values: Create, Modify

Usage: Click the property’s Value box, and then select a value from the 
list.

Documentation Reference: See Creating a Form on page 249 for 
details.

Description: Lets you specify if long column labels should wrap to 
multiple lines.

Location: Table  Column Properties

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you change the name of an element.

Location: Report, Form, Combo Box, Table, Tab, Graph, Links  
link_name

Values: This is a user-specified text value.

Usage: You can enter a name when you use the wizard that creates the 
element. A name is optional.

Documentation Reference: None
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No Constraints Label

Number of Fixed Columns

Operator

Description: Lets you specify a label (for example, “All Devices”, which 
will appear as the first option in a combination box. This option will 
choose data from the destination element without applying any 
constraints.

Location: Combo Box

Values: True, False

Usage: Click the property’s Value box, and type a label.

Documentation Reference: See Adding a Combination Box (Combo 
Box) on page 59 for details.

Description: Lets you specify the number of columns that are fixed.

Location: Table  Column Properties

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you specify or view an operator for a constraint 
expression.

Location: Graph  Query  Constraint List  constraint_name, Links 
 link_name  link_constraint

Values: =, >=, >, <=, <, !=, NONE, LIKE, NOT LIKE

Usage: Click the property’s Value box, and select a statistic from the list.

Documentation Reference: See Creating a Constraint on page 196 and 
step 5 on page 176 in the Linking Elements section for details.
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Paragraph Alignment

Placement

Point Color

Description: Lets you specify how the text of the paragraph should be 
aligned.

Location: Label

Values: Left, Center, Right, Justified

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you control the placement of the x- or y-axis.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis

Values: Bottom, Top (x-axis); Left, Right (y-axis)

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify the symbol for a statistic in a scatter plot 
graph.

Location: Graph  Data  Query  Selected Statistic  statistic_name

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: None
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Point Shape

Point Size

Precision

Description: Lets you specify the shape of the symbol for a statistic in a 
scatter plot graph.

Location: Graph  Data  Query  Selected Statistic  statistic_name

Values: None, Dot, Box, Triangle, Diamond, Star, Vertical Line, 
Horizontal Line

Usage: Click the property’s Value box, and select a value. 

Documentation Reference: None

Description: Lets you specify the size of the point for a statistic in a 
scatter plot graph.

Location: Graph  Data  Query  Selected Statistic  statistic_name

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you specify how many places will display after the 
decimal point.

Location: Graph  Properties  Y Axis

Values: This is a user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None
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Property Table Name

Right Hand Side

Rotation

Description: Lets you view the property table name of the table that 
was used to create the element.

Location: Graph  Query, Table  Query

Values: You cannot edit the value.

Usage: None

Documentation Reference: None

Description: Lets you specify the value that appears to the right of the 
operator in a constraint statement.

Location: Graph  Query  Constraint List  constraint_name

Values: This is a user-specified text or numeric value.

Usage: Click the property’s Value box, and type a value.

Documentation Reference: See Creating Constraints on page 195.

Description: Lets you increase a graph’s rotation, which creates the 
effect as if you moved to the right of the graph.

Location: 

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box, and enter a value.

Documentation Reference: See Changing Rotation, Elevation and 
Depth on page 151 for details.
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Row Color 1

Row Color 2

Rows

Description: Lets you specify the color for the first row of the table and 
every alternating row after it. For example, this affects the first row, the 
third row, the fifth row, and so on.

Location: Table  Row Properties

Values: There are numerous colors available from the Select a Color 
dialog box. If you do not set a color, the default color is the background 
color of the table.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: None

Description: Lets you specify the color for the second row of the table 
and every alternating row after it. For example, this affects the second 
row, the fourth row, the sixth row, and so on.

Location: Table  Row Properties

Values: There are numerous colors available from the Select a Color 
dialog box. If you do not set a color, the default color is the background 
color of the table.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: None

Description: Lets you adjust the size of the rows in the legend area of a 
graph.

Location: Graph  Legend Area

Values: This is a user-specified numeric value. A value of -1 specifies that 
the graph automatically adjust the rows as it sees fit.

Usage: Click the property’s Value box, and enter a value.

Documentation Reference: None
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Scaling Factor

Selected Cell Background

Selected Cell Foreground

Description: Lets you scale large numbers.

Location: Graph  Properties  Y Axis

Values: None, Kilo, Mega, Tera

Usage: Click the property’s Value box, and select a value. For example, to 
scale 1,000,000 to 1000K, select Kilo.

Documentation Reference: None

Description: Lets you select the background color for cells on the 
selected row of a table.

Location: Table  Cell Properties

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: None

Description: Lets you select the foreground (text) color for cells in the 
selected row of a table.

Location: Table  Cell Properties

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: None
354 Appendix A



Show Cell Bottom Border

Show Cell Left Border

Show Cell Right Border

Description: Lets you specify whether the bottom border of the table cell 
should display.

Location: Table  Cell Properties

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify whether the left border of the table cell 
should display.

Location: Table  Cell Properties

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify whether the right border of the table cell 
should display.

Location: Table  Cell Properties

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
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Show Cell Top Border

Show Column Labels

Show Row Labels

Description: Lets you specify whether the top border of the table cell 
should display.

Location: Table  Cell Properties

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify whether a table’s column headings should 
display.

Location: Table  Column Properties

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify whether a table’s row numbers should 
display.

Location: Table  Row Properties

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
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Source

Source Element

SQL Expression

Description: Lets you view the source statistic for a link’s constraint.

Location: Links  link_name  link_constraint

Values: You can select from the database’s available list of statistics. 

Usage: You specify the statistic when you use the Link wizard.

Documentation Reference: See step 5 on page 176 in the Linking 
Elements section for details.

Description: Lets you view the number of the element that is the source 
element for the link.

Location: Links  link_name

Values: You can select from the database’s available list of statistics.

Usage: You specify the source element when you use the Link wizard.

Documentation Reference: See step 5 on page 176 in the Linking 
Elements section for details.

Description: Lets you specify an SQL expression for a custom 
constraint.

Location: Links  link_name  link_constraint

Values: This is a user-specified value.

Usage: To edit this value, click on the property’s Value box, and edit the 
expression in the Custom Constraint SQL Expression dialog box.

Documentation Reference: See Creating a Custom Constraint on 
page 197 for details.
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Start Time

Tab Label

Table Name

Description: Lets you specify the start of the time range for a query.

Location: Graph or Table  Data  Query  Time Period

Values: This is a user-specified numeric value.

Usage: Click the property’s Value box to display the Edit Date Value 
dialog box, and then edit the value displayed or click the arrow button to 
display the Calendar dialog box.

Documentation Reference: See Step 13 on page 74.

Description: Lets you specify whether the label will display on a tab.

Location: Tab  Graph or Table

Values: A user-specified string

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you view the name of table used to create the element.

Location: Graph  Query, Table  Query

Values: You cannot edit this value.

Usage: None

Documentation Reference: None
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Table Type

Text

Text Alignment

Description: Lets you view the type of the table used to create the 
element.

Location: Graph  Query, Table  Query

Values: You cannot edit the value.

Usage: None

Documentation Reference: None

Description: Lets you specify the text for a label.

Location: Label

Values: A user-specified string

Usage: Click the property’s Value box to display the Label Text dialog 
box, and type a value.

Documentation Reference: None

Description: Lets you position the text below a selected statistic’s 
heading in a table column.

Location: Table  Data  Query  Selected Statistics  statistic_name

Values: Top Left, Top Center, Top Right, Middle Left, Middle Center, 
Middle Right, Bottom Left, Bottom Center, Bottom Right

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
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Text Bold

Text Color

Text Date Format

Description: Lets you specify whether or not the statistic name in a 
table should be bold.

Location: Table  Data  Query  Selected Statistics  statistic_name

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify the foreground color for a statistic’s name 
in a table.

Location: Table  Data  Query  Selected Statistics  statistic_name

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: None

Description: Lets you specify the format of a date for a selected statistic.

Location: Table  Data  Query  Selected Statistics  Statistic 
Name

Values: A Java DateFormat format string

Usage: Click the property’s Value box to display the Edit the Date 
Format dialog box, and enter a value or select a value from the list.

Documentation Reference: See Changing the Date or Time Format of 
a Statistic on page 161 for the available date formats.
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Text Font Name

Text Font Size 

Text Italic

Description: Lets you specify the font for a statistic’s name in a table

Location: Table  Data  Query  Selected Statistics  Statistic 
Name

Values: There are numerous font types available.

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify the font size for a statistic’s name in a 
table.

Location: Table  Data  Query  Selected Statistics  Statistic 
Name

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you specify italic text for a statistic’s name in a table.

Location: Table  Data  Query  Selected Statistics  Statistic 
Name

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
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Text Precision

Ticks

Time Format

Description: Lets you specify the number of fractional digits to display.

Location: Table  Data  Query  Selected Statistics  Statistic 
Name

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you specify the number of tick marks that you want to 
display on the x- or y-axis.

Location: Graph  Properties  X Axis, Graph  Properties  Y Axis

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you specify a time format for the x-axis.

Location: Graph  Properties  X Axis

Values: A Java DateFormat format string

Usage: Click the property’s Value box and type a time format. 

Documentation Reference: See Changing the Date or Time Format of 
a Statistic on page 161 for the available time formats.
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Time Period

Time Range Type

Title Background

Description: Lets you change the type of time period used.

Location: Graph  Data  Query   Time Period

Values: This Hour, Today, This Week, This Month, This Year, Hour(s), 
Day(s), Week(s), Month(s), Year(s)

Usage: Click the Value box next to the property, and select a value from 
the list.

Documentation Reference: See Selecting a Time Period on page 194.

Description: Lets you view the type of time period (relative or absolute) 
applied to the element’s data selection.

Location: Graph  Data  Query   Time Period

Values: True, False

Usage: You can only view the current value. To change the value, 
right-click on the element in the report, and select Set Time Period from 
the shortcut menu.

Documentation Reference: See Selecting a Time Period on page 194.

Description: Lets you specify the background color for the title area in a 
graph or table.

Location: Table or Graph  Title Area

Values: There are numerous colors available from the Select a Color 
dialog box.

Usage: Click the property’s Value box to display the Select a Color dialog 
box.

Documentation Reference: None
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Title Text

Underline

Until Now

Description: Lets you specify the text for one line of the title area.

Location: Table or Graph  Title Area  Title Line x

Values: A user-specified string

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Lets you specify whether the text of the label should be 
underlined.

Location: Label

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify if the time period will display data for 
selected time period up until the current time. 

Location: Graph  Data  Query   Time Period

Values: True, False

Usage: Click the Value box next to the property, and select a value from 
the list.

Documentation Reference: See Selecting a Time Period on page 194.
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Update Statement

Use Autoscaling

Use Title

Description: Lets you specify the SQL statement used to update a form.

Location: Form

Values: This is a user-specified text value.

Usage: Click the property’s Value box to display the Edit Update 
Statement dialog box.

Documentation Reference: None

Description: Scales an annotation.

Location: Graph  Properties  Y Axis

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify whether the text of the title line will 
display.

Location: Table or Graph  Title Line x

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
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Use main time period in overlay

Use new Y axis in overlay

Use source time period in overlay

Description: Lets you specify if the overlay graph will use the main 
graph’s time period.

Location: Graph  Overlay Properties

Values: True, False

Usage: None

Documentation Reference: See Changing Overlay Properties Using 
the Components Window on page 142.

Description: Lets you specify if the overlay graph will use a new y-axis.

Location: Graph  Overlay Properties

Values: True, False

Usage: None

Documentation Reference: See Changing Overlay Properties Using 
the Components Window on page 142.

Description: Lets you specify if the overlay graph (the destination 
object) will use the source object’s time period.

Location: Graph  Overlay Properties

Values: True, False

Usage: None

Documentation Reference: See Changing Overlay Properties Using 
the Components Window on page 142. For more information about source 
and destination objects, see Chapter 5, Linking Report Elements.
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Use Overlay

Use Source Time Period

Visible

Description: Lets you specify if the graph has a second graph overlaid 
on top of it.

Location: Graph

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you specify if the graph or table takes its effective 
time period from the source of the link to graph or the table.

Location: Table, Graph, Link n

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None

Description: Lets you display or hide the legend area of a graph. See 
also Anchor.

Location: Selected Statistics, Chart Area, Legend Area

Values: True, False

Usage: Click the property’s Value box, and select a value.

Documentation Reference: None
Element Properties 367



Width

X

X1

Description: Lets you specify the width of the element. 

Location: Label, Image, Circle, Rectangle, Report, Combo Box, Table, 
Tab, Form, Graph

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Together with Y, this lets you specify the location of the 
upper left corner of any element.

Location: Label, Image, Circle, Rectangle, Combo Box, Table, Graph, 
Tab

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Together with Y1, this lets you specify the starting point of 
a line.

Location: Line

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None
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X2

Y

Y1

Description: Together with Y2, this lets you specify the ending point of a 
line.

Location: Line

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Together with X, this lets you specify the location of the 
upper left corner of any element.

Location: Label, Image, Circle, Rectangle, Combo Box, Table, Tab

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None

Description: Together with X1, this lets you specify the starting point of 
a line.

Location: Line

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None
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Y2

Description: Together with X2, this lets you specify the ending point of a 
line.

Location: Line

Values: A user-specified numeric value

Usage: Click the property’s Value box, and type a value.

Documentation Reference: None
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B Using TrueType Fonts in PDF Files
When using Report Builder, Report Viewer, or the Web Access Server, you are 
able to export reports and generate reports to PDF files. If you want to use 
TrueType fonts in these PDF files, you must configure OVPI to do so before 
you can generate the PDF file. For example, you want to use TrueType fonts 
when using languages, like Chinese and Japanese, that use non-ASCII 
characters.

To use configure OVPI to use TrueType fonts in a PDF file: 

1 Edit the fonts.cfg file, which is located in the data folder of the 
directory into which you installed OVPI. 

2 Change the value of the following line to match the TrueType font 
directory on your system. 

truetype.font.dirs=c:\\windows\\fonts 

On Windows, this is typically c:\windows\fonts.

3 Save the fonts.cfg file.

4 Edit the fonts.prp file, which is located in the data folder of directory 
into which you installed OVPI. This file contains the mappings between 
the Java font names and the TrueType font names.

5 Create an entry in the file for each TrueType font that you have installed 
and want to use in your PDF files. 

Create the entry using the following format:

Java_font_name=TrueType_font_name 

For example, to use the SimHei and SimHei-Bold fonts, you would add the 
following entries:

The value of this entry on Windows system will require two 
backslashes before the directory name to ensure that the first 
backslash is read as the backslash character.
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SimHei=SimHei 
SimHei-Bold=SimHei 

6 Save the fonts.prp file.

7 To use the font in reports, you must explicitly assign the font to the report 
elements. 

This applies to title fonts, statistic fonts, and so on. By default, the 
elements you create in your reports will use the serif and sansserif fonts. 

For example, to use SimHei as the font for the first title line of a table, 
expand the table’s folder in Builder’s components tree, expand the Title 
Area folder, and then select Title Line 1. Click the Font Name value box, 
and select SimHei from the list of font names. 

8 Deploy the modified report to the Web Access Server using the 
Deployment Wizard. See Deploying a Report on page 238 for more 
information about this wizard.   

In many cases, the Java and TrueType font names will be the same.

If the client and Web Access Server are on separate systems, you 
must do the following:

1 Make sure that the font is installed on both systems.

2 Change the fonts.cfg and the fonts.prp files on both 
systems.
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Index
A
adding

circles, 58
combination boxes, 59
graphs, 62
lines, 58
nodes, 190
rectangles, 58
tabbed areas, 91
tables, 62

Alias property, 321

aligning, elements, 112

Allowable Drilldowns property, 322

Allow Column Resize property, 322

Anchor property, 322

Annotation Font Bold property, 323

Annotation Font Italic property, 323

Annotation Font property, 323

Annotation Font Size property, 324

Annotation Rotation property, 324

B
Background property, 324

Bold property, 325

Border Style property, 325

Border Thickness property, 325

browser options, setting, 320

builder.log file, 33, 44

C
Cell Border Style property, 326

Cell Border Thickness property, 326

changing
element properties, 133
Report Builder wizards, 121, 125
report preferences, 114 to 120
Web Access Server, 120, 121

character encoding, 126

circles, adding, 58

colors, associating with rules, 211

Column Name property, 326

Columns property, 327

Column Width property, 327

combination box
adding to a form, 256
adding to a report, 59

Comment property, 327

constraints
creating, 195 to 197
definition of, 195, 305
modifying, 199

Created property, 328
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creating
constraints, 195 to 197
custom constraints, 197
graphs

GOS example, 79
parameters, 200 to 205

for use in a constraint, 203
property parameter

for Object Manager report or form, 
204

reports, 47 to 164
rules, 208
statistics, 187

creating property parameters for, 204

CSV
downloading reports to, 314
exporting to, 130

custom statistics, 189

D
data detail, displaying for graphs, 154

dataset report, 16, 50

data tables, displaying for graphs, 148

date format of a statistic, 161

debug tracing
enabling and disabling, 123

Default to No Constraints Option property, 
328

Deferred Node property, 329

Deferred property, 328

deleting
custom statistics, 189
elements, 111
events, 234
nodes, 193
overlays, 143
rule clauses, 215
rules, 214
tabbed areas, 92, 94
tabs, 94

deploying forms, 259
using the wizard, 260

deploying reports, 237 to ??, 284 to 286

deploying URLs, 288 to 290

Deployment Wizard, 238 to 246
deploying reports, 238
undeploying reports, 245

Depth property, 329

Description property, 329

Destination Data Index property, 330

Destination Element property, 330

destination object, definition of, 165

Destination property, 330

Distinct property, 331

dockable window, definition of, 25

document window, definition of, 26

drill-down depth, definition of, 219

E
Edit menu

for Report Builder, 31
for Report Viewer, 268
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elements
adding to a report, 53 to 93
aligning, 112
changing names of, 113
changing properties, 133
deleting, 111
exporting, 130
linking, 171
micropositioning, 109
moving a single item, 109
resizing, 109
selecting, 107
selecting groups of, 108
tabbed area, 91
unselecting, 108

Enable No Constraints Option property, 331

encoding characters, 126

End Time property, 332

events
adding to schedule, 222
deleting from schedules, 234

F
Favorites folder

adding, reports
using Favorites button, 312
using Home link, 312

viewing reports in, 304

File menu
for Report Builder, 29
for Report Viewer, 267

File Name property, 332

Fill Color property, 332

Fill Pattern property, 333

fixed column, definition of, 120

Font Name property, 333

Font Size property, 333

Foreground property, 334

Format property, 334

forms
combination box, adding, 256
creating, 247, 249
database table, displaying, 252
default values, supplying, 253
deploying, 259

using the wizard, 260
elements of, 248

input combination box, 248
input field, 248

input field, adding, 255
overview of, 248
type of, specifying, 253
undeploying

using the wizard, 262

G
generating reports

using the Web Access Server, 217

GoS Weight property, 335

Grade of Service (GOS)
example of, 79
explanation of, 78

Graph By property, 335

graph overlay data, exporting, 130
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graphs
adding to a report, 62, 78
changing

GOS y-axis labels, 155
rotation, elevation, and depth, 151
style of, 147
titles, 149

displaying
data detail, 154
data tables, 148
missing data, 156

exporting, 130
Grade of Service, explanation of, 78
grid lines, specifying, 143
modifying, 136
overlays, 137
preferences for, 117

general, 117
legends, 118
title area, 117

printing, 131
titles, specifying, 149
zooming in, 153

Graph Style property, 335

grid lines, specifying for graphs, 143

Grids property, 336

H
Header Alignment property, 336

Help
displaying, 114
specifying a browser for, 120, 122

Help menu
for Report Builder, 35
for Report Viewer, 270

History folder
viewing reports in, 304

Hole Mark Color property, 337

Hole Mark in Legend property, 337

Hole Mark Legend Label property, 338

Hole Mark property, 337

Hole Mark Shape property, 338

Hole Mark Size property, 338

Hole Style property, 339

I
images

adding to reports, 54
associating with rules, 211

input combination box, adding to a form, 248

input field, adding to a form, 248, 255

Insert menu, for Report Builder, 33

Italic property, 339

J
Join Operator property, 339

L
Label Background property, 340

Label Font Bold property, 341

Label Font Italic property, 341

Label Font Size property, 341

Label Foreground property, 342

Label Placement property, 342

Label property, 340

Label Rotation property, 342

labels
adding to a report, 56
editing text of, 57
formatting text for, 57
micropositioning, 109

Label Text property, 340
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Last Modified property, 343

Left Hand Side property, 343

Legend Orientation property, 343

legends
repositioning, 144
using variables, 168

Length property, 344

Line Color property, 344

Line Pattern property, 344

lines
adding to a report, 58

Line Width property, 345

Linked Row property, 345

linking elements, 165 to 182
creating a description for, 181
deleting links, 180
displaying links, 182
modifying link names, 181

Link Type property, 345

Logarithmic property, 346

log files
builder.log, 33, 44
Report Builder, 44, 45
Report Viewer, 269
specifying settings for, 123

logging on
to Report Builder, 18
to Report Viewer, 18
Web Access Server, 20

log viewer window, 44

M
Margin Height property, 346

Margin Width property, 346

Maximum Rows property, 347

Maximum Value property, 347

menu bar
for Report Builder, 29 to 35
for Report Viewer, 267 to 270

micropositioning, elements, 109

Minimum Value property, 347

Mode property, 348

modifying
constraints, 199
graphs, 136
parameters, 307
reports, 305 to 306
rule clauses, 215
rules, 213
statistics, 188

modifying expressions for
custom statistics, 189

moving an element, 109

Multiline Column Tables property, 348

N
Name property, 348

No constraints label property, 349

nodes
adding, 190
deleting, 193

Number of Fixed Columns property, 349

O
Object Manager, 204

opening
report links, 106

opening reports, 50 to 52, 272

Operator property, 349
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options
for Report Builder, 120

ordering, statistics, 184

output viewer window, 45

overlays
adding, 139
changing properties, 142
definition of, 137
deleting, 143
types, 138

P
Paragraph Alignment property, 350

parameters
characteristics of, 200
creating, 200 to 205
deleting, 207
modifying, 307
modifying values, 207

pattern used in text date format, 162

Placement property, 350

Point Color property, 350

Point Shape property, 351

Point Size property, 351

Precision property, 351

preferences
for Report Builder, 116

property parameter
creating for use in Object Manager, 204

Property Table Name property, 352

R
rectangles, adding to a report, 58

repetition of characters in text date format, 
162

Report Builder
changing options

Web Access Server, 120, 121
wizards, 121, 125

creating constraints, 195 to 197
creating parameters, 200
exiting, 30
logging on, 18
menu bar, 29 to 35

Edit menu, 31
File menu, 29
Help menu, 35
Insert menu, 33
View menu, 33
Window menu, 34

starting, 17
status bar, 45
toolbars, 36
user interface, 25
version information, 35

Report file, definition of, 16

report links
creating, 106
opening, 106, 276
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report properties
Alias, 321
Allowable Drilldowns, 322
Allow Column Resize, 322
Anchor, 322
Annotation Font, 323
Annotation Font Bold, 323
Annotation Font Italic, 323
Annotation Font Size, 324
Annotation Rotation, 324
Background, 324
Bold, 325
Border Style, 325
Border Thickness, 325
Cell Border Style, 326
Cell Border Thickness, 326
Column Name, 326
Columns, 327
Column Width, 327
Comment, 327
Created, 328
Default to No Constraints Option, 328
Deferred, 328
Deferred Node, 329
Depth, 329
Description, 329
Destination, 330
Destination Data Index, 330
Destination Element, 330
Distinct, 331
Enable No Constraints Option, 331
End Time, 332
File Name, 332
Fill Color, 332
Fill Pattern, 333
Font Name, 333
Font Size, 333
Foreground, 334
Format, 334
GoS Weight, 335
Graph By, 335
Graph Style, 335

Grids, 336
Header Alignment, 336
Hole Mark, 337
Hole Mark Color, 337
Hole Mark in Legend, 337
Hole Mark Legend Label, 338
Hole Mark Shape, 338
Hole Mark Size, 338
Hole Style, 339
Italic, 339
Join Operator, 339
Label, 340
Label Background, 340
Label Font Bold, 341
Label Font Italic, 341
Label Font Size, 341
Label Foreground, 342
Label Placement, 342
Label Rotation, 342
Label Text, 340
Last Modified, 343
Left Hand Side, 343
Legend Orientation, 343
Length, 344
Line Color, 344
Line Pattern, 344
Line Width, 345
Linked Row, 345
Link Type, 345
Logarithmic, 346
Margin Height, 346
Margin Width, 346
Maximum Rows, 347
Maximum Value, 347
Minimum Value, 347
Mode, 348
Multiline Column Tables, 348
Name, 348
No constraints label, 349
Number of Fixed Columns, 349
Operator, 349
Paragraph Alignment, 350
379



Placement, 350
Point Color, 350
Point Shape, 351
Point Size, 351
Precision, 351
Property Table Name, 352
Right Hand Side, 352
Rotation, 352
Rows, 353
Scaling Factor, 354
Selected Cell Background, 354
Selected Cell Foreground, 354
Show Cell Bottom Border, 355
Show Cell Left Border, 355
Show Cell Right Border, 355
Show Cell Top Border, 356
Show Column Labels, 356
Show Row Labels, 356
Source, 357
Source Element, 357
SQL Expression, 357
Start Time, 358
Tab Label, 358
Table Name, 358
Table Type, 359
Text, 359
Text Alignment, 359
Text Bold, 360
Text Color, 360
Text Date Format, 360
Text Font Size, 361
Text Format Name, 361
Text Italic, 361
Text Precision, 362
Ticks, 362
Time Format, 362
Time Period, 363
Time Range Type, 363
Title Background, 363
Title Text, 364
Underline, 364
Until Now, 364

Update Stmt, 365
Use Autoscaling, 365
Use main time period in overlay, 366
Use new Y axis in overlay, 366
Use Overlay, 367
Use Source Time Period, 367
Use source time period in overlay, 366
Use Title, 365
Visible, 367
Width, 368
X, 368
X1, 368
X2, 369
Y, 369
Y1, 369
Y2, 370
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reports
adding elements, 54 to 93

circles, 58
combination boxes, 59
graphs, 62
labels, 56
lines, 58
rectangles, 58
tabbed areas, 91
tables, 62

changing preferences, 114 to 349
closing, 29, 130, 267
creating, 29, 47 to 164

with deferred selections, 162
dataset type, 50
deleting

schedules, 234
deploying, 237 to 246, 284
display problems in Web Access Server, 

320
elements

resizing, 109
exporting, 128
generating

manually, 229
results of, 231
using trendtimer, 230
viewing results of, 231

generation of
disabling, 232

linking elements, 165 to 182
destination object

definition of, 165
link types

tabbed page, 175
source object

definition of, 165
using variables in legend, 168

link types
descriptions of, 166 to 170

opening, 29, 50, 267, 272
on the Web Access Server, 51
on your system, 50
using drag-and-drop, 52
using the Browser window, 51
using the Open dialog box, 50

opening links
to applications, 276, 302
to other reports, 276, 302
to URLs, 276, 302

preferences for, 116
preventing display problems in Web 

Access Server, 320
printing, 129

setting preferences for, 129
report definition type, 50
saving, 29, 127, 280
scheduling

with Web Access Server, 219 to 229
selecting elements, 107
selecting statistics, 183 to 189
setting preferences for, 114 to 349
types, 50
types of files, 16
viewing, 272 to 276

with deferred selections, 272
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Report Viewer, 265 to 280
exiting, 268
logging on, 18
menu bar, 267 to 270

Edit menu, 268
File menu, 267
Help menu, 270
View menu, 269
Window menu, 269

starting, 17
status bar, 270
toolbars, 270
user interface, 266

Report windows
tiling, 35, 269

resizing elements, 109

Right Hand Side property, 352

Rotation property, 352

row labels, adding to tables, 160

Rows property, 353

rules
clauses, deleting, 215
clauses, modifying, 215
colors with, 211
creating, 208
deleting, 214
images with, 211
modifying, 213

S
saving reports, 127, 280

Scaling Factor property, 354

schedules
deleting, 234
deleting events, 234

scheduling reports
using the Web Access Server, 217

Selected Cell Background property, 354

Selected Cell Foreground property, 354

selecting
elements, 107
multiple elements, 108

Show Cell Bottom Border property, 355

Show Cell Left Border property, 355

Show Cell Right Border property, 355

Show Cell Top Border property, 356

Show Column Labels property, 356

Show Row Labels property, 356

sorting statistics, 185

Source Element property, 357

source object, definition of, 165

Source property, 357

SQL Expression property, 357

starting
Report Builder, 17
Report Viewer, 17

Start Time property, 358

statistics
creating, 187
modifying, 188
ordering, 184
sorting, 185
unselecting, 184

status bar
for Report Builder, 45
for Report Viewer, 270

T
tabbed areas

adding to a report, 91
definition of, 91
deleting, 92, 94
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Tab Label property, 358

Table Name property, 358

tables
adding row labels, 160
adding to reports, 62
changing column order, 159
changing statistic date/time format, 161
exporting, 130
preferences for

cells, 119
data properties, 120
general, 117
headings, 118
title area, 117

printing, 131
resizing, columns, 159
setting number of fixed columns, 120
specifying

titles for, 159

Table Type property, 359

tabs
adding to tabbed areas, 92
deleting, 94

Text Alignment property, 359

Text Bold property, 360

Text Color property, 360

Text Date Format
property definition, 360

Text Date format, 161

Text Font Size property, 361

Text Format Name property, 361

Text Italic property, 361

Text Precision property, 362

Text property, 359

Ticks property, 362

tiling
Report windows, 35, 269

time format of a statistic, 161

Time Format property, 362

time period, definition of, 297

Time Period property, 363

time range, definition of, 163

Time Range Type property, 363

Title Background property, 363

Title Text property, 364

toolbars
for Report Builder, 36
for Report Viewer, 270

trendtimer, using to generate reports, 230

U
undeploying

forms, using the wizard, 262
using the Wizard, 245

Underline property, 364

undocking windows, 28

unselecting elements, 108

unselecting statistics, 184

Until Now property, 364

Update Stmt property, 365

URL
for viewing reports, 295

Use Autoscaling property, 365

Use main time period in overlay property, 
366

Use new Y axis in overlay property, 366

Use Overlay property, 367

Use source time period in overlay property, 
366
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Use Source Time Period property, 367

Use Title property, 365

V
variables

actual time range ($T$), 151, 334
end time range ($E$), 150, 334
interface name ($C$), 146, 150, 334
node and interface name ($N$), 146, 150, 

334
node name ($M$), 146, 150, 334
start time range ($S$), 151, 334
statistic name ($L$), 146
time range ($D$), 150, 334
using in graph legends, 168

version information
for Report Builder, 35

viewing
reports, 291
URLs, 291

viewing deployed items, 291 to 294

viewing reports, 272 to 276, 291 to 301
using a URL, 295

View menu
Report Builder, 33
Report Viewer, 269

Visible property, 367

W
Web Access Server

browser settings for, 320
changing, 120, 121
definition of, 121
deploying reports, 284 to 286
deploying URLs, 288 to 290
generating, reports, 217
logging on, 20
mailing reports URLs, 315
modifying reports, 305 to 307

graph style, 305
maximum rows, 305
time range, 305

opening links, 302
scheduling reports, 217
setting preferences, 308

browser window, 316
download to CSV, 314
font, 309
font color, 309
font size, 309
History Folder capacity, 313
report editing capability, 316

viewing reports
in Favorites folder, 304
in History folder, 304
with deferred selections, 297

Width property, 368

Window menu
for Report Builder, 34
for Report Viewer, 269

windows
undocking, 28

wizards
changing, 121, 125

X
X1 property, 368
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X2 property, 369

X property, 368

Y
Y1 property, 369

Y2 property, 370

Y property, 369
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